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About This Manual

About This Manual

Related Documentation

Links to publications, along with hardware manuals and data sheets, can be found under the
downloads heading at: http://www.harmonicdrive.net/

Harmonic Drive LLC software and related information can be found at:
http://www.harmonicdrive.net/support/hdm-downloads/

Comments

Harmonic Drive LLC welcomes your comments on this manual. See
http://www.harmonicdrive.net for contact information.

Copyrights
No part of this document may be reproduced in any form or by any means, electronic or
mechanical, including photocopying, without express written permission of Harmonic Drive LLC.

Windows 7, Windows 8, and Windows XP are registered trademarks of the Microsoft Corporation.

Document Validity

We reserve the right to modify our products. The information in this document is subject to change
without notice and does not represent a commitment by Harmonic Drive LLC. Harmonic Drive LLC
Controls assumes no responsibility for any errors that may appear in this document.



Product Warnings

Observe all relevant state, regional and local safety regulations when installing and using
Harmonic Drive LLC amplifiers. For safety and to assure compliance with documented system
data, only Harmonic Drive LLC should perform repairs to amplifiers.

Hazardous voltages.
Exercise caution when installing and adjusting Harmonic Drive LLC amplifiers.

Risk of electric shock.

DANGER

On some Harmonic Drive LLC amplifiers, high-voltage circuits are connected to mains
power. Refer to hardware documentation.

Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifier re-enables the PWM
output stage without operator intervention. In this case, motion may re-start
unexpectedly. Configure faults as latched unless a specific situation calls for non-
latched behavior. When using non-latched faults, be sure to safeguard against
unexpected motion.

Latching an output does not eliminate the risk of unexpected motion with non-
latched faults.

Associating a fault with a latched, custom-configured output does not latch the fault
itself. After the cause of a non-latched fault is corrected, the amplifier re-enables
without operator intervention. In this case, motion may re-start unexpectedly.

For more information, See Faults.

When operating the amplifier as a CAN or EtherCAT node, the use of HDM or ASCII
serial commands may affect operations in progress. Using such commands to initiate
motion may cause network operations to suspend.

Operation may restart unexpectedly when the commanded motion is stopped.
Use equipment as described.

Operate amplifiers within the specifications provided in the relevant hardware manual
or data sheet.

FAILURE TO HEED THESE WARNINGS CAN CAUSE EQUIPMENT DAMAGE,
INJURY, OR DEATH.
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Host Computer Requirements

Computer and Operating System
Minimal hardware requirements:

e CPU:1GHz

e RAM:1GB

Operating Systems Supported: Windows XP, Windows 7 and Windows 8.

Default File Locations

The default location for HDM data files (ccx, ccm, etc.) is determined by the Operating System.
Windows XP:
C:\Program Files\Harmonic Drive\HDM

Windows 7 and Windows 8
C:\Users\Public\Public Documents\Harmonic Drive\HDM

Serial Communications
e Standard RS-232 serial port or a USB-t0-RS-232 adapter.
e Serial communication cable. See data sheet for part numbers.

Ethernet Communications
e Standard Ethernet adapter.
e FEthernet cable.

CAN Communications

CAN card. The following CAN card manufacturers are supported:

Harmonic Drive LLC CAN PCI card (CAN-PCI-02)

Kvaser

IXXAT

CANopen network cable (see data sheet for part number and wiring instructions).

EtherCAT Communications
o Ethernet adapter dedicated to the EtherCAT network.
o EtherCAT network cable, (see data sheet for wiring instructions).

Harmonic Drive LLC 10
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Overview

Setup and Tuning

Java based HDM configuration software is powerful and intuitive. Comprehensive diagnostics,
auto-tuning and advanced oscilloscope tools simplify system commissioning. Auto-phasing
eliminates time consuming rewire-and-try for encoder/Halls/motor connections. HDM automatically
compensates for crossed wires eliminating the most common cause of startup headaches.

Indexing

Point-and-click to define up to 32 indexes or index sequences. Simply select the index/sequence
and command GO. Index sequences can include motion, parameter changes, dwell times and 1/10O
control. Any parameter can be assigned to a register for efficient control by a PLC. Custom
functions can be provided for complex applications. Install the Java "bean" and fill in the blanks.
Harmonic Drive LLC also provides a flexible OEM programming environment. Harmonic Drive LLC
Virtual Machine assembler/debugger enables the development of fast, compact control program.

Cam Tables

Camming is an effective way to produce repetitive motion synchronized to an external device. A
pre-defined cam-table of slave positions is typically cycled through by a master encoder connected
to the drive. The drive performs linear interpolation between points to minimize cam-table size.

NOTE: The feature descriptions in this manual may not apply to all Harmonic Drive LLC amplifiers

under all configurations. Significant differences between amplifier models are noted. See the
relevant hardware manual or data sheet for more information.

11 Harmonic Drive LLC
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Servo Operating Modes and Control Loops

Servo Operating Modes and Control Loops

Harmonic Drive LLC drives use up to three nested control loops - current, velocity, and position - to
control a motor in three associated operating modes. (Stepper drives operated in stepper mode,
function as traditional open position loop stepper drives).

Control Loops Model

In position mode, the amplifier uses all three loops. As shown in the typical system illustrated
below, the position loop drives the nested velocity loop, which drives the nested current loop.

Target
Position

Limits
Position Velocity Limited Current Limited PWM
v Command Command | Velocity Command | Current Command
. ! i : 1 3¢ e i :
Trajectory Position 1 Vglqcny 'S Velocity 5| CllJrr.ent ! Current 1 Motor/
Generator Loop Limiter @ H Loop @ Limiter Loop Sensors
’_A'ctual Position ’_;erived Velocity ’_;ctual Current

In velocity mode, the velocity loop drives the current loop. In current mode, the current loop is
driven directly by external or internal current commands.

Basic Attributes of All Servo Control Loops

Loop Description

Attribute

Command Every loop is given a value to which it will attempt to control. For example, the velocity loop

input receives a velocity command that is the desired motor speed.

Limits Limits are set on each loop to protect the motor and/or mechanical system.

Feedback The nature of servo control loops is that they receive feedback from the device they are
controlling. For example, the position loop uses the actual motor position as feedback.

Gains These are constant values that are used in the mathematical equation of the servo loop. The
values of these gains can be adjusted during amplifier setup to improve the loop
performance. Adjusting these values is often referred to as tuning the loop.

Output The loop generates a control signal. This signal can be used as the command signal to
another control loop or the input to a power amplifier.

For more information on using HDM to set up and tune control loops, see Control Loops.

Harmonic Drive LLC
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Installation, Startup, and Interface Tour HDM User Guide

2.1: Download and Install HDM Software

1 Navigate to:
http://www.harmonicdrive.net/support/hdm-downloads
Select HDM to start the download.

2 Navigate to the folder where HDM was downloaded to and extract the contents of
HDM.zip.

3 Run Setup.exe and follow the instructions on the installer screens. We recommend
accepting all default installation values.

Harmonic Drive LLC 14
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Special Notes for Windows 7 and Windows 8

Installer
When the installer starts, Windows will display a dialog asking for permission to make changes to
your computer. Click the button to allow the installer to continue, and HDM will be installed

properly.

Set up HDM to run as administrator
On some versions of Windows 7 and Windows 8, HDM will have to be set up to run as
administrator to access the communications drivers (serial, CANopen, EtherCAT).

1 Right-click the HDM icon on the desktop.

e

HDM

2 Choose Properties from the pop-up menu.

Open
Troubleshoot compatibility
Run with graphics processor »

Open file location
' Run as administrator
Restore previcus versions
Send to »

Cut
Copy

Create shortcut
Delete

Rename

Properties
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3 Click the Advanced button on the Properties dialog.

-

# HDM Properties E RS
Security Dietails Previous Versions
General Shorteut Compatibility

lﬂ HDM

Target type: Application

Target location: HDM

Target: gram Files {<86)\Hamonic Drive \HDM\HDM exe"

Start in: "C:\Program Files {«<86)"Harmonic Drive HDM"

Shortout key:  None

Run: [ Normal window - ]
Comment:
Open File Location ] [ Change lcon... ] [ Advanced... ]
[ ok |[ cancel Apply

HDM User Guide

4 Select Run as Administrator. Click OK to close the Advanced Properties dialog, then OK

to close the Properties dialog.

Advanced Properties = &

Choose the advanced properties you want for this shortcut.

[ Run as administrator
This option allows you to run this shortcut as an

administrator, while protecting your computer from
unautharized activity.

Run in separate memory space

QK ] [ Cancel

Harmonic Drive LLC
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2.3: Start HDM

1
Double-click the HDM shortcut icon on the Windows desktop to start HDM.
2 If communications were set up If communications were not set up...
already...
...the HDM Main Screen opens. If there are multiple  ...the Communications Wizard will be displayed as
ports, Harmonic Drive LLC Neighborhood will be shown below:
selected in the tree as shown below: i =
# Communications Wim@ﬁ
r
et Select device:
File Amplifier Tools Help © Serial Ports
b
Ay w6 B3[P EE [ ©) CaN Network
SER M HD Neighborhood (") EtherCAT
E Virtual Amplifier
E COM4&: unnamed
- _ W Tor [ Mext= § [ Cancel

. 4
In this case, proceed to Communications Wizard
Select the desired drive. For instance:

[=}-- |, HD Meighborhood

17 Harmonic Drive LLC
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After an amplifier has been selected, the HDM Main Screen looks similar to this:

' B’
% HDM V7.0 Beta 14 (DDP-090-09 unnamed) (o020 ] oo s S

File Amplifier Tools Help

By el AW B B | cd <afl ol M

- i HD Neighborhood CAN Metwork:  Address: ]

|:=—-BCOM4: unnamed Input / Output
- COM1:

HDWM Control Program

l Programmed Paosition

e T Ty N ey

e

@ Axis A
Axis B

Axis C

Sine Commutation Fotary Motor Amp Hardware Disabled F12 To Disable

2.4: Communications Wizard

Configure Serial Ports

1 Start the Communications Wizard

If communications has never been set up, the Communications Wizard will be displayed
automatically when HDM starts up.

Otherwise choose Tools>Communications Wizard

2 )
#* Communications WizaLxEJ ﬁ

Select device:

(@ Serial Ports
(7) CAN Metwaork
(") EtherCAT

[ Next> | [ Cancel ]

Pl

Choose Serial Ports and click Next
2 Select serial ports
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Select one or more serial ports from the Available Ports list then click Add.

* Communications Wizard ﬂ

Select Ports

To add serial ports, selectthem from the Available Ports list, then press Add.

To remove serial ports, selectthem from the Selected Ports list, then press Remove.

Available Ports: Selected Ports:
COM1 COM4

<Bad<] ’ MNext = ] ’ Cancel

When finished, click Next.
3 Configure serial ports

e Highlight a port in the Selected Ports list.
¢ Choose a Baud Rate for that port.
o Repeat for each selected port.

i ™y
#  Communications Wizard ﬁ

Configure 5erial Ports

Select one or more serial ports from the list, then select the baud rate.

Selected Ports:
COM4

BaudRate: 115200 |

’ = Back ] ’ Finish ][ Cancel

Click Finish to save the settings.
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Configure Ethernet Network
Configuration is same as EtherCAT.

Configure CANopen Network

1 Start the Communications Wizard

If communications has never been set up, the Communications Wizard will be displayed
automatically when HDM starts up.

Otherwise choose Tools=>Communications Wizard

' -y
*  Communications WizaI:EJ @

Select device:

() Serial Ports

................................

(71 EtherCAT

Mext = ] [ Cancel

Choose CAN Network and click Next

2 Configure CANopen Network

e Select the CAN card from the list.
o Enter the channel number (O for single channel CAN cards).

e Select the bit rate.
-
[ #  Communications Wiﬁ@@

Configure CAN Network

Click Finish to save the settings.
CAM Card: :Cnpley v:
Channel: ]

BitRate: | iMbits v

< Back ] [ Finish | [ Cancel
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NOTES:

1. The CAN Card list only shows the CAN cards that are supported by HDM and are
properly installed on the PC.

2. All amplifiers must be set to the same bit rate (default is 1 Mbit/s).
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Configure EtherCAT Network

1 Start the Communications Wizard

If communications has never been set up, the Communications Wizard will be displayed
automatically when HDM starts up.

Otherwise choose Tools=>Communications Wizard

r© ]
*  Communications WizaL:EJ ﬁ

Select device:

(") Serial Ports
() CAN Network

Mext = ] [ Cancel

Choose EtherCAT and click Next.

2 Select the Network adapter

Select the appropriate Network Adapter.
*  Communications Wizard l @Jﬁ

Metwork Adapters:

Intel(R) 82575LM Gigabit Network Connection -

[ < Back ][ Finish ][ Cancel

Click Finish to save the settings.
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2.5: Connect to an Amplifier

Installation, Startup, and Interface Tour

Choose an amplifier by clicking on its name in the Harmonic Drive LLC Neighborhood. When there
is only one amplifier, HDM will automatically connect on startup.

23

One serial port:

File Amplifier Tools Help

ﬁﬁﬁ..ﬁ

B JJ Copley Neighborhood
- EEE Virtual Amplifier

CAN network:

File Amplifier Tools Help

ﬁﬁmIIE

B+ Jy Copley Neighborhood
- BB Virtual Amplifier
— B CAN1: X-Axis
" —- B CANZ: Y-Axis

EtherCAT network:

File Amplifier Tools Help

& B AW ER

=+ i Copley Neighborhood
- Virtual Amplifier
. —- BECAT1: X-Axis

Multiple serial ports:

File Amplifier Tocls Help

EEE--E

, Copley Neighborhood

BB virtusl Amplifier
- B COM1: X-Axis [
o —— B COMZ: Y-Axis

Multi-drop: CAN
File Amplifier Tools Help

EWEIIE

Bl Ji Copley Neighborhood
- Y Virtual Amplifier
o= [
BB node 10 Y-Axis

== Node 2: Z-Axis
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2.6: Rename an Amplifier

1 Choose Main Menu Amplifier»Rename to open the Rename Amplifier screen.

2 Enter the new name and click OK to close the screen.
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2.7: HDM

Interface Tour

Installation, Startup, and Interface Tour

HDM features are called out in the diagram below. Screen details vary depending on amplifier
model and mode selection. Details follow in the chapter.

File Arnplifier Tools Help - Main Menu
ﬂi’ﬁiﬂlﬂm@ 'ﬂﬁlﬂﬂ - Toolbar
Copley ———| |5 L Copley Nesghbarnacs
Meighborhood L-—— R T N PR PP R 1 % S —
Tree = Ingut | Cutpet : Diagram
VM Corbod Progeam | | |
P Loop = W Loop = | Loop —'Muw."Fﬂdblﬂ..
Homss Coigen [Rimgan Coan [F milis
Axis Selection — - St iee
B Configure Filtens |
Staws Bar o | [ Commutation inear Motor [Caropen over EtherCAT (CoE) Control F12 To Disable
Tool Bar
Icon Name For More Information
Basic Setup Basic Setup

Control Panel

Control Panel

Bl S8

Auto Phase Motor Phasing
Auto Tune Auto Tune all Loops for Linear Motors
I Scope Oscilloscope
r Error Log Error Log

(=R |
1=}

Amplifier Properties

Save amplifier data to disk

Restore amplifier data from disk

Data Management Tools

Save amplifier data to flash

Restore amplifier data from flash

EMdLpm

25
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Menu Bar
Menu Selection Description For More Information
File Save MACRO File (MACRO amplifiers only.) Saves | Data, Firmware, and Logs
amplifier setup and tuning
parameters in a format that can
be read by Delta Tau controllers.
Save Drive Saves the contents of amplifier
Configuration RAM and all CVM flash to a drive
configuration file.
Save Amplifier Saves contents of amplifier RAM
Data to a file on disk.
Save As->Single For multi-axis drives only: saves
Axis one axis to a file on disk.
Save As>V4.1 Saves amplifier data file in format
Format usable by HDM Version 4.1.
Copy Axis For multi-axis drives only: copies
the setting from one axis to
another.
Restore>Drive Restores contents of a drive
Configuration configuration file to amplifier RAM
and CVM flash.
Restore>Amplifier | Restores contents of an amplifier
Data file from disk to amplifier RAM.
Restore>Single For multi axis drives only:
Axis restores contents of an amplifier
file to only one axis
Restore>CVM Restores a CVM program from a Harmonic Drive LLC Indexer 2
Control Program file to the CVM Flash. Program User Guide.
Restore>Cam Restores a Cam Table file (.cct). See Harmonic Drive LLC
Tables Camming Users Guide.
Restore>Gain Restores Gain Scheduling Table Gains Scheduling
Scheduling Table from a file (.ccg).
Exit Closes HDM.
Amplifier | Basic Setup Opens Basic Setup screen. Basic Setup
Control Panel Opens Control Panel. Control Panel
Auto Phase Opens Auto Phase tool. Motor Phasing
Scope Opens Scope Tool screen. Oscilloscope
Error Log Opens Error Log screen. Error Log
Amplifier Displays basic amplifier
Properties properties.
Network Opens the CAN Configuration Network Configuration
Configuration screen.
Rename Prompts for new amplifier name. Rename an Amplifier
Auto Tune Opens Auto Tune for Linear Servo | Auto Tune all Loops for Linear
Motors. Motors
Gain Scheduling Opens Gain Scheduling screen. Gains Scheduling

Harmonic Drive LLC
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Menu Selection Description For More Information
Tools Communications Starts sequence of prompts to set | Communications Wizard
Wizard up communications.
Communications Opens Communications Log. Communications Log
Log
Download Starts prompts to download Firmware Download
Firmware firmware from disk to amplifier.
Download CPLD Starts prompts to download PLD
Program code from disk to amplifier.
Manual Phase Opens Manual Phase tool. Manual Phase
View Scope Files Opens Trace Viewer window. Scope Trace Files
I/O Line States Opens I/O Line States window,
showing high/low status of the
amplifier's inputs and outputs.
HDM Lock/Unlock Opens screen for locking and Lock/Unlock HDM
unlocking HDM functionality.
ASCIlI Command Opens screen to accept ASCII Harmonic Drive LLC ASCII
Line format commands. Interface
Help HDM User Guide Opens this manual.
All Documents Opens the Doc folder in the HDM installation folder
(typically c://Program Files/Harmonic Drive LLC Motion/HDM/Doc).
This folder contains all of the related documents that were installed with
HDM.
Downloads Web Opens default web browser with pages from Harmonic Drive LLC
Page website.
Software Web Page
View Release Opens latest HDM release notes in a text viewer.
Notes
About Displays HDM version information.

27
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Functional Diagram

The functional diagram, shown below, provides button-click access to most of the screens
used to configure an amplifier. It also indicates the flow of control from input, across all
active control loops, to motor/feedback. Only those control loop buttons that are
appropriate to the amplifier and operational mode appear on the diagram.

HDM User Guide

{Zontrol Loops

Input / Cutput

CWM Control Program

| ¥

Input Command —m

Analog Command —'-b| P Loop |—P| V Loop |—b| | Loop |—D| Motor/Feedback |
- ;

..... - o

Configure Filters

| Home | Configure Regen |

Configure Faults

Name Description For More Information
Input/ Opens Input/Output screen. Digital Inputs and Outputs
Output
HDVM Opens Harmonic Drive LLC Virtual Machine screen. Harmonic Drive LLC Indexer
Control Program User’s Guide.
Program
Input Opens screen for configuring the input command. Command Inputs
Command | Button text varies depending on the selected control
loop input.
Control Each opens a control loop configuration screen. Control Loops
Loops
Motor/ Opens the Motor/Feedback screen. Motor/Feedback
Feedback
Home Configure and test homing. Homing
Configure | Opens Regen Settings screen. Regen Resistor Configuration
Regen
Configure | Opens Fault Configuration screen. Faults
Faults
Configure | Opens Filter Configuration Screen Filters
Filters
Encoder (Stepper amplifier with encoder only.) Opens Encoder | Encoder Correction
Correction | Correction screen.
Detent (Stepper amplifier only). Opens stepper amplifier Detent Compensation Gain
Advanced Tuning screen.
Position (Stepper amplifier with encoder only.) Opens Position | Position Limits (Stepper Amplifier)
Limits Limits screen

Harmonic Drive LLC
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CAN Information and Status Bar

CAN Information
The Main screen displays the basic CAN information. The example below shows CAN information:
CAMN Metwork:  Address: 1 State: Pre-operational

The Address field shows the amplifier's present CAN address. For more information, see Network
Configuration . When the Position Loop Input is set to CAN, the State field shows the state of the
amplifier's CANopen state machine (for more information, see Harmonic Drive LLC Control’s
CANopen Programmer’s Manual).

Status Bar

The status bar describes the present commutation mode, motor type, and amplifier control status
as shown below. It also includes a reminder that pressing the F12 function key while HDM is
running disables the amplifier.

|5ine Commutation |R|:utary' Maotor |ﬂ|'|pE|1§HEd
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3.1: Setup Procedure

Warnings and Notes

NOTE: To software disable the amplifier at any time while running HDM, press function key F12.
Also, the amplifier’s enable input can be used to disable the amplifier.

DANGER: Hazardous voltages.
Exercise caution when installing and adjusting.

Do not make connections to motor or drive with power applied.

DANGER
Risk of unexpected or uncontrolled motion with HDM in CAN mode.
HDM can be used while the amplifier is under CAN or EtherCAT control.
However, some extreme changes made with HDM could cause unexpected
or uncontrolled motion.
Failure to heed these warnings can cause equipment damage, injury, or
death.
Spinning motor with power off may damage amplifier.
Do not spin motors with power off. Voltages generated by a motor can
damage an amplifier.
Failure to heed this warning can cause equipment damage.
WARNING
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1

OR

OR

Prepare for setup

Understand this procedure’s Warnings and Notes.

Verify that amplifier power is OFF.

Verify wiring and connections.

Make sure motor is securely fastened with no load connected.
Apply power to the amplifier.

For off-line amplifiers apply 24V only.
For DC amplifiers apply AUX HV only.

Start HDM and enter Basic Setup parameters

Double-click HDM icon on the Windows desktop to start HDM.

If necessary, Connect to an Amplifier from the list in the Harmonic Drive LLC
Neighborhood tree.

IJEE If the Basic Setup screen does not appear, click the Basic Setup button.

Choose:

| Changesettings |  Settings.
Then proceed to Step 3 of this Setup Procedure.

To load a .ccx file that was prepared for the amplifier/motor

combination, see Copy Drive Data. Then proceed to Step 13 of

this Setup Procedure..

ServoTube Setu
[ =rlfiose= e | Setup and see ServoTube Setup.

Harmonic Drive LLC

In most cases, click Change Settings to Change Basic Setup

To complete the setup for a ServoTube motor, click ServoTube

HDM User Guide
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Enter Motor/Feedback/Brake Stop parameters

@ Click Motor/Feedback to open the Motor/Feedback screen.

To optionally load data from an existing motor data file,
see Load Motor/Feedback/Brake Settings from a File and then skip to
Step 4.

On the Motor tab, modify the appropriate Rotary Motor Parameters or Linear Motor
Parameters

On the Feedback tab, as appropriate for each encoder or resolver, verify the parameters
described in Feedback Parameters, Rotary or Feedback Parameters, Linear

If using a brake, click the Brake/Stop tab to verify Brake/Stop Parameters

Use Calculate to set initial gains and limits

h Calculate

Click Calculate to have the software calculate and display initial loop gains and limits.
See Calculate.

Load the calculated values into amplifier RAM by clicking OK.

Configure digital 1/0

Input / Cutput

Click Input/QOutput on the Main screen to open the Input/Output screen.
Verify the 1/O settings described in Digital Inputs and Outputs.

On the Input/Output screen, click Close.

Configure the command input

Analog Command | or | PWM Command | Digital Input | or | CAN Configuration

or |
Click the appropriate button to configure the amplifier's command input.

For more information see Command Inputs.

NOTE: If the amplifier is to run CVM programs or in Camming mode see the relevant
documents.

After setting command input parameters, Click Close.
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11

12

Configure faults

Caonfigure Faults

Click Configure Faults to open the Fault Configuration screen and set latching faults as
needed. See Faults.

Click OK to close the Fault Configuration screen.

Configure an optional regen resistor

Regen Settings

If the amplifier is equipped with a regen resistor, click Regen Settings to open the Regen
Settings screen. See Configure a Standard Harmonic Drive LLC Regen Resistor for regen
resistor parameters.

Click OK to close the Regen Settings screen.

Phase and jog the motor

Apply AC or HV power.
[a Phase the motor. See Auto Phase
To verify Auto Phase results, see Manual Phase

Jog/move the motor to verify that the amplifier can drive the motor. See Jog Mode

Tune the control loops

Starting with the Current Loop set up and tune all applicable Control Loops
If you are setting up a linear motor, you can optionally Auto Tune all Loops for Linear
Motors.

Set gains and limits for stepper mode (stepper only)

If tuning a stepper amplifier in stepper mode:

= Set Position Limits in Stepper Mode. See Position Limits (Stepper Amplifier).
= |f using Encoder Correction, set Encoder Correction
= Tune Detent Compensation Gain

Configure Homing

See Homing
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Test with load attached

ﬁ On the HDM Main screen, click Save to Flash.
Remove amplifier power.

Attach load.

Reconnect amplifier power.

If necessary, re-tune velocity and position loops.
m On the HDM Main screen, click Save to Flash.

'ﬁ On the HDM Main screen, click Save to Disk (for backup or duplication).

The amplifier tuning procedure is complete.

NOTE: To copy the results of this setup to other amplifiers,
see Drive Configuration or Copy Drive Data
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4.1: Overview

Basic Setup

The Basic Setup Wizard is used to set up the parameters that define the fundamental
characteristics of the system. This is where the motor, feedback, and operating mode are
setup. The setup can be done three different ways: manually change settings, load settings
from a ccx file, or run the ServoTube setup wizard. Each of these methods are explained in

this chapter.

1 IJE[_T'CIick to open the Basic Setup screen.

2
3

Motor Feedback:
Load Feedback:
Load Feedback Type:
Multi-mode Port:

Operating Mode:

Basic Setup
Settings
Motor Family: Brushless
Motor Type: Rotary
Commutation: Sinusoidal
Hall Type: Digital
Hall Phase Correction: on
Use Halls for Velocity/Position:  Off
Use Back EMF for Velocity: Off

Primary Incremental
Secondary Absolute A
Rotary

Differential Input

Paosition, Digital Input

[ Change Settings |l Load ccx File H SeryoTube Setup H Cancel

Review settings.

Choose:

[ Change Settings ‘

O [issieare |

OR [ ServoTube Setup I

oR ([ |

37

Click Change Settings to manually Change Basic Setup Settings.

If you have a .ccx file that was prepared for the amplifier/motor
combination, click Load ccx File and see Data Management Tools.

To change Basic Setup settings for a ServoTube motor, click ServoTube

Setup and see ServoTube Setup.

To accept the displayed settings, click Cancel.
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4.2: Change Basic Setup Settings

HDM User Guide

1 On the Basic Setup screen, click Change Settings to manually change
all Basic Setup settings. Use the Back and Next buttons to navigate
screens. Screen details vary depending on amplifier model and mode

selection.

2 Set Motor Options

Basic Setup

Motor Options

Motar Family:
@) Brushless (7 Brush I}

Motor Type:
@ Rotary ~) Linear

[ =Back |I Mext = II Cancel

3 Set Feedback Options

Basic Setup
Feedback Options
Hall Type: _Digital - |

Hall Phase Correction

Motor Feedback: _Incremental

Load Feedback: | Absalute A

Load Feedback Type:
@ Rotary Linear

|| Use Load Feedback In Passive (Monitor) Mode

Input Source:

- | @ Primary Secondary

+ | (7) Primary (@) Secondary

I < Back “ Mext > |I Cancel

Harmonic Drive LLC
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Basic Setup

Setting

Description

Hall Type

Select Hall type: None, Digital, or Analog (Analog is used with Harmonic Drive LLC
ServoTube motors).

Hall Phase Correction

If selected, will enable error checking between hall sensors and encoder phase
angle.

Motor Encoder

Select type and source of motor feedback.

None: No motor encoder.

Primary Incremental: Incremental encoder on primary feedback connector.
Secondary Incremental: Incremental encoder on multi-mode port.
Panasonic Incremental A Format

SSlI

EnDat

BiSS

Absolute A

Tamagawa Absolute A

Panasonic Absolute A Format

Panasonic Incremental A Format

Sanyo Denki Absolute A

Analog: Analog encoder on primary feedback connector.

Low Frequency Analog: Harmonic Drive LLC ServoTube motor on primary
feedback connector.

Resolver: Resolver (-R) version of a Harmonic Drive LLC amplifier on primary

feedback connector.

Additional encoder types are supported by certain Harmonic Drive LLC amplifier
models. See the amplifier data sheet for more information.

Position Encoder

Select type and source of Position (load) feedback.

None: No position encoder.

Primary Incremental: Incremental encoder on primary feedback connector.
Secondary Incremental: Incremental encoder on multi-mode Port.

Analog: Analog encoder on primary feedback connector.

Position Encoder
Type

Select the type of Position (load) encoder:

Rotary
Linear

Use Position Encoder
in Passive (Monitor)
Mode

When this is checked, the position of the position encoder will be reported by the
passive load position variable but it will not be used to control the position of the
axis.

Stepper Drives Only

Motor Encoder Select the encoder type:

e None
e Primary incremental

Run in Servo (Requires encoder.) Amplifier operates as a true, closed loop, servo amplifier controlling
Mode a stepper motor.

Enable Encoder | (Requires encoder) Amplifier runs as a stepper drive; encoder feedback is used to
Correction correct positional errors. See Encoder Correction
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4 Set Operating Mode Options

Basic Setup

Operating Mode:

Operating Mode Options
Position -
Command Seurce: |Digital Input -

Digital Input Source
@ High Speed Inputs
Multi-mode Port
Differential Inputs

< Back || Next > || Cancel

Setting Description

Operating Choose the mode of operation: Current, Velocity, or Position.
Mode See Control Loops

Command Choose the command input source (see Command Inputs):
Source

e Analog Command: Analog voltage provides command input.

o PWM command (current and velocity mode only): Digital pulse-width modulated signal
provides command input.

e Function Generator: Internal function generator provides command input.

e Software Programmed: The amplifier is controlled by software commands from either
the Harmonic Drive LLC Virtual Machine (CVM) or an external source. See Harmonic
Drive LLC Indexer Program User’s Guide or the Harmonic Drive LLC ASCII Interface
Programmer’s Guide.

e Camming: Runs in Camming Mode. See Harmonic Drive LLC Camming User Guide.
¢ Digital Input: Command input is provided via the chosen Input Source (below).

e CAN: Command input is provided over the CANopen network. See the CANopen
Programmer’s Guide.

Input Source

Choose the input source for PWM or Digital input commands:

e Single-ended Inputs: Command input is provided via two of the amplifier's
programmable digital inputs.

o Multi-mode Port: Command input is provided via differential inputs on the amplifier's
multi-mode port.

o Differential Inputs: Command is provided via differential inputs.
e High Speed Inputs. Command is provided via two of the amplifier's high speed inputs.

Harmonic Drive LLC
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Basic Setup

Set Miscellaneous Options

Basic Setup @
Miscellaneous Options
Commutation Mode:
@ Sinusoidal () Trapezoidal () Estimated Sinusoidal
Use Back EMF For Velocity
Use Halls for Velocity
Multi-mode Port: _Differential Input -
< Back I [ Finsh | I Cancel
Setting Description
Commutation Commutation method: Sinusoidal, Trapezoidal, or Estimated Sinusoidal

Use back EMF
for Velocity

If selected, will use the motor's measured back EMF to determine motor velocity.
Recommended only for medium- to high-speed. Accuracy depends on the accuracy of
the programmed Back EMF value, and may be affected by factors such as cable
resistance.

Use Halls for

If selected, will use transitions of the Hall switches to determine motor velocity and

Velocity and position. Recommended only for medium- to high-speed applications (may run roughly
Position at low speeds).

Multi-mode Selects the mode for the amplifier's multi-mode port:

Port

¢ Buffered Motor Encoder. The multi-mode port functions as a buffered digital encoder
output based on the digital encoder input.

o Emulated Motor Encoder. The multi-mode port functions as an emulated digital
encoder output based on the motor analog encoder or motor resolver.

e Emulated Position Encoder. The multi-mode port functions as an emulated digital
encoder output based on the position analog encoder.

 Differential Input. The multi-mode port functions as a differential command input.

When changes are complete, click Finish.
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4.3. ServoTube Setup

The ServoTube Setup wizard sets up the amplifier for use with the chosen ServoTube motor. After
the last step in the wizard is completed, HDM will perform the following actions:

e Performs the Calculate function to set initial gains and limits.

e Sets the appropriate programmable digital input as Motor Over Temperature.
e Sets the proper phasing values.

e Saves all values to flash.

e Opens the Control Panel so the user can Test a move in Jog Mode

1 | ServoTube Setup | Click ServoTube Setup to start the Basic Setup wizard. Use the Back

and Next buttons to move from screen to screen as needed.

2 Choose the appropriate Series and Model. Optionally choose to Invert Motor
Direction. Optionally choose the Additional Encoder Option (available with certain
motor series) and choose the appropriate resolution for the optional encoder
(1 um or 5 um).

Basic Setup @
Motor Options
Series: | 5TB - Model: |5 7

|| Invert Moter Direction | Additional Encoder Option

@ lum Sum

< Back || Mext = || Cancel
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Set Operating Mode Options.

Basic Setup
Operating Mode Options
Operating Mode: :Position -
Command Source: :Analog Command -

Digital Input Source
High Speed Inputs
Multi-mede Port

Differential Inputs

[ < Back ]l Next

{ ’ Cancel

Set Miscellaneous Options.

Basic Setup

Miscellaneous Options

Commutation Mode:

@) Sinuscidal () Trapezoidal Estimated Sinusoidal

Use Back EMF For Velodty

Use Halls for Velodity and Position

Multi-mode Port: | Differential Input -

[ < Back ]| Finish |[ Cancel I

When changes are complete, click Finish.

To test basic move capabilities, test a move in Jog Mode.

Test with Load attached.

Basic Setup
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5.1: Motor/Feedback Screen Overview

Motor/Feedback - Rotary Motor @

Motor | Feedback | Brake\Stop|

Manufacturer: Copley Units
{ @ Metric () Englsh
Model Mumber: CBL341FE-001
Mator Inertia: _ _
0.11976 | |kg-cm? =
Torgue Constant: . .
Mumber of Poles: 4 0.1401 _N'mfﬁ.pk v
Back emf Constant: _ _
14.67 ||V
Peak Torgue: _ _ L frpm adl
1,959 [N'm - Resistance:
. 2.27 | ohms
Continuous anqug: .
0.6553 | |N'm - Inductance:
' ' 5.23 |mH
Velocity Limit:
5000 [rpm

el ol Gl (@] (o] [

Action Name Description

'ﬂ Save motor data to Saves motor/feedback/brake settings from PC to a disk file with
disk .ccm name extension.

ﬁ Restore motor data Restores contents of a .ccm file from disk to PC.
from disk

[:H Save motor data to Saves motor/feedback/brake settings from PC to amplifier
flash permanent flash memory.

ﬁ Restore motor data Restores motor/feedback/brake settings from flash memory to
from flash the PC.

A Calculate Calculate Calculates initial tuning and limit values.
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L
MeterP==d®=<* | Click Motor/Feedback to open the Motor/Feedback screen.

E ﬁ Load Motor/Feedback/Brake Settings from a File.
OR

Enter settings manually:

| Motor |

Click the Motor tab to view or change Rotary Motor Parameters or Linear Motor
Parameters

| Feedback

Click the Feedback tab to view or change Feedback Parameters, Rotary or Feedback
Parameters, Linear.

Erak&‘lﬁ

Click the Brake/Stop tab to view or change Brake/Stop Parameters.

[ |
ot | (Calculate . — . _—
(o] e Click Calculate to calculate initial gains and limits.

ﬁ On the Main screen, click Save to Flash to avoid losing the changes.

Harmonic Drive LLC 46



HDM User Guide Motor/Feedback

5.2: Load Motor/Feedback/Brake Settings from a File

47

1

If needed, download a motor data file from the Harmonic Drive LLC website:

In an internet browser, navigate to http://harmonicdrive.net/support/hdm-downloads/
Click on the appropriate motor name.

When prompted, save the file to the MotorData folder in the HDM installation folder.
Extract the contents of the zip file to the same location.

The folder should now contain the new motor data file (with a .ccm filename
extension).

Load the motor data to the amplifier:

@ Click Motor/Feedback to open the Motor/Feedback screen.

On the Motor/Feedback screen, click Restore Motor Data from Disk.
When prompted, navigate to the folder containing the file,
then click on the file name, and then click Open.

Calculate _— . Co
‘ Calculate initial gains and limits with.

ﬂOn the Main screen, click Save to Flash to avoid losing the changes.
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5.3: Rotary Motor Parameters

Setting

Description

Manufacturer

Motor manufacturer’s name. Saved for reference in the motor data file.

Model Number

Motor model number. Saved for reference in the motor data file.

Units

Selects whether the parameters entered in this screen are in Metric or English units.

Motor Inertia

The rotor inertia of the motor. Used for calculating initial velocity loop tuning values.
Range: 0.00001 to 4,294 kg cm®. Default: 0.00001 kg-cmz'

Number of Poles

(Brushless only.) The number of magnetic poles in the motor. Required for correct
commutation of the motor. If the number of poles is not known,
Verify the motor’s pole count using the Data accuracy test.. Range: 2 to 200. Default: 4.

Peak Torque

The peak torque that the motor can produce. Peak Torque divided by torque constant =
motor’s peak current limit. Range: 0.0001 to 2,100 Nm. Default: 0.0001 Nm.

Continuous Torque

The continuous torque that the motor can produce. Used with the torque constant to
calculate continuous current. Range: 0.0001 to 1,000 Nm. Default: 0.0001 Nm.

Velocity Limit

Maximum speed of the motor. Used to calculate the velocity and acceleration limits for the
velocity loop. Range dependent on encoder resolution.

Torque Constant

Relates the motor's input current to torque produced. Sometimes abbreviated as Kt.
Range: 0.001 to 1,000 Nm/Apk. Default: 0.001 Nm/Apk.

Back emf Constant

Relates the motor's input voltage to speed. Sometimes abbreviated as Ke. Used for
calculating the maximum velocity for a given amplifier bus voltage.
Range: 0.01 to 21,000,000 V/Krpm. Default: 0.01 V/Krpm.

Resistance Motor resistance line-to-line. Used for calculating the initial current loop tuning values.
Range: 0.01 to 327 Q. Default: 0.01 Q.
Inductance Motor inductance line-to-line. Used for calculating the initial current loop tuning values.

Range: see the hardware documentation.

Stepper Amplifiers

Only

Rated Torque

Motor’s rated operating torque. Min: .001. Max: 1000.

Rated Current

Motor’s rated continuous current. Min: 0.001. Max: 1000.

Basic Step Angle

Fundamental stepper motor step, in degrees. Min: 0.225. Max: 22.5. Default 1.8.

Microsteps/Rev

Number of microsteps per revolution of the motor.
Min: 4. Max: 100,000,000. Default 4000.

Full Steps/Rev

This read-only value can be used after entering Basic Step Angle to cross-check against
motor data sheet.

Harmonic Drive LLC
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5.4: Linear Motor Parameters

Setting

Description

Manufacturer

Motor maker’s name. Saved in the motor data file. Choose from list or enter manually.

Model Number

Motor model number. Saved in the motor data file. Choose from list or enter manually.

Units Selects whether the parameters entered in this screen are in Metric or English units.

Mass The mass of the motor. Used for calculating initial velocity loop tuning values.
Range: .0001 Kg to 100,000 Kg. Default: .0001 Kg.

Peak Force The peak force that the motor can produce. Peak Force divided by Force Constant =

motor’s peak current limit. Range: 0.00001 to 2,000 N. Default: 0.00001 N.

Continuous Force

The continuous force that the motor can produce. Used with the force constant to
calculate continuous current. Range: 0.00001 to 1,000 N. Default: 0.00001 N.

Velocity Limit

Maximum speed of the motor. Used to calculate the velocity and acceleration limits for
the velocity loop. Range dependent on encoder resolution.

Force Constant

Relates the motor's input current to force produced. Sometimes abbreviated as Kf.
Range: 0.00001 to 2,000 N/Amp. Default: 0.00001 N/Amp.

Back emf Constant

Relates the motor's input voltage to speed. Sometimes abbreviated as Ke. Used for
calculating maximum velocity for a given amplifier voltage. Range: 0.01 to 1,000
VIM/Sec. Default: 0.01 V/M/Sec.

Resistance Motor resistance line to line. Used for calculating the initial current loop tuning values.
Range: 0.01 to 327 Q. Default: 0.01 Q.
Inductance Motor inductance line to line. Used for calculating the initial current loop tuning values.

Range: see the hardware documentation.

Magnetic Pole Pair Length

The length of a pair of magnets which equals the distance moved in one electrical cycle
of the motor.

Stepper Amplifiers Only

Rated Force

Motor’s rated operating force. Min .001 N. Max 1000 N.

Rated Current

Motor’s rated continuous current. Min: 0.01 A. Max 1000 A.

Full Step

Fundamental stepper motor step distance. Min: 0.0001mm. Max: 5000 mm.

Microsteps/
Full Step

Number of microsteps per full step. Min: 1. Max: 100,000,000.
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5.5: Feedback Parameters, Rotary

Details for serial encoders can be found in the Serial Encoder Guide.

Feedback Type | Parameters/Actions
Incremental In the Motor Encoder lines or Position Encoder lines field, enter the number of encoder lines
(see encoder or motor data sheet). As indicated by the counts field, the number of encoder
counts per revolution is equal to 4 x the number of lines. Enable Encoder Loss Detection
and/or Index Loss detection if desired.
Motor Feedbadk
1000| lines = 4000 counts
Enable Encoder Lass Detection
Enable Index Loss Detection
Analog In Fundamental Lines, enter the number of fundamental encoder lines (see encoder or motor
data sheet). As indicated by the Fundamental Counts field, the number of fundamental
encoder counts per revolution is equal to 4 x the number of Fundamental Lines.
~Motor Feedback
Fundamental Lines: 64 = 256 Fundamental Counts
Interpolation: 14 x|
Interpolated Counts Per Rev: 1024
Optionally modify the encoder resolution by changing the Interpolation value. The
interpolated resolution (Interpolated Counts Per Rev) is the product of Fundamental Counts
value and the Interpolation value.
Resolver Optionally modify the feedback resolution by changing the value in Counts Per Rev. Default:
16384.
Resolver
16384{ counts per rev
Halls With amplifier set to Use Halls for Velocity/Position, optionally increase the counts per rev
ratio by incrementing the Halls Count Multiplier.
~Maotor Halls
Hall Count Multiplier 1 =
Counts per Rev.: 24
P Defalt

Harmonic Drive LLC
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5.6: Feedback Parameters, Linear

Details for serial encoders can be found in the Serial Encoder Guide.

Feedback Type

Parameters/Actions

Incremental Choose units and then enter the Encoder Resolution (see encoder or motor data sheet).
Enable Encoder Loss Detection and/or Index Loss detection if desired.
Motor Feedback
Encoder Resolution: i ymm @um ) nm
[ | Enable Encoder Loss Detection
[] Enable Index Loss Detection
Analog Enter the Fundamental Pitch (distance between encoder lines; see encoder or motor data

sheet). As indicated by the Fundamental Resolution field, Fundamental Pitch divided by four
gives Fundamental Resolution. The interpolated resolution is the dividend of Fundamental
Resolution value/Interpolation value. Optionally modify the Interpolated Resolution by
changing the Interpolation value.

~Motor Feedback
() mm i@ um ) nm
Fundamental Pitch: 40 um = 10 um Eﬁi_’;g uﬁ'}ﬁﬂ‘f"
Interpolation: 1 -
Interpolated Resolution: 10 um

Low Frequency
Analog

Normally used with ServoTube, Pole Pitch is the distance between poles in a pole pair, as
entered in the Magnetic Pole Pair Length field on the Motor tab. The interpolated resolution is
the dividend of Pole Pitch/Counts per pole value, expressed in micrometers. Optionally
modify the resolution by changing the Counts/Pole value. Click Restore Default to restore

default Counts/Pole.

—Motor Feedback
() mm i@ um ) nm
Fundamental Pitch: 40| um = 10 um EE_.’;E J{}EHE"
Interpolation: i -
Interpolated Resolution: 10 um

51

Harmonic Drive LLC



5.7:

Motor/Feedback HDM User Guide

Feedback Notes

Encoder and Resolver Support

Some Harmonic Drive LLC amplifiers are offered in multiple versions to support different types of
encoder or resolver feedback. Some encoder versions support digital quadrature encoders, some
support analog sin/cos encoders, and others support both. Encoder versions normally require
Halls for the commutation of brushless motors. The resolver versions support standard, single
speed, transmit-type resolvers.

Dual Feedback
Some Harmonic Drive LLC amplifiers can receive position feedback from sensors on the motor,
the load, or both, through the Primary Feedback channel, a Secondary Feedback channel (multi-
mode port) or both. (Some amplifiers can also operate in certain modes without encoders or
resolvers.)
A drive configured with a multi-mode port can:
e Provide a buffered digital encoder output based on the digital encoder input.
e Provide an emulated digital encoder output based on the analog encoder or resolver input.
e Provide a second digital encoder input to be used in the dual encoder position mode. In this
mode, an encoder attached to the load provides position loop feedback, and the motor
encoder or resolver provides velocity loop feedback.
A dual-feedback setup is shown below. The amplifier receives feedback from an incremental motor
encoder through the Primary feedback channel. Position (load) encoder feedback comes through
the multi-mode port. The ratio of motor turns to position encoder turns is 1 to 10.

Motor/Feedback - Rotary Motor @
— -
| Mator | Feedback | BrakelStop |
Motor Encoder
1000 | lines = 4000 | counts
[~] Enable Encoder Loss Detection
[7] Enable Index Loss Detectiort
Position Encoder —
1000 | lines = 4000 | counts |
rRatio
Motor turns: i
Position turns: 10
. @ m m j Calculate | OK, I I Cancel
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5.8: Brake/Stop Parameters

Many control systems employ a brake to hold the axis when the amplifier is disabled. On brake-
equipped systems, disabling the amplifier by a hardware or software command starts the following
sequence of events.

e The motor begins to decelerate (at Abort Deceleration rate in position mode or Fast Stop
Ramp rate in velocity mode). At the same time, the Brake/Stop Delay Time count begins.
This allows the amplifier to slow the motor before applying the brake.

o When response time has passed, the amplifier's output stages are disabled. This delay
ensures the brake has time to lock in before disabling the power section.

e This feature is not available when the amplifier is configured for current mode. In this mode,
the amplifier output turns off and the brake output activates immediately when the disable
command is received.

-

Motor/Feedback - Rotary Motor @

Brake Stop

Enahble Input D — e

BrakeiStop delay time

Speed
1 BrakefStop activation velocity

Brake Cuptput

Enzhle teahe- PR el
Powver Section BrakesStop responze time

Brake/Stop delay time: 10| ms
Brake /Stop activation velodity: 6| rpm
PWM delay brake/stop response time: 100 ms

Set Defaults

| Motor Wiring Detection |

Parameter Description

Brake/Stop Delay Time Range of accepted values: 0 to 10,000 mS

Brake Activation Velocity Range of accepted values: 0 to encoder resolution dependent limit rpm (mm/s for linear
motor)

PWM Delay Brake/Stop Range of accepted values: 0 to 10,000 mS
Response Time
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Set Defaults

Sets the three brake parameters to defaults values, based on the motor data.

[ Motor Wiring Detection ]

Displays the Motor Wiring Detection screen

Harmonic Drive LLC
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5.9: Calculate

The Calculate function uses the motor and feedback data to calculate initial gains and limits.
These can be modified to fine-tune the amplifier. Follow the steps below:

1 j Caloulate . . .
= Click Calculate to calculate and display settings.
( Calculated Amplifier Settings @
Current Loop Cp Gain: 3426 =
Current Loop Ci Gain: 371
Peak Current Limit 9.64 A -
Continuous Current Limit 3.85 |
IZT Time Limit 1000 ms
Current Loop Offset 0 A
Current Ramp: i mafs
Programmed Current: i} A
Velodty Loop Vp Gain: 3144
Velodty Loop Vi Gain: 699
Velodty Integral Drain: 0
Velodty Loop Velodty Limit: 2250 rpm
Velodty Loop Accel., Decel., Fast Stop: 750 rps?
Velodty Tracking Window: 375 rpm
Velodty Tracking Time: 100 ms o
i oK I Cancel I

2 Verify the peak current limit, continuous current limit, and velocity loop velocity limit.
If one or more of these values seems inappropriate, click Cancel and check: Peak
Torque (or Force), Continuous Torque (or Force), Velocity Limit, and Torque (or Force)
Constant. Correct them if needed. See Rotary Motor Parameters
or Linear Motor Parameters.

If the Motor/Feedback values were correct but the peak current limit, continuous current
limit, or velocity loop velocity limit values are not optimal for the application, change
these limits during the tuning process.

3 Save the values into amplifier RAM by clicking OK.
NOTE: When loading motor data from a file, if the motor wiring configuration in the motor
file does not match the configuration currently stored in the amplifier, HDM prompts for

verification on which configuration to use. Select the file configuration by clicking Yes.
The configuration will be tested as part of Motor Phasing.

4 ﬁ On the Main screen, click Save to Flash to avoid losing the changes.
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6.1: Digital Inputs

| Input ¢ Output |

Click Input/Output on the Main screen.

A typical screen is shown below. Options vary with model and configuration.

Eed light: mhibited motion or active input depending on input function.
Grey light: motion notinhibited.
No hght: notonfigured

Lo/Hi: indicated state of inpull.
* Input/Output £=2 o]

[ Digital Inputs 1-5 Digital Inputs 6-12 | Digital Outputs|

Debounce time CAM address
- : ]
S [IN1] ' Amg Enable-HI Enables With Clear Faults - 0l m H =
@ Pull up +5V - :

Pull down [INZ] Mot Configured . of ms H BITO
[IN3] Mot Configured =) 0 ms H BIT1
@ Pull up +5V [IN4] | ot Configured - 0 ms Hi BIT 2
Pldown el (NotConfigured = o] ms H BIT3

F 3

Hold position when limit switch is active Restore Defaudts ] Cose
4

Hold position setting. Indicates input is used as a CAN address bit|
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Parameter | Description
Pull up +5V | Pulls up the group of inputs up to internal +5 V.
Pull down Pulls the group of inputs down to internal signal ground.
Debounce Specifies how long an input must remain stable at a new state before the amplifier recognizes the
Time state. Increase to prevent multiple triggering caused by switch bounce upon switch closures.
Range: 0 to 10,000 mS.
Debounce does not affect inputs that have been configured as PWM, Pulse and Direction, or
Quadrature control inputs.
IN1- INp Select the function for the input.
*Hold position Available in position mode only:
when limit switch is | \when one or more inputs are configured as a limit switch (NEG Limit-HI Inhibits, NEG Limit-
active LO Inhibits, POS Limit-HI Inhibits, or POS Limit-LO Inhibits). The *Hold position option
prevents any motion while a limit switch is active. This option uses the Abort Deceleration
rate to stop the motor as described in Trajectory Limits.
CAUTION: If the amplifier is switched back to current or velocity mode with this option
selected, the limit switches will no longer function
Restore Defaults Restores all inputs and outputs to factory defaults.
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Digital Input Functions

Depending on the mode of operation, some inputs may have a predefined function such as enable
Typically IN1 is defined as an enable input.

or motor temperature sensor.

Motor/Feedback

Input Function

Description

AMP Enable-
LO Enables with clear faults

A low input will enable the amplifier.
Any transition will clear latched faults and outputs.

AMP Enable-
HI Enables with clear faults

A High input will enable the amplifier.
Any transition will clear latched faults and outputs.

AMP Enable-
LO Enables with reset

A low input will enable the amplifier.
A low to High transition will reset the amplifier.

AMP Enable-
HI Enables with reset

A High input will enable the amplifier.
A High to low transition will reset the amplifier.

AMP Enable-LO Enables

A low input will enable the amplifier.

AMP Enable-HI Enables

A High input will enable the amplifier.

Not Configured

No function assigned to the input.

NEG Limit-HI Inhibits*

A High input will inhibit motion in negative direction.

NEG Limit-LO Inhibits*

A low input will inhibit motion in negative direction.

POS Limit-HI Inhibits*

A High input will inhibit motion in positive direction.

POS Limit-LO Inhibits*

A low input will inhibit motion in positive direction.

Reset on LO-HI Transition

A low to Hi transition of the input will reset the amplifier.

Reset on HI-LO Transition

A High to low transition of the input will reset the ampilifier.

Motor Temp HI Disables

A High input will generate a Motor Over Temperature fault.

Motor Temp LO Disables

A low input will generate a Motor Over Temperature fault.

Home Switch Active HI

A High input indicates the home switch is activated.

Home Switch Active LO

A low input indicates the home switch is activated.

Motion Abort Active HI

A High input causes the amplifier to stop motion, using the Abort
Deceleration rate described in Trajectory Limits. The amplifier remains
enabled.

Motion Abort Active LO

A low input causes the amplifier to stop motion, using the Abort
Deceleration rate described in Trajectory Limits. The amplifier remains
enabled.

Hi Res Analog Divide Active HI

A High input causes the firmware to divide the level of the analog input
signal by 8.

Hi Res Analog Divide Active LO

A low input causes the firmware to divide the level of the analog input
signal by 8.

High Speed Position Capture on LO-HI
Transition

Position will be captured on the low to high transition of the input.

High Speed Position Capture on HI-LO
Transition

Position will be captured on the high to low transition of the input.

PWM Sync Input

PWM synchronization input. Synchronizing PWM Switching Frequency.
(For high-speed inputs only.)
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6.2: Digital Outputs

A typical Digital Outputs screen is shown below. Options vary with model and configuration.

Red LED: Qutput is active
Gray LED: Output is inactive

Indicates the state of the output On/Off or Hi'Lo

* Input/Output " o @ =)
| Digital Inputs 16 | Digital Inputs 7-14 | Digital Outputs | Analog 10| ¥
[OUT 1] | Faut-Actve High v) H e
[OUT 2] Mot Configured - H .
[OUT 3] |NotConfigured > lo =
[OUT 4]  Not Configured = off =
[OUT 5] Not Configured - off =
[OUT 6]  Brake-Active mn - e
* Hold pasition when limit switch is active Restore Defaults ] | Close |
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Output Function

Description

Not Configured

No function. Output remains Hi/Off.

Fault Active Hi/Off

Output goes Hi/Off when one or more faults are detected.

Fault-Active Lo/On

Output goes Lo/On when one or more faults are detected.

Brake-Active Hi/Off

Output goes Hi/Off to activate the brake.

Brake-Active Lo/On

Output goes Lo/On to activate the brake.

PWM Sync Output (OUT1 only)

The PWM synchronization output.

Custom Event

See Custom Event Triggered Output

Custom Trajectory Status

See Custom Trajectory Status Triggered Output.

Custom Position Triggered Output

See Custom Position Triggered Output.

Program Control Active Hi/Off

Output state controlled by CVM or external program.

Program Control Active Lo/On

Output state controlled by CVM or external program

Harmonic Drive LLC
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6.3: Custom Event Triggered Output

Motor/Feedback

Digital outputs can be configured for one or more bits in the Event Status (faults, warnings, and

status).

1

63

[OUT 2] | Custom Event = Lo

I Configure Custom I

Choose Custom Event for the output configuration, then click Configure Custom to

open the Event Triggered Output screen.

Event Triggered Output
[] Amplifier Fault

m

[7] Motor Phasing Error

[] Feedback Errar

[7] Under Voltage
[] Over Voltage
[ short Circuit
[ Current Limited

P [T 3

~ Output Active High (@ Output Active Low

I Ok I [ Cancel I [ Help I

Select one or more events from the list. Selections are OR’ed together, so that any

event will cause the output to go active.
The Clear button clears all selections.

Choose Output Active Hi/Off or Output Active Lo/On.
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4 To latch the output, set the Latch Output option.

Latching an output does not eliminate the risk of unexpected
motion with non-latched faults.

Associating a fault with a latched, custom-configured output does
not latch the fault itself. After the cause of a non-latched fault is
corrected, the amplifier re-enables without operator intervention. In

DANGER  this case, motion may re-start unexpectedly.
Failure to heed this warning can cause equipment damage,
injury, or death.
) Click OK to save changes to amplifier RAM and close the screen

Event

Description

Amplifier Fault

A latched fault is active.

Amp Over Temperature

For descriptions of these fault events, see Faults

Motor Phasing Error

Feedback Error

Motor Over Temperature

Under Voltage

Over Voltage

Short Circuit

Current Limited

The current output is being limited by the 12T Algorithm or a latched current fault
has occurred.

Voltage Limited

Current loop is commanding the full bus voltage in an attempt to control current.
Commonly occurs when the motor is running as fast as the available bus voltage
will allow.

Positive Limit Switch

Axis has contacted positive limit switch.

Negative Limit Switch

Axis has contacted negative limit switch.

Amp Disabled by Hardware

Amplifier enable input(s) is not active.

Amp Disabled by Software

Amplifier is disabled by a software command.

Attempting to Stop Motor

The amplifier, while in velocity or position mode, has been disabled.

In velocity mode, amplifier is using the Fast Stop Ramp described in

Velocity Loop Limits. In position mode, the amplifier is using the Abort Deceleration
rate described in Trajectory Limits.

The output remains active until the amplifier is re-enabled.

Motor Brake Active

Motor brake activated.

PWM Outputs Disabled

The amplifier's PWM outputs are disabled.

Positive Software Limit

Actual position has exceeded the positive software limit setting.
See Homing.

Negative Software Limit

Actual position has exceeded the negative software limit setting.
See Homing

Following Error

Following error has reached programmed fault limit.
See Following Error Faults

Following Warning

Following error has reached programmed warning limit.
See Following Error Faults

Position has Wrapped

The position counters have exceeded the maximum range of
-23' — 23'.1 and have wrapped. Normal amplifier operation is not affected.
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Velocity Limited

The velocity command (from analog input, PWM input, or position loop) has
exceeded the velocity limit. See Velocity Loop Limits

Acceleration Limited

In velocity mode, motor has reached an acceleration or deceleration limit that was
set as described in Velocity Loop Limits

Pos Outside of Tracking Window

The following error has exceeded the programmed value.
See Position and Velocity Tracking Windows

Home Switch Active

Axis has contacted the home limit switch.

In Motion

The motor is moving, or it has not yet settled after a move. The amplifier is settled
when it comes within the position tracking window and stays there for the tracking
time at the end of a move. Once this bit is set, it remains set until a new move is
started.

Vel Outside of Tracking Window

Difference between target and actual velocity has exceeded the window. See
Position and Velocity Tracking Windows

Phase not Initialized

Amplifier is using Phase Initialization function and phase is not initialized.

Command Input Fault

PWM or other command signal (e.g., EtherCAT master) not present. If Allow 100%
Output option is enabled by a setting Bit 3 of Digital Input Command Configuration
this fault will not detect a missing PWM command.

Latched vs. Non-Latched Custom Event
An output that is configured for a custom event can be latched or non-latched.

If a non-latched output goes active, it will go inactive as soon as the last of the selected events is
cleared. If a latched output goes active, it remains active until at least one of the following actions

has been taken:

o Reset or power-cycle the amplifier.
e Cycle (disable and then enable) an input that is configured as Enable with Clear Faults or

Enable with Reset.

e Open the Control Panel and press Clear Faults or Reset.

The latched/non-latched behavior of an output configured as a custom event is independent of the
drive’s latched/non-latched fault. Consider the following example:

OUT3 is configured as a custom event: under voltage and latched, but the Under Voltage
fault on the Configure Faults screen is set to non-latched. The table below shows the
difference in behavior between the output and the drive’s fault reporting.

Condition

Drive OuUT3

OCcurs

Under voltage condition

Disables PWM outputs, and reports Goes to active state

under voltage faults

corrected

Under voltage condition is

Under voltage fault is not reported and
PWM outputs are enabled

Stays active
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6.4: Custom Trajectory Status Triggered Output

Digital outputs can be configured for one or more events in the Trajectory Status.

[OUT 2] Custom Trajectory Status = Hi *

[ Configure Custom ]

Choose Custom Trajectory Status for an output and then click Configure Custom to
open the Trajectory Status Triggered Output screen.

Trajectory Status Triggered Output

[ Homing Errar

[] Referenced {Homed)

[] Homing In Progress

[ Move Aborted

[] Trajectory Generator Funning

[] Camming Buffer Error

*) Dutput Active High @ Output Active Low

POk |[ Cancel I

2 Select one or more events from the list. Selections are OR’ed together, so that any
event will cause the output to go active.

Status Description

Homing Error Activate output if an error occurred in the last homing attempt.
Referenced (Homed) Activate output if the most recent homing attempt was successful.
Homing in Progress Activate output when a homing move is in progress.

Move Aborted Activate output if move is aborted.

Trajectory Generator Activate output while trajectory generator is generating a move.
Running

Camming Buffer Error | A camming buffer error has occurred.

3 Choose Output Active High to have the output go high when active or Output Active Low
to have the output go low when active.

4 Click OK to save changes to amplifier RAM and close the screen.

Harmonic Drive LLC 66



HDM User Guide Motor/Feedback

6.5: Custom Position Triggered Output

[OUT 2] | Custom Position Triggered Output - Lo @

[ Configure Custom I

Choose Custom Position Triggered Output for an output and then click Configure
Custom to open the In Position Triggered Output screen.

Position Triggered Output

Configuration
(@) In Position Window
() Trigger At Position
~ Trigger Positive Motion
_' Trigger Megative Motion

1 Output Active High @) Output Active Low

Upper Position: 0| counts

Lower Position: 0| counts

@ Use Actual Position
() Use Limited Position

2 Select one of the configurations described below and enter appropriate values for the
parameters.
Configuration | Description and Parameters
In Position Activates the output while the axis is in the window between the programmed Upper
Window and Lower positions.

Trigger at Position | Activates the output for the programmed Time when the axis travels through the
programmed Position.

Trigger Positive Activates the output for the programmed Time when the axis travels in the positive
Motion direction through the programmed Position.

Trigger Negative Activates the output for the programmed Time when the axis travels in the negative
Motion direction through the programmed Position.

3 Choose Output Active High to have the output go high when active or Output Active Low
to have the output go low when active.

4 In stepper mode with no encoder, choose Use Limited Position. Otherwise choose Use
Actual Position.

) Click OK to save changes to amplifier RAM and close the
Custom Output Configuration screen.
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Synchronizing PWM Switching Frequency

In some situations, such as when sampling small analog signals, it is desirable to synchronize the
PWM switching frequency among multiple amplifiers. In these cases, one amplifier serves as a
master for one or more slave amplifiers. The PWM sync output of the master sends a signal that is
received as a PWM sync input by each slave. To configure this, an output of the master must be
configured as PWM Sync Output and one input on each of the slaves must be configured as PWM

Sync Input.
[OUT 4]  Eiiii Sync Cutput -

[IN4] PWM Sync Input -

6.7: Analog I/O

A typical Analog I/O screen is shown below. Currently, only the REL/RTL has analog 1/O
functionality.

[ o) = |

#  Input/Output

| Digital Inputs 1-6 | Digital Inputs 7-14 | Digital Outputs | Analog 10 |

Analog Motor Temperature Sensaor

Lirnit: 0 mv

Actual Voltage: 4166 mV

Analog Output

Mode: :Manual -

Programmed Value: 0| my

*Hold position when limit switch is active Restore Defaults ] [ Close ]
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Analog Motor Temperature Sensor
Enter a voltage limit in mV. Fault will occur when voltage is above limit. Actual voltage is the
sensor reading in mV.

Analog Motor Temperature Sensor

Lirnit: 0| my

Actual Voltage: m\y

Analog Output
The Analog Output has two modes of operation, Manual and Actual Current.

When Manual is chosen the output is set to the programmed value, +/- 5V, entered in mV.

Mode: | Manual -

Programmed Value: 1| my

When Actual Current is chosen the output value is proportional to the actual motor current.

Mode: | Actual Current -

Analog Qutput Value: 1 my
Actual Current: 0.01 A
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Command Inputs

7.1: Analog Command Settings

| Analog Command

| Click the Analog Command button on the Main screen.

P 5
* Analog Command [ EJ[ = ﬂh,l
Scaling: b.67| A =10V
Dead Band: 0 my
[] Invert Command
Dffset
Offset: 0| mv

Parameter

Description

Scaling

Current mode: output current produced by +10 Vdc of input.

Range: 0 to 10,000,000 A. Default: Peak Current value.

Velocity mode: output velocity produced by +10 Vdc of input.

Range: 0 to 100,000 rpm (mm/sec).

Default: Maximum Velocity value.

Position mode: position change (counts or mm) produced by +10 Vdc of input.
Range: 0 to 1,000,000,000 counts.

Default: 1 Revolution of a rotary motor or 1 pole pair distance for a linear motor.
For more information, see Scaling

Dead Band

Sets dead band. Range: -10,000 to 10,000 mV. Default: 0.
For more information, see Dead Band

Invert Command

Inverts polarity of amplifier output with respect to input signal.

Offset

(Current and Velocity modes only.) Used to offset input voltage error in an open loop system. Not
recommended for use when the amplifier is part of a closed loop system.
Range: -10,000 to 10,000 mV. Default: 0. For more information, see Offset
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Analog Command Notes

The amplifier can be driven by an analog voltage signal through the analog command input. The
amplifier converts the signal to a current, velocity, or position command as appropriate for current,
velocity, or position mode operation, respectively. The analog input signal is conditioned by the
scaling, dead band, and offset settings.

Scaling

The magnitude of the command generated by an input signal is proportional to the input signal
voltage. Scaling controls the input-to-command ratio, allowing the use of an optimal command
range for any given input voltage signal range.

For example, in current mode, with default scaling, +10 Vdc of input generates a command equal
to the amplifier's peak current output; +5 Vdc equals half of that.

Scaling could also be useful if, for example, the signal source generates a signal range between 0
and +10 Vdc, but the command range only requires +7.5 Vdc of input. In this case, scaling allows
the amplifier to equate +7.5 Vdc with the amplifier’s peak current (in current mode) or maximum
velocity (in velocity mode), increasing the resolution of control.

Dead Band

To protect against unintended response to low-level line noise or interference, the amplifier can be
programmed with a “dead band” to condition the response to the input signal voltage. The amplifier
treats anything within the dead band ranges as zero, and subtracts the dead band value from all
other values. For instance, with a dead band of 100 mV, the amplifier ignores signals between —
100 mV and +100 mV, and treats 101 mV as 1 mV, 200 mV as 100 mV, and so on.

200

100 Dead Band

Output
o
<
4.

-100

-200

-200 -100 0 100 200
Input
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Offset

To remove the effects of voltage offsets between the controller and the amplifier in open loop
systems, HDM provides an Offset parameter and a Measure function. The Measure function takes
10 readings of the analog input voltage over a period of approximately 200 ms, averages the
readings, and then displays the results. The Offset parameter allows the user to enter a corrective
offset to be applied to the input voltage.

The offset can also set up the amplifier for bi-directional operation from a uni-polar input voltage.
An example of this would be a 0 to +10 Vdc velocity command that had to control 2000 rpm CCW
to 1000 rpm CW. Scale would be set to 2000 rpm for a +10 Vdc input and Offset set to -5V. After
this, a 0 Vdc input command would be interpreted as -5 Vdc, which would produce 1000 rpm CCW
rotation. A +10 Vdc command would be interpreted as +5 Vdc and produce 1000 rpm CW rotation.

Monitoring the Analog Command Voltage
The analog input voltage can be monitored in the Control Panel and in the Scope Tool. The
voltage displayed in both cases is after both offset and deadband have been applied.

Analog Command in Position Mode

The Analog Position command operates as a relative motion command. When the amplifier is
enabled the voltage on the analog input is read. Then any change in the command voltage will
move the axis a relative distance, equal to the change in voltage, from its position when enabled.
To use the analog position command as an absolute position command, the amplifier should be
homed every time it is enabled. The Homing sequence may be initiated by CAN, ASCII serial, or
CVM Indexer program commands.
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1.2:

PWM Input Settings

s Coneead | Click the PWM Command button on the Main screen.

« PWM Command (0B {scul o=l S|

Scaling: k.67 A at 100% duty cyde
Input Type:

i@ 50% Duty Cyde (7 100% Duty Cyde
Options:

[] Invert PWM Input
[] Allow 100%: Output
Invert Sign Input

HDM User Guide

Parameter Description

Scaling Current mode: output current at 100% duty cycle.
Range: 0 to 10,000,000 A. Default: Peak Current value.

Velocity mode: output velocity at 100% duty cycle.
Range: 0 to 100,000 rpm (mm/sec).
Default: Maximum Velocity value.

PWM Input Type One wire 50% or two wire 100% with direction.

Options Invert PWM input: Inverts the PWM logic.

Allow 100% output: Overrides the 100% command safety measure.
See Failsafe Protection from 0 or 100% Duty Cycle Commands

Invert Sign Input: In 100% duty cycle mode, inverts the polarity of the directional input.

Harmonic Drive LLC
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50% Duty Cycle (One-Wire)

The input takes a PWM waveform of fixed frequency and variable duty cycle. As shown below, a
50% duty cycle produces zero output from the amplifier. Increasing the duty cycle toward 100%
commands a positive output, and decreasing the duty cycle toward zero commands a negative

output.
Decreasing Duty Cycle

| ]

The command can be inverted so that increased duty cycle commands negative output and vice
versa.

100% Duty Cycle (Two-Wire)

One input takes a PWM waveform of fixed frequency and variable duty cycle, and the other input
takes a DC level that controls the polarity of the output. A 0% duty cycle creates a zero command,
and a 100% duty cycle creates a maximum command level. The command can be inverted so that

increasing the duty cycle decreases the output and vice versa.
100% 100%
Duty Cycle Duty Cycle

U U

Direction Input

Amplifier Output

Failsafe Protection from 0 or 100% Duty Cycle Commands

In both formats, the amplifier can be programmed to interpret 0 or 100% duty cycle as a zero
command, providing a measure of safety in case of controller failure or cable break.
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7.3: Digital Position Input Settings

Digital Input

r

* Digital Input

| Click the Digital Input button on the Main Screen.

(o) [ s e

Input Config

Control Input:

~ Pulse Up  Pulse Down

) Quadrature

Stepping Resolution
1| Input Pulses =

[] Invert Command

Increment Pasition on:
@ Rising Edge

~ Falling Edge

1| Output Counts

Close

Parameter

Description

Control Input

Pulse and Direction: One input takes a series of pulses as motion step commands, and
another input takes a high or low signal as a direction command.

Pulse Up / Pulse Down: One input takes each pulse as a positive step command, and
another takes each pulse as a negative step command.

Quadrature: A/B quadrature commands from a master encoder (via two inputs) provide
velocity and direction commands.

Increment position on

Rising Edge: Increment position on the rising edge of the input pulse.
Falling Edge: Increment position on the falling edge of the input pulse.

Stepping Resolution

Input Pulses: Number of Input Pulses required to produce output counts.
Range: 1 to 32,767. Default: 1.

Output Counts: Number of Output Counts per given number of input pulses.
Range: 1 to 32,767. Default: 1.

Invert Command

When selected, inverts commanded direction.

Pulse Smoothing

In digital position mode, the amplifier's trajectory generator can be used to create trapezoidal
profiles, with programmed acceleration, deceleration and velocity, from a simple pulse train or
burst of pulses. To bypass the trajectory generator while in digital or analog position modes, set
the maximum acceleration to zero. The only limits in effect will now be the velocity loop velocity
limit and the current limits. (Note that leaving the maximum acceleration set to zero will prevent
other position modes from operating correctly.)
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Pulse and Direction

In pulse and direction format, one input takes a series of pulses as motion step commands, and
another input takes a high or low signal as a direction command, as shown below.

Pulse Input J—|_|—|_|—H ML

Direction INpUt e e e e e e e e e e e e e = = = E N N S E . E S EEEsEs ===

Velocity /
Command @ =D = m = m e m e . = . . e ——— e = = = = == == == - f

The amplifier can be set to increment position on the rising or falling edge of the signal. Stepping
resolution can be programmed for electronic gearing.

Count Up/Count Down

In the count up/count down format, one input takes each pulse as a positive step command, and
another takes each pulse as a negative step command, as shown below.

Up Input J—H—H—H
Down Input H H_H ﬂ

Velocity /
Command = == == == == == == == -------------/7

The amplifier can be set to increment position on the rising or falling edge of the signal. Stepping
resolution can be programmed for electronic gearing.

Quadrature

In quadrature format, A/B quadrature commands from a master encoder provide velocity and
direction commands, as shown below.
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Alnput

B Input

Velocity /
Command ==Lt = e e e ———__—_———— e e - - _/___

The ratio can be programmed for electronic gearing.
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7.4: Software Programmed Input Settings

These settings can be saved to flash to allow default conditions to be set and used when the
amplifier is powered up or reset.

Programmed Position

Programmed Position

L Click the Programmed Position button on the Main screen.

* Programmed Command c=g|C=REE

Mawve: Type:
i@ Relative i@ Trap
(") Absolute i) 5 Curve
Distance: 0 | counts
Setting Description
Move Relative or Absolute.
Type Trap or S-Curve.
Distance Move distance (relative) or location (absolute)
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Programmed Velocity

Programmed Velocity |

Click the Programmed Velocity button on the Main screen.

F

* Programmed Command [EJEI'_'&J

Programmed Velocity:

III| rpm

Close

DANGER

Potential for unexpected movement.

If the Programmed Velocity is set to values other than 0, the motor
will move after power-up or reset if the amplifier is hardware
enabled.

Failure to heed this warning can cause equipment damage,
injury, or death.

Setting

Description

Programmed Velocity

Move velocity. Units: rpm (rotary) or mm/s (linear).
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Programmed Current

Pr med Current . i
il ik | Click the Programmed Current button on the Main screen.

P # Programmed Command @Jl — | |_-"-‘&J1

Programmed Current: 0 A

Current Ramp: 0| mafs

Close

Potential for unexpected movement.

If the Programmed Current is set to values other than 0, the motor
will move after power-up or reset if the amplifier is hardware
enabled.

DANGER  Failure to heed this warning can cause equipment damage,
injury, or death.

Setting Description

Programmed Current | Current applied during the constant velocity portion of the move. Units: A.

Current Ramp Acceleration/deceleration current. Units: mA/s.
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8.1: CANopen Network

Command Inputs

A CANopen network can support up to 127 nodes. Each node must have a unique and valid
seven-bit address (Node ID) in the range of 1-127. (Address 0 should only be used when the
amplifier is serving as a HDM serial port multi-drop gateway.)

83

Verify that the CAN network has been cabled and terminated as per amplifier documents.

CAN Configuration

Click CAN Configuration to open the CAN Configuration screen. (If CAN is

not the Position Loop Input, choose Amplifier>Network Configuration instead.)

CAM Configuration

Metwork Type:

@ CAM () DeviceMNet
BitRate:  1Mbitls
Address Configuration
[/] Use Switch
[ Use Inputs

Switch Value:
Input Lines Value:
Programmed Value:

Mew Resulting Address;

[ Use Programmed Value

-

Input Mapping

Mumber of Inputs: |0

Bit 0: |Mone Switch
Bit 1: |Mone Switch
Bit Z: |Mone Switch
Bit 3: |Mone Switch
Bit 4: | None
Bit 5: | None

Bit 6: | Mone

| Save & Close H Cancel H Help |

Choose network type (CAN or DeviceNet). This is optional for some drives.

Choose a Bit Rate and choose any combination of address sources (Switch, Inputs, and
Programmed Value). The address is the sum of the values from these sources.

For each source selected, perform the additional steps described below.

Source Additional Steps

Use Switch Verify the S1 switch setting. (Assigns values for Bit 0 — Bit 3 of CAN address.)
Use Inputs Enter Number of Inputs, then choose inputs to represent each CAN address bit.
Use Programmed Value | Enter the Programmed Value.

Click Save & Reset to save changes to amplifier flash, close the screen, and reset the
amplifier. Click Save & Close to save changes to amplifier flash without resetting.
NOTE: Address and bit rate changes take effect only after power-up or reset.
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MACRO Network

A Delta Tau PMAC card can hold up to four MACRO IC’s, each of which is a master on a MACRO
ring. Each master IC can address 16 stations (hodes, slaves), enabling the addressing of up to 64
devices on a ring. Of these, 32 can be motion devices such as Xenus XML. A node address is an
8-bit value with bits 7-4 addressing the master IC and bits 3-0 addressing the slave.

XML switch S1 is set to select the master IC to which the Xenus will be linked. The four possible
values for this setting are 0,1,2, and 3.

As a MACRO station or node the XML has eight available addresses as a motion control device.
These are 0,1,4,5,8,9,12, & 13.

1 Verify the S1 and S2 switch settings.

Select Amplifier->Network Configuration from the HDM Main Screen to open the MACRO
Configuration screen as shown in the following example.

-

MACRO Configuration [wE3m|

Master Address: 0
Slave Address: 0
Scaling Input Command: 15000| A

Heart Beat Time Out: 0 ms

Home Status Bit:
| Use Motor Encoder Index
@) Use Home Input

Auxiliary Data Registers
First: Digital Input -

Second: | Analog Input -

[] Enable Position Qutput Scaling
[] Active Network Required for Amp to Enable

[] Enable MACRO Network Synchronization

Current Loop Freguency: 16 | kHz

Cloze
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Parameter Description

Scaling Input Command | Current mode: output current produced by +10 Vdc of input.
Range: 0 to 10,000,000 A. Default: Peak Current value.

Velocity mode: output velocity produced by +10 Vdc of input.

Range: 0 to 100,000 rpm (mm/sec).
Default: Maximum Velocity value.

Heart Beat Time Out The frequency at which the drive will produce heartbeat messages. This parameter
may be set to zero to disable heartbeat production.

Home Status Bit Use Motor Encoder index: Return the primary encoder index state in the home
status bit of the MACRO status word.

Use Home Input: The state of any general purpose input configured as a home
input will be returned in the home status bit of the MACRO status word.

Auxiliary Data Registers | Defines what type of additional data is transmitted in the Auxiliary data registers of
every MACRO response message.

First Register: Digital input Value, Secondary Analog Input Value.
Second Register: Analog Input, Motor Encoder, Position Encoder.

Enable Position Output When selected, position data sent over the MACRO network is shifted up 5 bits to
Scaling be compatible with Delta-Tau controllers.

Enable MACRO Network | Allows the drive’s PWM frequency to be adjusted to allow synchronous operation
Synchronization with the MACRO ring. Note that changing the PWM Frequency will affect the

Current Loop Frequency current loop tuning. Therefore, current loop tuning will need to be checked.

Active Network Required | If selected, drive will not enable if network is not active.
for Amp to Enable
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EtherCAT Network

An EtherCAT network enables high-speed control of multiple axes while maintaining tight
synchronization of clocks in the nodes. Data protocol is CANopen over EtherCAT (CoE) based on
DSP-402 for motion control devices.

Stations on EtherCAT are automatically addressed by their bus location. The first drive on the
network is station address -1. The second is -2, and so on.

As an alternate to the default addressing, switches S1 and S2 may be used to program a station
alias. The default address and station alias are always available. If the switch-based station alias is
used, it is the responsibility of the user to ensure that each drive has a unique station alias.

EtherCAT Address (Station Alias)

1 View the S1 and S2 switch settings on the drive.

Verify the S1 and S2 switch settings select Amplifier>Network Configuration from the HDM
Main Screen to open the EtherCAT Settings screen as shown in the following example.

-

% EtherCAT Settings || 2%

al: 0
52 0
Resulting Device ID: ]

Close
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9.1: Overview

Latched vs Non-latched Faults

When a fault is configured to be latched, the fault can only be cleared after the fault has
been corrected and at least one of the following actions has been taken:

o Power-cycle the amplifier

¢ Cycle (disable and then enable) an input that is configured as
Enable with Clear Faults or Enable with Reset

e Open the Control Panel and press Clear Faults or Reset
e Clear the fault over the CANopen network or serial bus

A non-latched fault will be cleared when the fault condition has been removed. This can
occur without operator intervention.

Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifier re-
enables the PWM output stage without operator intervention. In this
case, motion may re-start unexpectedly. Configure faults as latched

DANGER unless a specific situation calls for non-latched behavior. When using
non-latched faults, be sure to safeguard against unexpected motion.
Failure to heed this warning can cause equipment damage,
injury, or death.

Example

The drive’s temperature reaches the fault level. The drive reports the fault and disables the
PWM output. Then, the drive temperature falls below the fault level.

Non-latched fault operation:
The fault is cleared and the amplifier's PWM outputs are enabled without operator
intervention.

Latched fault operation:
The fault remains active and the drive’s PWM outputs remain disabled until the faults are
cleared as described above.
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2
3
4

@ Click the Configure Faults button on the Main screen.

Fault Configuration \E\
rLatch Fault

Short Circuit

Amp Over Temperature
[¥] Motor Over Temp

[] over Voltage

[7] Under voltage

[] Feedback Errar

["] Motor Phasing Error

[¥] Following Error

[ command Input Fault

Optional Faults

Restore Defaults

[ 0K ] [ Cancel ] [ Help ]

Select the faults to latch. See Fault Descriptions.

Click OK to close screen and save changes to amplifier RAM.

Command Inputs

m On the Main screen, click Save to Flash to avoid losing the changes.
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9.2: Fault Descriptions

Note: The list of faults may vary with amplifier model.

HDM User Guide

Fault Description

Fault Occurs When...

Fault is Corrected When...

*Amp Over Temperature

Amplifier's internal temperature exceeds
specified temperature.

Amplifier's internal temperature falls
below specified temperature.

Motor Phasing Error

Encoder-based phase angle does not agree
with Hall switch states. This fault can occur
only with brushless motors set up using
sinusoidal commutation. It does not occur
with resolver feedback or with Halls
correction turned off.

Encoder-based phase angle agrees
with Hall switch states. See
Troubleshoot Manual Phase w/
Encoder and Halls

*Feedback error

Over current condition detected on output of
the internal +5 Vdc supply used to power the
feedback.

Resolver or analog encoder not connected or
levels out of tolerance.

Differential signals from incremental encoder
not connected.

Encoder power returns to specified
voltage range.

Feedback signals stay within specified
levels.

Differential signals connected.

*Motor Over Temp

Motor over-temperature switch changes
state to indicate an over-temperature
condition.

Temperature switch changes back to
normal operating state.

Under Voltage Bus voltage falls below specified voltage Bus voltage returns to specified
limit. voltage range.
Over Voltage Bus voltage exceeds specified voltage limit. Bus voltage returns to specified

voltage range.

*Following Error

User set following error threshold exceeded.

See Following Error Fault Details

*Short Circuit Detected

Output to output, output to ground, internal
PWM bridge fault.

Short circuit has been removed.

Command Input Lost

PWM or other command signal not present.

Command signal restored.

Over Current (Latched)

Output current I°T limit has been exceeded.

Amplifier is reset and re-enabled.

Motor Wiring Disconnected

The drive detects that it cannot push current
through the motor windings

The motor is reconnected.

*Latched by default.
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Auto Phase

The examples in this chapter show particular amplifier operating modes and motor feedback
configurations. Some screens and choices may vary from those described here.

Auto Phase Example: Servo Amplifier

NOTE: The following steps show Auto Phase with a brushless rotary motor, digital Halls, and an
incremental quadrature encoder. Screens vary for other configurations.

1 Verify that the Enable Input is not activated and that HV or AC power is applied.

2 2 Click Auto Phase to open the Auto Phase wizard.

i * Auto Phase @

Motor Direction Setup

Move the motor in the direction that you want
to be positive. Press MNext when done.

Motor Actual Position: 0 counts
{ Next> | | skip > | | Cancel
&2
3 Move the motor in the direction to be considered positive
OR

If you cannot move the motor, click Skip (you will confirm motor direction later).

NOTE: If an output is configured as a brake you can temporarily release the brake by
holding down the Release Brake button. The brake will be reactivated when you
release the button.

4 Click Next to go to the Motor Wiring Setup step:
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»*  Auto Phase

G )

Motor Wiring Setup

The software will now micro step the motor.
Make sure the motor is free to move.

Press Start when ready and

observe the motor movement.

Auto Phase Current: 0.3 A

Increment Rate: 90| elec degfs

Commanded Motor Phase Angle

80

150 20

Mator Actual Position: 0 counts

Mot Ready
Amp disabled by hardware.

< Back Mext >

Cancel

5 Activate the Enable Input.

6 Click Start to begin the motor wiring setup.
The message area displays messages: Configuring Initial Settings, Microstepping, Test
Complete, Motor Wiring has been configured.

Command Inputs

During microstepping, a current vector is applied to the motor windings and
microstepped through an electrical cycle at a set rate, causing the motor to move.

If you chose to Skip the motor direction setup step, Auto Phase will prompt for
confirmation of correct motor direction.

If the step fails see Troubleshooting the Auto Phase Problems

NOTE: If incorrect values were entered for inductance and resistance, the calculated Cp
and Ci values may produce current loop oscillation, evidenced by an audible high
frequency squeal during auto phasing.

7 Click Next to go to the Phase Count Test step.
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2

Phase Count Test

The software will now micro step the motaorin

120 60
the negative direction. Make sure the motor is 150 .
free to move. Press Start when ready. R
180 -y
Auto Phase Current: 0.54 A 210 330
240 o 200
Increment Rate: a0 | elec degfs “
Mave Distance: 4| elec Cydes Actual Motor Position: 0 counts

Ready

Commanded Mator Phase Angle

Configuration Settings

o | [(owr ] [ ot |

counts per rey 4000

Poles 3

HDM User Guide

8 Click Start to begin the Phase Count Test. Observe status messages. See the prompt:

Phase Counts

P
| |

Observe motor motion and verify that it

BF  moves 1 full turn before any gearing.

[l

o) When you are ready to observe motion, click OK.

When motion is complete the prompt will be displayed:

Phase Counts

'9' Did motor mowve 1 full turn?
Mo

(3]

If motor did not turn 1 full turn, click No and see Phase count test.

If motor turned 1 full turn, click Yes.

10 For a resolver (—R) version of a Harmonic Drive LLC amplifier, skip to Step 12.

For a non-resolver amplifier, click Next to open the Hall Wiring Setup screen.
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=

Hall Wiring Setup

The software will now micro step the motor.
Make sure the motor is free to move.
Press Start when ready.

Auto Phase Current: 0.54 a

Increment Rate: 90 | elec degfs

o ]

Hall Offeet: 0 deg

Ready

< Back

Commanded Motor Phase Angle
& Hall State

120 &0

B 130

240

h--D.

300

Hall States

u v W

Hi Hi Lo

Finish Cancel

11

Click Start to begin the Halls wiring setup. The message area displays the messages:

Microstepping. Test Complete. Motor has been properly phased.

During microstepping, a current vector is applied to the motor windings and
microstepped through an electrical cycle at a set rate, causing the motor to move. As
the motor moves the Hall lines are decoded for proper commutation.

If the step fails, see Halls wiring setup.

12

Resolver Phase Angle Setup screen.

For a resolver (-R) version of a Harmonic Drive LLC amplifier, click Next to open the

** Auto Phase

Feedback Phase Angle Setup

The software will now micro step the motor.
Make sure the motor is free to move.
Press Start when ready.

Auto Phase Current: 206 | A

Feedbadk Offset 0 deg

Feedback Angle 56 deg

Motor Actual Position: 8426513 counts

13

messages.

14

95

[sga] [Fown

Feedback angle in red. Commanded
motor phase angle in black.

120 &0

L.

300

130

240

Ready

Cancel

==l

Click Start to start the resolver phase angle setup. The message area displays status

Click Finish to close the screen and save values to flash memory
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OR to close the screen without saving changes, click Cancel.

15 If the Auto Phase algorithm does not produce desired results, try adjusting the Auto
Phase Current and Increment Rate values, using the guidelines in
Tips for Auto Phase Current and Increment Rate.

16 If desired results are not obtained, or to confirm results, proceed to Manual Phase
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10.2: Tips for Auto Phase Current and Increment Rate

e [f friction is high, more current may be required to move the load.

e High static friction may require more current to overcome stiction.

e Transition from static friction to dynamic friction, and back, may produce jerky motion.

o A faster increment rate will operate in the dynamic friction range.

o A slower rate will operate in the static friction range.

¢ If the friction is low, as in the case of air bearings, low frequency oscillations may occur;

thus, less current and slower rates may be required. If oscillations persist, then friction may
need to be temporarily added.

10.3: Troubleshooting the Auto Phase Problems

Motor direction setup

If motor direction setup step failed:
o Check Encoder or resolver power and signals.
o Verify that the encoder is differential. (Contact factory if encoder is single-ended.)
e Check shielding for proper grounding.

Motor wiring setup
If motor wiring setup step failed:
o Verify that amplifier is disabled.
Check for mechanical jamming.
Check for smooth motion with no mechanical jerking.
Check for good connections to the motor power wires.
Disconnect motor power wires and measure for proper motor resistance.

Phase count test
If phase count test failed:
¢ Verify that in the Motor/Feedback screen the following parameters have been set correctly:
o Number of Poles for rotary motors. Verify the motor’s pole count with the Data accuracy
test.

e Magnetic Pole Pair Length for linear motors.
Encoder Lines or Fundamental Lines for rotary encoders.
e Encoder Resolution for linear encoders.

Halls wiring setup

If Halls wiring setup step failed:
¢ Check Halls power and signals.
e Check for smooth motion with no mechanical jerking.
e Check shielding for proper grounding.

If the auto phase procedure fails despite these corrective measures, see Manual Phase
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10.4: Manual Phase

=

2

Harmonic Drive LLC

Remove load from the motor.

On the Main screen, choose Tools>Manual Phase to open the window:

Manual Phase @
rConfiguration rMonitor
sy No Faults
i Motor Phase Angle Black
Feedback Angle in Red
Offset 0 deg
—Feedback 120 60

rMotor Feedback————— 180 —

e Angle 0 deg

|| Invert Input

240 300
Motor Phase Angle: Odeg

rMotor

[F] Invert Cutput Position: 0 counts

Actual Current:  U: .03 A W 0.01A W 0.04 A
—Control
Increment Rate: 0| elec degfs Set Zero Position
R e & Move Motor
~) Enable @) Disable Re Fwd
Restore Defaults OK Cancel

(71 Disable

Verify the Current setting before enabling the drive.

Mowve Maotor
[ Rev ” Fwd I

To control the current vector rotation, command the motor forward or reverse.

NOTE: Some motors have bearings stiction, so helping the motor with mechanical force
Is acceptable. Motors with no friction may need friction added to steady motion.

If the motor cannot keep up with the rate of vector rotation, then reduce the Increment
Rate or increase the Current.

Verify that pressing forward button moves motor forward.
If the motor moves in the wrong direction, toggle the Motor Invert Output setting.

Verify actual position count agrees with direction of rotation: increasing counts in
forward direction and decreasing counts in reverse direction. If it does not, toggle the
Motor Feedback Invert Input box setting.

If the motor has no Halls, skip to Phase Initialization for Motor without Halls.
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9

10

Monitor the vector rotation through one electrical cycle for proper Hall transitions:

= Verify that the red indicator rotates in the same direction as the motor phase angle,
and that the transition occurs when the needle is between indicators (+30 degrees, as
shown below).

Wotor Phase &ngle & Hall Siat=

B an’
120 B0 H”
[ REN ”~
0 300
[ | [ |

= |f the needle and Hall states do not track properly, use the Hall Wiring list box and/or
Invert Input options (shown below) to swap the amplifier's Hall wire configuration.
—Hall=

Invert Input:
[Cu Cv [Ew

Hall Wiring: |[UVW -

Hall Offset: |, \yy 2]
URERY
~Motor Feedbady W L
[] Inwer wvu
WY

= |f the red indicator transition leads or lags behind the centered needle by more than
30 degrees, then try adjusting the Hall Offset in +/- 30 degree increments:

Hall Offset: 0 deg

Phasing of a motor with encoder and Halls is complete. Click OK.

Phase Initialization for Motor without Halls
The Phase Initialization is designed to phase a motor with no Halls.

DANGER

Halls are strongly recommended for safe, redundant system.

Harmonic Drive LLC strongly recommends the use of Halls or a
commutating encoder for commutation to provide a safe, redundant
system. If the application requires otherwise, the customer accepts
responsibility for verifying system performance and reliability.

Failure to heed these warnings can cause equipment damage,
injury, or death.

The Phase Initialization function uses as little motion as possible (less than 1/3 of one electrical
cycle) to determine phasing. Phase Initialization drives the motor in open loop current mode, using
microstepping of a current vector.
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1 Ensure that the motor is free to move (for instance, make sure the brake is OFF).

2 Ensure that no external force, such as gravity, will cause the motor to move. If it is not
practical to eliminate such forces, it may be necessary to use the Forced Phase feature
later in this procedure.

3 | Initialize Phase

To phase a motor with an encoder and no Halls, click Initialize Phase.
Observe the status messages under Monitor.

4 If the message “Phase Initialized” appears, the phasing of a motor with encoder and no
Halls is complete. Click OK to close the Manual Phase window.
5 ~Phase Initialize -
Time: 400 | mS
ey ol If the phasing function fails (for instance, message “Phase

Initialized” is not displayed, or if a phasing fault is
indicated) adjust the phase initialization settings described
below and try Step 4 (Initialize Phase) again.

(Current set to 0 uses IPeak)
["| Forced Phase

[7] Increment Phase 90 deg

[ Use Offset Initialize Phase

Setting Description

Time Used first as a delay, allowing amplifier to ramp up current to drive a small move.
Then used as a settling time. If the value is too low, the settling may not occur in
time, possibly resulting in jerky motion. Default: 400 ms.

Current Use to overcome stiction when rotating current vector. If the current is too large,
motion may not settle; a low value may not provide enough current to drive a move.

Forced Phase When selected, Forced Phase causes the Phase Initialization function to apply
Phase Init Current to alternate pairs of motor wires using the Phase Init Time.
Forced Phasing has been used to overcome various phasing problems, including
situations where gravity introduces unwanted motion. Forced Phasing tends to
produce more jerk and apparent motion.

Increment Phase 90 | If set, the amplifier will increase the starting phase angle by 90 degrees after every
deg failed initialization attempt.

Use Offset If set, the amplifier uses the Hall Offset value as the initialization starting angle.

Manual Phase Example: Motor with Resolver

1 Make sure that no load is connected to the motor.

2 On the Main screen, choose Tools>Manual Phase to open the window:
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Manual Phase

rResolver

Offset| 90 deg

Configuration rMonitor
Mo Faults

Motor Phase Angle Black
Feedback Angle in Red

Resolver— 120 60
rMotor Feedback —————————— 18 0
R Angle 180 deg
|| Invert Input
240 300
Motor Phase Angle:  274deg
rMator
[7] Invert Output Position: -2121  counts
Actual Current: U 0A W 0A W 0A
—Control
Increment Rate: 90 elec deg/s Set Zero Position
SRt G & Move Motor
") Enable @) Disable Re: F
Restore Defaults Ok Cancel

("1 Disable

Verify the Current setting before enabling the drive

Mowve Maotor
[ Rev ” Fwd I

Command Inputs

To control the current vector rotation, command the motor forward or reverse.

NOTE: Some motors have bearings stiction, so helping the motor with mechanical force
is acceptable. Motors with no friction may need friction added to steady motion.

If the motor cannot keep up with the rate of vector rotation, then reduce the Increment
Rate or increase the Current.

Verify that pressing forward button moves motor forward. If it does not, toggle the Motor
Invert Output box setting.

Verify actual position count agrees with direction of rotation: increasing counts in
forward direction and decreasing counts in reverse direction. If it does not, toggle the

Motor Feedback Invert Input box setting.
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7 Adjust Resolver Offset configuration as required, testing Fwd and Rev, to produce
alignment of Motor Phase Angle with Resolver Angle as shown here.

Molor Phase Angle Black
Feedback Angle in Red

120 60

180 [ 2u

290 300

Note: Motor manufacturers typically align the resolver in 30 degree increments, typically
by applying current through a pair of motor power wires.
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Troubleshoot Manual Phase w/ Encoder and Halls

To perform trapezoidal commutation after power-up or reset, the amplifier must receive good Hall
signals. After the first Hall transition is detected, then sinusoidal commutation can be performed. In
sinusoidal commutation, the amplifier uses the encoder for commutation while monitoring the Halls
to verify proper phase. If the error between the encoder count and Hall transition is too large, then
the Hall phase correction will not be performed and a phase fault will be triggered.

Test for phase fault problems in the order shown below.

Data accuracy test
1. Verify the motor’'s pole count:
e Apply a current vector at zero Increment Rate to lock motor in position.
e Turn the motor shaft and count the number of distinct locking positions.
e Calculate the number of poles: Poles = number of locking positions * 2
2. Verify the encoder line count OR a linear motor's magnetic pair length and the encoder
resolution.

Encoder wiring test
If the Halls produce good trapezoidal commutation but a phase fault is persistent in sinusoidal
commutation mode, the encoder is highly suspect:

o Verify the differential encoder signals.

o Verify proper twisted shielded cable with good grounding.

¢ Disable the amplifier and move the motor manually to test for phase fault.

[ ]

If phase fault only occurs under command of current, make sure the motor power cable is
not bundled with the encoder cable.

Hall signals test

If the Halls signals are suspected to be faulty:
o Make sure Halls change states as the motor moves through one electrical cycle.
e Some Hall signals are noisy and require filtering. Check with motor manufacturer.
e Some Halls are not properly calibrated to the motor manufacturer’s specification.

Hall transition test

If the location of the Hall transition is not within +/-30 degrees:
o Adjust Hall offset in smaller increments.
¢ Verify Hall alignment.
e Make sure motion is smooth.
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11.1: Current Loop Setup and Tuning

Control Loops

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be
calculated with Calculate.

Click I Loop to open the Current Loop screen:

M

Current Locp

)l e

Commanded —— £ Commanded
Current _*/ e " Volta
Limiter 7/ Co+d
j _
Offzet
Actual Current
Peak Current Limit: 41[A Cp: 102
I=T Time Limit: 1000 | ms Ci: 75
Continuous Current Limit: 2.14 A Drive Output
@ Maximize Smoothness
Current Loop Offset: oA () Maximize Speed
[ ] Enable Bus Clamping
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Parameter

Description

Peak Current Limit

Used to limit the peak phase current to the motor. Max value depends upon the
amplifier model; Min value > continuous limit.

I>T Time Limit

Sets I°T Time Limit in ms. See I2T Limit Algorithm.

Continuous Current Limit

Used to limit the Phase Current. Max Value is < Peak Current and depends upon
the amplifier model. Min value: 0

Current Loop Offset

Sets current loop offset. Leave it set to zero until after tuning. For more
information, see Offset

Cp

Current loop proportional gain. Range 0 — 32,767.

Ci

Current loop integral gain. Range 0 — 32,767.

Drive Output

Maximize Smoothness: Amplifier uses circular vector limiting to produce smooth
operation even into the voltage limits.

Maximize Speed: Allows for slightly more of the bus voltage to be used when in
the voltage limit. This may produce a small disturbance at top speed.

Enable Bus Clamping

Auto Tune

See Current Loop Auto Tune

Bandwidth

Measure bandwidth using the Cp and Ci values now in the amplifier.
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Manually tune the Current Loop
Apply square-wave excitation to the current loop and adjust current loop proportional
gain (Cp) and current loop integral gain (Ci) to obtain a desired waveform.

| Trace Status: '_I'rac_eCEEeléd - F-ieal:h-I To Start r:l;u-:l'r-ace

NOTE:
1. During tuning, observe any warnings or faults that appear in the status bar of the
scope.
2. Some users prefer the Auto Tune feature. See Current Loop Auto Tune (p. 121).

E Click the Scope Tool.

Apply Ta: ;.Current -
- Choose Current from the Function Generator Apply To:
list.

Auto SeUP O the Settings tab, make sure Auto Setup is selected.
Auto Setup automatically sets the following parameters:

Function Generator Tab

Parameter Description

Function Square Wave.

Amplitude 10% of continuous current value.
Frequency 100 Hz.

Settings Tab

Channel 1 Commanded current (green).
Channel 2 Actual current (white).

Amplitude: | 0.47) A

Verify that the Amplitude value is not excessive for the motor.
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o lil Click Start.

6 Current
F
Cpe- 2897 i
i 285

On the Gains tab, adjust current loop proportional gain (Cp):

= Set current loop integral gain (Ci) to zero.

= Raise or lower Cp to obtain desired step response. (Typically, little or no overshoot
with a 100 Hz, low-current square wave.) If the Cp value is too large, ringing may occur.
If the Cp value is too low, bandwidth decreases.

7 Adjust current loop integral gain (Ci) until desired settling time is obtained.

Is‘t';pl Press Stop to stop the function generator.

E:ﬂ On the Main screen, click Save to Flash to avoid losing the changes.
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11.2: Current Loop Auto Tune

The current loop Auto Tune algorithm applies a square-wave command to the current loop and
adjusts current loop proportional gain (Cp) and current loop integral gain (Ci) until a desirable
waveform is obtained.

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be
calculated with Calculate.

T ()
2% | Click | Loop to open the Current Loop screen:

N

Commanded Commanded
Current ) +//_\\ Current i oltage
Limiter
f B
Ed

Actual Current

Peak Current Limit: A cp:
12T Time Limit: ms Git EI
Continuous Current Limit: A Drive Output
(@ Maximize Smoothness
Current Loop Offset: E A () Maximize Speed

Enable Bus Clamping

2 Verify that the amplifier is hardware enabled.

3 Click Auto Tune to open screen and start the Current Loop Auto Tune.

e B

Auto Tune Current: A

Status:  Auto Tune in progress.

cp: 0 a 0 [s=t | [sme ] o

4 To Change the Auto Tune Current, Press Stop, enter the new current in the Auto Tune
Current field, and then press Start.
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Observe the Auto Tune process and results. A typical example:
= Sets Cp and Ci to zero and then adjusts Cp and Ci for optimal values.

* Auto Tune

Auto Tune Current: 1A
L |

Cp: 3|1 O o

Status:  Auto Tune in progress.

start

= Uses a frequency sweep to determine the small signal, current loop bandwidth.

Auto Tune Current: [ ‘1' A
L 4|

Cp: 335 G 252

Status:  Measuring Bandwidth

= Displays the results: a set of Cp and Ci alternatives, and the bandwidth measured

using the high Cp and Ci values.

=Au1n Tune Results

Auto Tune has determined new values for Cp and Ci along with
@ high bandwidth measurement. Select desired settings.

() High Cp: 335 G 252
@ Medium cp: 201 g 151
() Low Cp: 134 i 101
() Criginal Cp: 293 199

(@) Save Cp and Ci to Flash
() Keep Cp and Ciin RAM only

Bandwidth: 2600 Hz

Harmonic Drive LLC
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6 Choose an action based on Auto Tune results.

= Choose which set of values to save: High, Medium, Low, or Original.

The Medium values, selected by default, are appropriate for most applications.
= Optionally choose how to save: Save Cp and Ci to Flash

or Keep Cp and Ci in amplifier RAM only.

4 Click OK to save the values as chosen, and close the Auto Tune Results window.
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Notes on the Current Mode and Current Loop

Current Loop Diagram

As shown below, the “front end” of the current loop is a limiting stage. The limiting stage accepts a
current command, applies limits, and passes a limited current command to the summing junction.
The summing junction takes the commanded current, subtracts the actual current (represented by
the feedback signal), and produces an error signal. This error signal is then processed using the
integral and proportional gains to produce a command. This command is then applied to the
amplifier's power stage.

Current Loop Inputs

Current Loop

Current Integral Gain (Ci)

Current Proportional Gain (Cp) —'» @

Current Command— Current Limiter |Limited Current

Current Offset —— _/_\_ r yll

—

Limits: Feedback (Actual Current)
@ Peak Current

@ Continuous Current

@ Peak Current Limit Time

vt
1
o

I

e The amplifier's analog or PWM inputs.
o A CANopen network via the amplifier’'s CAN interface.
¢ A Harmonic Drive LLC Virtual Motion (CVM) control program.
o The amplifier's internal function generator.
In velocity or position modes, the current command is generated by the velocity loop.

Offset

The current loop offset is intended for use in applications where there is a constant force applied
to, or required of, the servomotor and the system must control this force. Typical applications
would be a vertical axis holding against gravity, or web tensioning. This offset value is summed
with the current command before the limiting stage.

Limits
The current command is limited based on the following parameters:
Limiter Description

Peak Current Limit Maximum current that can be generated by the amplifier for a short duration of time. This
value cannot exceed the peak current rating of the amplifier.

Continuous Current Maximum current that can be constantly generated by the amplifier.
Limit
I°T Time Limit Maximum amount of time that the peak current can be applied to the motor before it must be
reduced to the continuous limit or generate a fault.

For more details, see 12T Time Limit Algorithm .

Note: Although the current limits set by the user may exceed the amplifier's internal limits, the
amplifier operates using both sets of limits in parallel, and therefore will not exceed its own
internal limits regardless of the values programmed.

Ramp Rate of change in current command. Used to limit jog moves initiated from the Control Panel
Jog function in current mode, and in advanced Indexer Program functions.
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Current Loop Gains

Gain Description
Cp - Current loop The current error (the difference between the actual and the limited commanded current) is
proportional multiplied by this value. The primary effect of this gain is to increase bandwidth (or

decrease the step-response time) as the gain is increased.

Ci - Current loop integral | The integral of the current error is multiplied by this value. Integral gain reduces the current
error to zero over time. It controls the DC accuracy of the loop, or the flatness of the top of

a square wave signal. The error integral is the accumulated sum of the current error value

over time.

Current Loop Output
The output of the current loop is a command that sets the duty cycle of the PWM output stage of
the amplifier.
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11.4: Velocity Loop Setup and Tuning

Initial velocity loop proportional gain (Vp) and velocity loop integral gain (Vi) values can be

calculated with Calculate

Click the V Loop button on the Main screen (contents vary with model and configuration):

* Velocity Loop CESIESAREN X
Commanded
\eloc Velocity & Accel. Input
Limiter Filter
Commanded
Output Current s
Filter

Actual Velocity

Vel Limit: 3000 | rpm Accel, Limit: 1000 | rps? Vp: 433
Decel, Limit: 1000 | rPs? Vit 109 [tow Gains shift
Fast Stop Ramp: 1000 | rps? Vi Drain: 1]
Disable Gains
Tracking Ve 0
Window: &00 | rpm
Parameter Description
Velocity Limit Top speed limit. Max value may depend upon the back EMF & the Encoder value.

Min value: 0.

Acceleration Limit

Maximum acceleration rate. Max value may depend upon load, inertia, & peak
current. Min value: 1. (Does not apply in position mode.)

Deceleration Limit

Maximum deceleration rate. Max value may depend upon load, inertia, & peak
current. Min value: 1. (Does not apply in position mode.)

Tracking Window

Tracking Time

See Position and Velocity Tracking Windows

Vp

Velocity loop proportional gain. Range: 0 to 32,767.

Vi

Velocity loop integral gain. Range: 0 to 32,767.

Harmonic Drive LLC
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Fast Stop Ramp Deceleration rate used by the velocity loop when the amplifier is hardware
disabled. Range: 0 to 100,000,000. Default: velocity loop Decel. Limit value.

Low Gains Shift Increases the resolution of the units used to express Vp and Vi, providing more
precise tuning. For more information, see Velocity Gains Shift

Hi Gains Shift Decreases the resolution of the units used to express Vp and Vi, providing more
precise tuning. For more information, see Velocity Gains Shift

Vi Drain (integral Vi drain modifies the effect of velocity loop integral gain. The higher the Vi Drain

bleed) value, the faster the integral sum is lowered. Range: 0 to 32,000. Default: 0.

Vcff Velocity loop command feed forward. The input command to the velocity loop (after
limiting) is scaled by this value and added to the output of the velocity loop.
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Manually Tune the Velocity Loop

Apply square-wave excitation to velocity loop and adjust proportional gain (Vp) and
integral gain (Vi) to obtain desired waveform. For instance:

Trace Status: Trace Canceled - Ready To Start New Trace

NOTE: During tuning, observe any warnings that appear to the left of the trace.

1 Z
Click the Scope Tool.

2 Apdly To- . |iiglagly ¥ | Choose Velocity from the Function Generator Apply To:
list.

Aute S2UP - O the Settings tab, make sure Auto Setup is selected.
Auto Setup automatically sets the following parameters:

Function Generator Tab
Function Square Wave.
Amplitude 10% of maximum velocity value.
Frequency 5 Hz.
Settings Tab
Channel 1 Limited velocity (green).
Channel 2 Actual Motor Velocity (white).
4 Amplitude:

200 S Verify that Amplitude value is not excessive for the motor.

S Click Start.

6 On the Gains tab, adjust velocity loop proportional gain (Vp):

= Set velocity loop integral gain (Vi) to zero.
= Raise or lower proportional gain (Vp) to obtain desired step response. (Typically,
little or no overshoot on a 5 Hz small, slow-speed square wave.)

7 Adjust velocity loop integral gain (Vi) until desired settling time is obtained.
8 S0 | press Stop to stop the function generator.

ﬁ On the Main screen, click Save to Flash to avoid losing the changes.
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Velocity Loop Diagram

As shown below, the velocity loop limiting stage accepts a velocity command, applies limits, and
passes a limited velocity command to the input filter. The filter then passes a velocity command to
the summing junction. The summing junction subtracts the actual velocity, represented by the
feedback signal, and produces an error signal. (The velocity loop feedback signal is always from
the motor feedback device even when an additional encoder is attached to the load.) The error
signal is then processed using the integral and proportional gains to produce a current command.
Programmable digital filters are provided on both the input and output command signals.

Velocity Loop

Velocity Integral Gain (Vi)

Velocity Limited +
S ) ¥ }
Command ™ Velocity Limiter [ ger |_Velocity > Z Velocity Proportional Gain (Vp) - | 5| Filter _,ggrrentnd
Limits: |
@ Velocity
@ Acceleration* Feedback (Derived Velocity)

® Deceleration*
® Emergency Stop Deceleration*
*Not used w hen velocity loop is controlled by position loop. See "Velocity Loop Limits" for details.

Inputs
In velocity mode, the velocity command comes from one of the following:
o The amplifier's analog or PWM inputs.
o A CANopen network via the amplifier's CAN interface.
e A Harmonic Drive LLC Virtual Motion (CVM) control program.
o The amplifier's internal function generator.
In position mode, the velocity command is generated by the position loop.

Velocity Loop Limits
The velocity command is limited based on the following set of parameters designed to protect the
motor and/or the mechanical system.

Limiter Description

Velocity Limit | Sets the maximum velocity command input to the velocity loop.

Acceleration Limits the maximum acceleration rate of the commanded velocity input to the velocity loop.

Limit This limit is used in velocity mode only. In position mode, the trajectory generator handles
acceleration limiting.

Deceleration Limits the maximum deceleration rate of the commanded velocity input to the velocity loop.

Limit This limit is used in velocity mode only. In position mode, the trajectory generator handles
deceleration limiting.

Fast Stop Specifies the deceleration rate used by the velocity loop when the amplifier is hardware

Ramp disabled. (Fast stop ramp is not used when amplifier is software disabled.) If the brake
output is active, the fast stop ramp is used to decelerate the motor before applying the
brake.

Note that Fast Stop Ramp is used only in velocity mode. In position mode, the trajectory
generator handles controlled stopping of the motor. There is one exception: if a non-latched
following error occurs in position mode, then the amplifier drops into velocity mode and the
Fast Stop Ramp is used.




Control Loops HDM User Guide

Diagram: Effects of Limits on Velocity Command
The following diagram illustrates the effects of the velocity loop limits.

Limited Velocity

Commanded Velocity
A_ —_—

Vel Limit= =— =— 7L -

A VN
|

Accel Limit === = |==— Decel Limit ==

Velocity Loop Gains

The velocity loop uses these gains:
Gain Description
Vp - The velocity error (the difference between the actual and the limited commanded velocity) is
Velocity loop multiplied by this gain. The primary effect of this gain is to increase bandwidth (or decrease
proportional the step-response time) as the gain is increased.
Vi - The integral of the velocity error is multiplied by this value. Integral gain reduces the velocity
Velocity loop error to zero over time. It controls the DC accuracy of the loop, or the flatness of the top of a
integral square wave signal. The error integral is the accumulated sum of the velocity error value

over time.

Velocity Gains Shift

The Velocity Gains Shift feature adjusts the resolution of the units used to express Vp and Vi,
providing more precise tuning. If the non-scaled value of Vp or Vi is 64 or less, the Low Gains Shift
option is available to increase the gains adjustment resolution. (Such low values are likely to be
called for when tuning a linear motor with an encoder resolution finer than a micrometer.) If the
non-scaled value of Vp or Vi is 24001 or higher, the High Gains Shift option is available to
decrease the gains adjustment resolution.

Velocity Loop Filters
See Standard Filter Types

Velocity Loop Outputs
The output of the velocity loop is a current command used as the input to the current loop.

Proper Tracking Over Time

As described earlier, position error is the difference between the limited position output of the
trajectory generator and the actual position. Velocity error is the difference between commanded
and actual velocity.

When the position or velocity error exceeds the programmed tracking window value, a status word
bit is set. The bit is not reset until the error remains within the tracking window for the programmed
tracking time.
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Velocity Tracking lllustration
The following diagram illustrates the use of tracking window and time settings in velocity mode.

Actual Velocity

Limited Velocity

+ Tracking Window

Tracking
= Time —=
’ |
Vs |
/ | |

Tracking Window
Output
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11.6: Position Loop Setup and Tuning

Initial position loop proportional gain (Pp), velocity feed forward (Vff), and acceleration feed
forward (Aff) values can be calculated with Calculate

Click the P Loop button on the Main screen.

= Position Loop ['EJLI_I—J:' X
Trajectory Values | Position Loop Values |
Profile Acceleration - AT
Profile Velocity o |T|
+y Co‘mmanded
II.« -._: e \elocity
\ Muttiplier
-
Limited Position ¥ /T n
T Actual Position
Pp: 1000] Pi: Aff: 0 Gains Multiplier: 1
Pi Drain: Vif: 16384
Eit 100% Vff = 16334
Enable PID
Following Error Tracking
Fault: 4000 | counts Window: 1000 | counts
‘Warning: 2000 | counts Time: 10 | ms
[ Disable Fault
Parameter Description
Aff Acceleration feed forward. Range: 0 to 32,767. See Trajectory Limits
Vit Velocity feed forward. Range: 0 to 32,767. 100% Vff: 16,384.
Trajectory Limits
Pp Position loop proportional gain. Range: 0 to 32,767. See Trajectory Limits

Gains Multiplier

Position loop output is multiplied by this value before going to the velocity loop. In dual
encoder systems, the multiplier’s initial value is calculated based on the ratio of motor
encoder turns to position encoder turns.

Following Error
Fault

The level (in encoder counts) at which the following error produces a fault, which stops
the servo loop. We recommend raising the fault level before tuning the loop.
See Following Error Faults

Following Error
Warning

The level (in counts) at which the following error produces a warning (without stopping
the loop). See Following Error Warnings
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Disable Fault

Stops following error from faulting. See Following Error Faults

Tracking Window

Width of tracking window in counts. See Position and Velocity Tracking Windows

Tracking Time

Position must remain in the tracking window for this amount of time to be consid
tracking. See Position and Velocity Tracking Windows

ered

Pi Position loop integral gain
Pd Position loop derivative gain
Pi Drain Position loop integral drain
Enable PID Enables the PID parameters

Glckthe Pasiion Wrap buton.

Motor Position Wrap:

1 revolution of the motor is 4000 counts.

Load Position Wrap:

Load positioning nat configured.

-

(3]

0 | counts

0 | counts

I QK H Cancel ][ Help ]

Change/verify the position wrap parameters as needed. Set both values to zero to
disable position wrapping. Note that the changes do not take effect until OK is pressed.
For more information about this feature, see Position Wrap

Parameter

Description

Motor Position
Wrap

Position at which the actual motor position count returns to zero. In a single feedback

system, it also applies to the actual load position.

Load Position
Wrap

Position at which the actual load position count returns to zero in dual feedback

systems. If the position encoder is set to passive mode, this value applies to the

passive encoder position.
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Click on the Trajectory Values tab:

* Position Loop = l = e
Trajectory Values | Position Loop Values|
Profile Velocity &
Commanded Position Velocity & A = J Profile Acceleration &
Limiter <
—‘ Limited Piosition <
Max Velocity: 1500 | rpm Max Accel.: 0 rps?
Max Decel.: 500 | rps?
Abort Decel.: 500 | rps?
Jerk: 20000 | rps?
Parameter Description
Max Velocity Maximum trajectory velocity. Max value may depend upon the back EMF and the Max
feedback count. Min:0. Default: 0.25 x motor velocity limit.
Max Accel Maximum trajectory acceleration. Max value may depend upon the load inertia and
peak current. Min:0. Default: 0.5 x velocity loop Accel. Limit value.
Max Decel Maximum trajectory deceleration. Max value may depend upon the load inertia and
peak current. Min:0 (disables limit). Default: 0.5 x velocity loop Accel. Limit value.
Abort Decel Deceleration rate used by the trajectory generator when motion is aborted. Min:0.
Default: 0.5 x velocity loop Accel. Limit value.
Jerk Rate of change of acceleration. The value of jerk set during the calculate procedure

produces an S-Curve whose maximum slope is equal to the trajectory profile slope.
This value will produce a maximum acceleration that is not more than the initial default
value of acceleration. Small values will produce less jerking but will take longer to
complete move. Large values will produce more jerking and a more trapezoidal profile
but will complete the move faster.

Note that setting limits to zero disables the trajectory generator so that the command input is not limited by
the generator. Velocity is only limited by the Velocity Limit set in the Velocity Loop.
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Manually Tune the Position Loop

Minimize following error and oscillation by running profiles and adjusting position
proportional gain (Pp), velocity feed forward (Vff), acceleration feed forward (Aff) and
other settings. For instance:

*  Oscilloscope EI@

File

Trace Status: Reaay

NOTE: During tuning, observe warnings that appear to the left of the trace.

E Click the Scope Tool.

2 ator | Profie

Select the Profile tab.

3 Auto SBP - o the Settings tab, make sure Auto Setup is selected. Auto Setup
automatically sets the following parameters:
Profile Tab
Move Relative
Type Trap
Distance 2000 counts
Reverse and repeat | Not selected
Settings Tab
Channel 1 Profile velocity (green)
Channel 2 Following error (white)
4 Distance: 2000 | counts

If the Auto Setup default profile distance is not
appropriate, enter an appropriate short distance.

S Click Start. The Profile Generator executes a short move.
NOTES:
e The profile may not reach constant velocity during a short move.

¢ If afollowing error occurs, open the Control Panel and click Clear Faults.
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r T R | T
6 | Settings | Gains | Trajectory Limits | Position Params | Velodity Params | Measurement
Maximum Velocity: 1500 | rpm
Maximum Acceleration: 00| rps2
Maximurm Deceleration: 00| rps2

and
| Function Generator | Profie |
Mowe: Type:
@ Relative i@ Trap
Absolute (1 5 Curve
Distance: 2000 | counts

Set up a trapezoidal profile by setting the trajectory limits and distance. See table:

Trajectory Limits Tab
Maximum Velocity

Maximum
Acceleration Set values typical of those expected to be used in the application.

Maximum
Deceleration

Profile Tab

Distance Set the move distance to produce a complete trajectory profile. Be sure
that this distance does not exceed mechanical limits of the system.

Move Relative

Type Trap

7 Position

Pp: 5000|
Aff: 0
vif: | 16334

Adjust position proportional gain (Pp) to minimize following error:

¢ On the Gains tab, set velocity feed forward (Vff) and acceleration feed forward
(Aff) to zero.

¢ On the Profile tab, click Start. On the Gains tab, adjust position loop proportional
gain (Pp) until best result is obtained.

e Click Start after each adjustment to test on a new profile move.

NOTES:

1. Too much position loop proportional gain (Pp) might cause oscillation.

2. If afollowing error occurs, open the Control Panel and click Clear Faults.
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8

10
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Adjust velocity feed forward (Vff):

= Velocity feed forward (Vff) reduces following error in the constant velocity portion of
the profile. Often, a velocity feed forward (Vff) value of 16384 (100%) provides best
results.

= Click in the Vff field and adjust the value.

= Click Start after each adjustment to test on a new profile move.

Adjust acceleration feed forward (Aff):

= Acceleration feed forward (Aff) reduces following error during profile acceleration
and deceleration.

= Click in the Aff field and adjust the value.

= Click Start after each adjustment to test on a new profile move.

NOTES:

1) If, after tuning the position loop, the motor makes a low frequency audible noise while
enabled but not moving, the velocity loop gains (Vp and Vi) may be lowered to reduce
the noise. If the gain values are set too low, the response to instantaneous rates of
change might be reduced (i.e., slow correction to disturbances or transients).

2) If the amplifier is set up to run in position mode under analog input command, and the
analog command signal produces too much noise at the motor after tuning, the Analog
Command Filter or the Velocity Loop Command Filter may be used to reduce the noise
further.

Tune to multiple sets of profiles representing typical moves that might be executed in
the application. Starting with Step 6, repeat the process as needed.
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Test S-Curve Profile

If the amplifier will perform S-Curve profile moves, use this procedure to tune the level
of jerk. (Jerk is the rate of change of acceleration. S-Curve moves reduce jerk to
provide a smooth profile.) Run an S-Curve profile and adjust velocity, acceleration,
deceleration, and jerk levels until the desired profile is obtained. For instance:

¥ Oscilloscope = |

File

Trace Status: Ready

(qunos) 1ou3 Bumalia 4

020 025
Time fseconds

Type:
) Trap
©) & Curve
On the Profile tab, click the S-Curve button.
2 Set up an S Curve profile by adjusting the following parameters to represent a typical

move under normal operation.

Trajectory Limits Tab

Maximum Velocity Maximum speed of the profile.

Maximum Acceleration/ Maximum acceleration/deceleration of the profile. The deceleration is
Deceleration set to be the same as acceleration.

Maximum Jerk The value of jerk set during the calculate procedure produces an S-

Curve whose maximum slope is equal to the trajectory profile slope.
This value will produce a maximum acceleration that is not more than
the initial default value of acceleration. Small values will produce less
jerking but will take longer to complete move. Large values will
produce more jerking and a more trapezoidal profile but will complete
the move faster.

Profile Tab

Distance Increase the move distance to produce a complete trajectory profile.
Use an acceptable value the does not exceed mechanical limits of
the system.

Move Relative

Type S-Curve

Click Start.
4 Try multiple sets of profiles representing typical moves that might be executed in the

application. Starting with Step 2, repeat the process as needed.
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Notes on the Position Mode and Position Loop

Position Loop Diagram

The amplifier receives position commands from the digital or analog command inputs, over the
CAN interface or serial bus, or from the CVM Control Program. When using digital or analog
inputs, the amplifier's internal trajectory generator calculates a trapezoidal motion profile based on
trajectory limit parameters. When using the CAN bus, serial bus, or CVM Control Program, a
trapezoidal or S-curve profile can be programmed. The trajectory generator updates the calculated
profile in real time as position commands are received.

The output of the generator is an instantaneous position command (limited position). In addition,
values for the instantaneous profile velocity and acceleration are generated. These signals, along
with the actual position feedback, are processed by the position loop to generate a velocity
command.

To bypass the trajectory generator while in digital or analog position modes, set the maximum
acceleration to zero. The only limits in effect will now be the velocity loop velocity limit and the
current limits. (Note that leaving the maximum acceleration set to zero will prevent other position
modes from operating correctly.)

The following diagram summarizes the position loop.

Profile Velocit o lillon lLoe)s
Y > Velocity Feed Forward (Vif) .
Target Trajectory Profile Acceleration Gain )
- ) Vel
Position Generator =I Acceleration Feed Forw ard (Aff) Muldpler > C;: ocn):1 )
- - " ma
> _/_\_ Limited Position @—ﬂ Position Proportional Gain (Pp) =
Limits:
® Max velocity
@ Max accel Feedback O from motor encoder or resolver
o oo Od-------mmooooom - from optional position encoder (on load)

@ Abort decel

Trajectory Limits
In position mode, the trajectory generator applies these limits to generate the profile.

Limiter Description

Maximum Velocity Limits the maximum speed of the profile.

Maximum Acceleration Limits the maximum acceleration rate of the profile.

Maximum Deceleration Limits the maximum deceleration rate of the profile.

Abort Deceleration Specifies the deceleration rate used by the trajectory generator when motion is
aborted.

Position Loop Inputs From the Trajectory Generator
The position loop receives the following inputs from the trajectory generator.

Input Description

Profile Velocity The instantaneous velocity value of the profile. Used to calculate the velocity feed
forward value.

Profile Acceleration The instantaneous acceleration/deceleration value of the profile. Used to
calculate the acceleration feed forward value.
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Limited Position The instantaneous commanded position of the profile. Used with the actual
position feedback to generate a position error.

Position Loop Gains
The following gains are used by the position loop to calculate the velocity command:

Gain Description

Pp - The loop calculates the position error as the difference between the actual and

Position loop limited position values. This error in turn is multiplied by the proportional gain

proportional value. The primary effect of this gain is to reduce the following error.

VIf - The value of the profile velocity is multiplied by this value. The primary effect of

Velocity feed forward this gain is to decrease following error during constant velocity.

Aff - Acceleration feed The value of the profile acceleration is multiplied by this value. The primary effect

forward of this gain is to decrease following error during acceleration and deceleration.

Gain Multiplier The output of the position loop is multiplied by this value before being passed to
the velocity loop.

Position Loop Feedback
Some Harmonic Drive LLC amplifiers feature dual-sensor position loop feedback, configured as
follows:
¢ Single sensor. Position loop feedback comes from the encoder or resolver on the motor.
o Dual sensor. Position loop feedback comes from the encoder attached to the load.
(Note that in either case, velocity loop feedback comes from the motor encoder or resolver.

Position Loop Output
The output of the position loop is a velocity command used as the input to the velocity loop.

Position Wrap

The position wrap feature causes the position reported by the amplifier to “wrap” back to zero at a
user-defined value instead of continually increasing. Once set, the reported position will be
between 0 and n-1 where n is the user entered wrap value. This feature is most useful for rotary
loads that continually turn in one direction and only the position within a revolution is of interest to
the user.

Relative moves with the wrap value set will move the relative distance called for. Example; if the
wrap value is set to 1000 and a relative move of 2500 is commanded, the axis will turn 2 ¥
revolutions.

Absolute moves will move the shortest distance to arrive at the programmed position. This could
be in the positive or negative direction. Moves programmed to a point greater then the wrap value
will cause an error.

Following Error Faults

When the position error reaches the programmed fault threshold, the amplifier immediately faults.
(The following error fault can be disabled.)

Following Error Warnings

When the position error reaches the programmed warning threshold, the amplifier immediately
sets the following error warning bit in the status word. This bit can be read over the CAN network.
It can also be used to activate a digital output.
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Position and Velocity Tracking Windows

When the position error exceeds the programmed tracking window value, a status word bit is set.
The bit is not reset until the position error remains within the tracking window for the programmed
tracking time.

A similar method is used to handle velocity errors.

Following Error Fault Details

Position Error Reaches Fault Level

As described earlier, position error is the difference between the limited position output of the
trajectory generator and the actual position. When position error reaches the programmed
Following Error Fault level, the amplifier faults (unless the following error fault is disabled.) As with
a warning, a status bit is set. In addition, the fault is recorded in the error log. See Error Log.

Additional responses and considerations depend on whether the fault is non-latched or latched, as
described below.

Amplifier Response to Non-Latched Following Error Fault

When a non-latched following error fault occurs, the amplifier drops into velocity mode and applies
the Fast Stop Ramp deceleration rate to bring the motor to a halt. The amplifier PWM output stage
remains enabled, and the amplifier holds the velocity at zero, using the velocity loop.

Resuming Operations After a Non-Latched Following Error Fault

The clearing of a non-latched following error depends on the amplifier's mode of operation. Issuing
a new trajectory command over the CAN bus or the ASCII interface will clear the fault and return
the amplifier to normal operating condition.

If the amplifier is receiving position commands from the digital or differential inputs, then the
amplifier must be disabled and then re-enabled using the amplifier’s enable input or though
software commands. After re-enabling, the amplifier will operate normally.

Amplifier Response to a Latched Following Error Fault

When a latched following error fault occurs, the amplifier disables the output PWM stage without
first attempting to apply a deceleration rate.

Resuming Operations After a Latched Following Error Fault
A latched following error fault can be cleared using the steps used to clear other latched faults:
e Power-cycle the amplifier

¢ Cycle (disable and then enable) an enable input that is configured as
Enable with Clear Faults or Enable with Reset

e Access the HDM Control Panel and press Clear Faults or Reset
e Clear the fault over the CANopen network or serial bus
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11.8: Auto Tune all Loops for Linear Motors

This feature is only available for use with linear motors.

Make sure motor is mounted firmly and verify accuracy and completeness of
motor data.

Failure to heed this warning can cause equipment damage, injury, or death.
DANGER

At any point, use Back to return to the previous screen. Use Skip to tune the velocity loop
without tuning the current loop, or to tune the position loop without tuning the velocity loop.

1 Verify the motor is mounted firmly. Also verify the accuracy and completeness of the motor
settings.

Current Loop

2 Make sure the amplifier's Basic Setup and Motor Phasing procedures have been
performed, and that the system is capable of a 10 mm move.

Click Auto Tune to open the Current Loop Tune screen.
Auto Tune @

Current Loop Tune

-

® Ready
Gains
e Select initial move direction, then
25 press start to tune current loop.
G: 35

[¥] Inital Move Positive

| Start || Stop | l Skip || Cancel I

The status indicator is blue when the amplifier is ready for tuning.

4 Verify the Initial Move Positive setting. In most cases, this option should be set. If positive
initial motion is not possible, you can specify negative initial motion by clearing this option.
For instance, negative initial motion may be used when a vertical axis is at the bottom of
the motion range and the positive direction is down.
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5 Click Start to tune the current loop. During tuning, the status indicator is amber.
Cp and Ci values change as the text in the status box gives progress updates.
When the current loop has been tuned, the status indicator turns green, and the status box

contains instructions for the next step.

Aute Tune @

Current Loop Tune

-

G Done
Gains

Bandwidth 1200 Hz
2 kil Press next to tune velocity loop.
Ci: 86

[¥] Inital Move Positive

i Start |l Stop | l Mext | | Cancel

Velocity Loop:

1 Click Next to open the Jog screen.

[ Auto Tune @

Jog
Joqg Speed: 50 | mm/s Po3ition your motor in
the center of its range.
| Jog Neg ‘ I Jog Pos
......................... 2 Actual Current m A
[¥] Enable Jog
Current Loop Offset Current 0A
I Back ] [ Mext ] I Cancel I

6 Move the motor to the center of its motion range. To use a jog move:
= Set the Enable Jog option.
= Optionally adjust the jog speed
= Jog the motor in either direction to move it to the center of its motion range.
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7 When the motor is centered, click Next.

If the amplifier must apply current to hold the new position against a force (such as gravity
in a vertical application), the following message appears:

r

=

Auto Tune Current offset required @

A current loop offset requirement of 041 A

! " has been detected. If you are using a vertical
systemn the current loop offset should be
changed to compensate for gravity.
Make recommended change?

| 0K | I Cancel l

If this message appears, click OK.
The Velocity Loop Tune screen opens:

K

Auto Tune @ﬁ

Velocity Loop Tune
® Ready

Target Bandwidth Auto tune will attempt to make a
[I Higher 10mm mowve. If your sy3stem is not

capable of a 10mm move cancel now.

Gains

Vp: 386 Bdjust target bandwidth then

Vie 193 press start to tune velocity loop.
fStart || stop | | Back || skp || Cancel |

8 Optionally adjust the Target Bandwidth.

TIP: Increase bandwidth for more stiffness in the holding position. Decrease bandwidth to
eliminate buzzing or oscillations caused when the load is removed.
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Click Start to tune the velocity loop. During tuning, the status indicator is amber.
Vp and Vi values change as the text in the status box gives progress updates.

When the velocity loop has been tuned, the status indicator turns green, and the status box
contains instructions for the next step:

Auto Tune @
Velocity Loop Tune

O Daone
Target Bandwidth Bandwidth 70 Hz
” Higher Press next to tune position loop.
Gains
Vp: 386
Vi: 193

i Start |[ Stop ] I Back ][ Mext H Cancel

Position Loop:

10  cClick Next to open the Position Loop Tune screen:

Auto Tune @ﬂ

Position Loop Tune
Move Type

(™) 5 Curve

ki

® Ready
Gains
. o Auto tune will attempt to make a
b 10mm move. If your sy3tem i3 not
vif: 16334 capable of a 10mm move cancel now.
Aff: 0

| Start ][ Stop

Vff = 100% (optimal setting and following)

Wff

Best Settling I] Best Following

Select move type then press 3tart
to tune position loop.

| Back ][ Einish l[ Cancel
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11 Verify the Move Type setting (S-Curve or Trap).

12 For a trapezoidal profile, optionally optimize the tuning along the scale between Best
Settling (for quicker settling) and Best Following (for less following error).

13 Click Start to tune the position loop. During tuning, the status indicator is amber.
Pp, Vff, and Aff values change as the text in the status box gives progress updates.
When the position loop has been tuned, the status indicator turns green, and the status box
E:ontains instructions for the next step:

Auto Tune @
Position Loop Tune
Move Type
1 S Curve Vff = 100%: (optimal settling and following)
Wt
@ Trap Best Setting ” Best Fallowing
C Done
Gains
Press finish to save tuning
Pp: 5600 -
values and exit.
Vff: 4915
Aff: 1229
FStart | | Stop | [ Back | [ Enmish | [ Cancel

14 Click Finish. See the reminder:
Tuning values Changed @

-

f e h Mew gains must be saved to

I flach after verification

15 Click OK.

16 ﬂ On the HDM Main screen, click Save to Flash.
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Homing

12.1: Overview

HDM User Guide

The Homing screen allows homing to be configured and tested. Changes made to this screen get
saved to amplifier RAM. On amplifiers configured for Absolute encoders, calibration can be

performed.

I

Home
Software Limits

Pasifve:

Megative:

@) Positive

Fast Velodity:
Slow Velocity:

Accel/Decel:

0| counts

0| counts

Method: |Hardstop

Direction of Mation

) Negative

150 | rpm
30 | rpm

50 | rps?

[] Test without home adjustments

[ Home ] [ Stop ] Calibr

Deceleration Rate: 0| rps2

Offset:

Current Limit:
Current Delay Time:
Following Warning:
Actual Current:
Actual Position:

Homing Adjustment:

=3

1500 | counts
2,34 A
250 | ms

2000 counts
A

0 counts

counts

ate [ Save

) (st )

Harmonic Drive LLC

Click the Home button on the Main screen to open the Home screen
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Parameter

Description

Software limits: Positive

Software limits: Negative

Position of user-defined travel limits that take effect after homing
operation.

Software limits:
Deceleration Rate

Deceleration rate used to stop a motor when approaching a software
limit.

Software limits: Disable

Disables the use of software limits by setting both limits to zero.

Method

Homing method. See Homing Method Descriptions

Direction of Motion

Initial direction of motion for the homing method (Pos or Neg).

Fast Velocity

The velocity used to find a limit or home switch. Also used when
moving to an offset position, or a resolver or Servo Tube index position.

Slow Velocity

The velocity used to find a switch edge, incremental or analog encoder
index pulse, or hard stop.

Accel/Decel

The acceleration and deceleration rate used during homing.

Offset

Execute a move of this distance after the reference is found. Set actual
position to 0 and call the new position home.

Current Limit

Current Delay Time

Hard stop home is reached when the amplifier outputs the homing
Current Limit continuously for the time specified in the Delay Time.

Following Warning

Shows the programmed following warning level.

Actual Current

Shows actual current being applied to windings during homing.

Actual Position

Shows the actual position of the axis.

Homing Adjustment

Shows the Home offset measured after homing is performed.

Test without home
adjustments

Selecting this option and pressing the Home Button tests the adjusted
home position without making any changes to the saved home position.
The resulting homing offset is reported in the Homing Adjustment text
field.

Home

!

Starts the homing sequence using the settings shown on the screen.

Stop

Stops the homing sequence.

Calibrate

Starts the Calibration routine for absolute encoders. See Absolute
Encoder Calibration

i

Save

Saves the homing parameters to amplifier flash.

Exit

d

Discards unsaved homing parameters, then closes the screen. The
rules for discarding unsaved values are as follows:

e If the Save button was never clicked, all of the homing
parameters will be reverted to the values at the time that the
screen was opened..

¢ If the Save button was clicked, then the homing parameters will
be reverted back to the values at the time of the last Save
event.

Upon closing, any home sequence in progress will be aborted.

1

w

7
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Absolute Encoder Calibration

When absolute encoders are used, the absolute encoder value that corresponds to the zero
position in the machine’s reference frame is saved to flash memory in the drive. This value is then
added to the absolute encoder reading so that all position measurements are in absolute units in
the machine’s coordinate system. Movement of the motor to ‘find’ the machine’s reference point is
not necessary. This process is called calibration because it's done once when the machine and
drive are commissioned together and does not need to be repeated until the encoder is changed,
or adjustment of the machine-zero location is changed.

Note: This feature is only available on the Plus family of drives with a minimum firmware version
of 2.00.

Calibration of an absolute encoder is a two-part process:

1. Mechanical Homing
2. Calibration

Mechanical Homing

Mechanical homing is the process of moving the motor to the position that is machine-zero. This is
the location from which all dimensions are absolute in the machine’s position reference frame.

1 Enter the values of the appropriate homing parameters.
2 | Home | Click the Home button to run the home sequence.

3 Repeat if necessary until the motor is positioned at machine zero.
4 3¢ | Click the Save button.
Calibration

Calibrating the encoder involves saving the absolute position at machine-zero to the drive’s flash.
This value will be saved as a negative number and added to the absolute encoder positions

thereafter by the firmware to convert them to machine absolute values. This value is stored in the
Home Offset parameter. HDM provides a single button-click operation to perform this calibration.

Calibrate Click the Calibrate button to initiate the calibration routine.

HDM will perform the following sequence:
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e Set the calibration bit of the Homing Configuration register.
¢ Initiate the homing sequence.

The drive will then perform the following sequence:

. Run the home sequence.
. Save the Home Offset in flash.
. Change the home method to Absolute Encoder Immediate Home.

The Homing Adjustment field on the Home screen will show the offset value saved in flash. Once
the calibration is complete, the Calibrate button will be disabled until another home sequence is
run by clicking the Home button. To remove the calibration, change the Home Method from
Absolute Encoder Immediate Home to some other method, and run the home sequence.
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Control Panel

13.1: Control Panel Overview

ﬁ Click to open the Control Panel.

StatuT indicators

Monitor real-time amplifier values
and operatior?al mode

*  Control Panel

Status
Red if fault -

is active — @
Yellow if warning i

is active —1 > A8
Display error log —#» | Error Log

Maonitor
# Safety: Enabled et el = m b
i Motor Qutput: Active 3
i Hardware Enabled: Enabled Bus Voltage -
# Software Enabled: Enabled -
i Positive Limit: Mot Active Actual Motor Position - ‘ e
i Negative Limit: Mot Active .
@ Software Limits: Mot Active

e oK Mode: Position, Digital Input

# Motion Abort Input: Mot Active
2z CVM Control Program: Mot Running Maove
i> Home: Mot Referenced velocity Sl
Network Status:
Gain Scheduling: Acceleration 100 | rps2
Deceleration 100 | rps?
Message box — | 2 L
Control [ Enable Jog ove NE ove POS
[ Enable | [ Set Zero Position ]
Control functions — I - ] [ : : I I
Disable Clear Faults Reset -Close

Jog mode controls

13.2: Status Indicators and Messages

The Status area includes status indicator lights (described below) and a message box. Any red
lights indicate that motion will be inhibited.

Indicator

States/Description

Safety

State of the safety circuit. Enabled or HI/LO disabled. On amplifiers with safety circuit.

Motor Output

State of the PWM output stage. Red if the output stage is inactive (disabled)

Hardware Enabled

State of the hardware enable input(s). Red if one or more enable inputs are inactive.

Software Enabled

State of the software enable. Red if the amplifier is disabled by software.

Positive Limit

State of the positive limit switch input. Red indicates an activated positive limit switch.

Negative Limit

State of the negative limit switch input. Red indicates an activated negative limit switch.

Software Limits

State of the software limits. Red indicates an activated software limit.

Motor Phase

Indicates a motor phasing error. Red indicates a motor phasing error exists.

Motion Abort Input

State of the programmed Motion Abort Input. Red indicates the input is active.

CVM Control
Program

Status of the CVM Control Program.
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Home Indicates whether the axis has successfully been referenced (homed).

CAN Status Status of the CAN Bus. Yellow indicates CAN warning limit reached. Red indicates bus
error detected.

Gain Scheduling Indicates whether Gains Scheduling is active.

|8l

Indicates that a fault is active. Check the status message box for a description of the

most recent fault: Fadl: Under voltage .
Check the Error Log for a full history of faults and warnings.

Indicates that a warning is active. Check the status message box for a description of the
most recent: Warning: Pos Outside of Tracking Window

Check the Error Log for a full history of faults and warnings.

Message Box

Displays status descriptions.
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13.3: Control Panel Monitor

The Control Panel Monitor displays real-time values of selected variables.

Monitor

-
- I

Commanded Yelodity

Actual Motor Velodty

Actual Motor Position

Mode: Disabled

Monitor Variables

Actual Current

Following Error

Passive Load Position

Actual Motor Velocity

Commanded Current

Limited Position

Actual Motor Position

Commanded Velocity

Analog Command

Actual Load Velocity

Commanded Position

Bus Voltage

Actual Load Position

Profile Velocity

Amplifier Temperature

Profile Acceleration

Motor Phase Angle

Velocity Error

Mode: Displays the amplifier’s operating mode in RAM. In camming mode it also displays the
active cam table number
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13.4: Control Functions

The Control area of the screen provides functions related to overall amplifier control. The screen
options vary with model and configuration.

Control
[ Enable ] [ Set Zero Position ]
I Disable I I Clear Faults ] I Reset
Control Description
Enable Click to software enable the amplifier.
Disable Click to software disable the amplifier. This will also stop any CVM programs that
are running.
Set Zero Position Click to set the amplifier’s actual position counter to zero.
Clear Faults Click to clear all amplifier faults.
Reset Click to reset the amplifier.

Risk of unexpected or uncontrolled motion.

Using the HDM Set Zero Position function while the amplifier is
operating under external control could cause unexpected or
uncontrolled motion.

Failure to heed this warning can cause equipment damage.

WARNING
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13.5: Jog Mode

Jog mode provides a simple means for moving/jogging the motor.

Mowe
Velodity 100|| rpm
Acceleration 500 | rps?
Deceleration 500 | rps2
Enable Jog Mave NEG ‘ I Move POS
1 To put the amplifier in jog mode, select Enable Jog.
2 Set up a jog move by setting the following mode-specific parameters:
Mode Parameter | Description
Current | Current Current applied to the motor. Limited by current loop Continuous
Current.
Warning: Unloaded motors may, depending on torque setting,
ramp up in speed very quickly.
Velocity Jog Speed Velocity of the jog move. Limited by velocity loop Vel. Limit.
Position | Velocity Velocity of the jog move. Limited by velocity loop Vel. Limit.
Acceleration Acceleration limit of the jog move.
Deceleration Deceleration limit of the jog move.
3 Command the move:

Mode Steps

Current | Hold Pos to apply positive current to the motor or hold down Neg to apply negative
current to the motor.

Release the button to command zero current.

Velocity | Hold Jog Pos to command a forward velocity or hold down Jog Neg to command a
negative velocity.

Release the button to command zero velocity.

Position | Hold Move Pos to generate a forward move profile or hold Move Neg to generate a
negative move profile.

Release the button to stop movement.

NOTE: Position mode jog is accomplished by continuously updating the
commanded position. If a following error develops with Following Error Fault
disabled, motion will not stop on button release. Instead, it stops when actual
position = commanded position.
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14.1: Overview

Oscilloscope

The Oscilloscope can be used to tune the amplifier, monitor performance, and perform
diagnostics. Function Generator and Profile Generator can drive the motor without external control.

Auto Set Up feature sets typical initial values for scope parameters.

*# Oscilloscope
File

o] -E -]

Function Generator | Profile

["] Reverse and Repeat

Start

Mowve: Type:

(@) Relative @ Trap

() Absolute () S Curve
Distance: 4000 | counts

Trace Status: Ready

Settings | Gains I Trajectory Limits I Fosition Params I Velocity Params I Meas‘urernent|

o 1) S
ollowing Error [ AutoSetup
Single Trace
Ch3
[ Auto Scale Lock
potual Current | _
Sample Rate: 125 ps
pisabled |
#‘I' [ Record ] [ Stop Trace ] [ Clear ] [ Close ]
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14.2: Menu, Display and Controls

File Menu

The File menu contains the options to save/restore scope settings. This feature is useful for saving
custom settings used for tests that are run frequently.

File Menu

Save Settings

Saves current scope settings to a file

Restore Settings

Restores settings from a file

Display

To access the Trace Display menu, Right-click in the trace display area.

Trace Status: Ready

Line Style » @ line

Preferences plus

connected plus

Menu Parameter Description
Line Style line A line connects the plotted data points.
plus The Scope plots data points as plus signs, with no connecting
line.
connected plus | Data points are plotted as plus signs and are connected with a
line.

Preferences | anti-aliasing When anti-aliasing is selected, the Scope removes screen-
related jaggedness in the displayed trace. Use of this feature
may slow down the refreshing of traces on slow computers.

grid When selected a grid is displayed on the scope screen.

Harmonic Drive LLC
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Trace Display Zoom

1 Hold the left mouse button down while dragging a box around the area of interest.

Trace Status: Ready

2 Release the button to let the display zoom in on the selected area.

Trace Status: Ready

3 To restore the normal zoom level immediately, left-click anywhere on the trace.
(Normal zoom level is also restored when the next trigger event occurs.)

Controls
4‘; [ Record ] [ Stop Trace ] [ Clear ] [ Close ]
Action Description

Save a trace. See Scope Trace Files

Eﬂ

Begins recording a trace

Stop Trace Stops recording a trace

Clear Clears the trace from the screen and trace data from buffer

1

o
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[] AutoSetup

Single Trace
[7] Auto Scale Lock

Trace Time: -1.255 v-

Sample Rate: 500 ps

HDM User Guide

started as soon as the current trace is displayed.

Function Description

Auto Setup When selected, the scope will be set up based on the setting for either the Function or Profile
Generator (whichever is active).

Single Trace When selected only one trace will be collected and displayed, otherwise a new trace will be

Auto Scale Lock

When displaying the trace data, the scope will automatically scale the vertical axis for optimal
viewing. When Auto Scale Lock is selected, the y-axis scale will be locked at its current

Trace Time

This is the total amount of time the trace is recorded.

Sample Rate

The rate at which each sample is collected. When tracing multiple channels, all channels are
collected at approximately the same time.

Harmonic Drive LLC
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14.3: Function Generator

Oscilloscope

The Function generators can provide inputs to the different control loops for tuning and diagnostics

purposes without using an external control source.

Function Generator rﬁﬂe
Apply To: .?u'elm:ity =
Function: |Square Wave -
Amplitude: 200 | mm/s
Frequency: Hz

Start Stop

The Start button starts the function or profile generator. The Stop button stops the generator and
aborts any profiles in progress.

Parameter | Description
Apply To Control loop to which the Excitation will be applied: Current (available in all modes), Velocity
(available in velocity or position mode), or Position (available in position mode only).
Function Function that will be applied to the control loop selected in the Apply To list box. The choices vary
with the control loop selected:
Selected Control Loop Functions Available
Current Sine Wave, Square Wave, Step Forward, Step Forward and
Reverse, and Impulse
Velocity Sine Wave, Square Wave, Step Forward, Step Forward and
Position Sine Wave, Square Wave
Amplitude Amplitude of the command. Units vary depending on the value chosen in the
Apply To field.
Frequency (Sine Wave and Square Wave only.) Frequency of input command cycle.
Period (Step Forward, Step Forward and Reverse, and Impulse only.) Duration of each input pulse.
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14.4: Profile Generator

| Function Generator| Profile

Mave: Type:
d { i) Trap
i@ 5 Curve
Distance: 2000 counts

[ Reverse and Repeat

Start Stop

Parameter Description
Move Relative: Moves axis a specified distance from the starting position.
Absolute: Moves axis to a specific position.
Type Trap or S-Curve.
Distance Distance for Relative move.
Position Target position for Absolute move.
Reverse and Repeat (Relative move only.) When selected, will continuously generate forward and reverse moves

of the distance specified until Stop is pressed.
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14.5: Trace Channel Variables

Settings | (Gains | Trajectory Limits I Position Params | Velod

)
o

Click the Channel button to open the Trace Variable selection screen

Oscilloscope

Channel 1 Trace Variables @
Categoary Trace Variahle
Disabled Profile Velodty
Current Commanded Velocity
Limited Velocity
Position Actual Motor Velocity
Acceleration Velocity Error
Voltage Actual Load Velodity
Miscellaneous Lnfiltered Motor Velodity
Digital Inputs Velocity Loop P Gain
Digital Cutputs Velocity Loop I Gain
Event Status Faults
Event Status Warnings
Ewvent Status Misc.
Raw Encoder Signals
[ QK ] [ Cancel
Category Trace Variable
Disabled <Channel disabled, no associated variable>
Current Commanded Current, Actual Current, Limited Current, I°T Amplifier Accumulator,
I*T Motor Accumulator.
Velocity Profile Velocity, Commanded Velocity, Limited Velocity, Actual Motor Velocity, Actual Load
Velocity, Unfiltered Motor Velocity, Velocity Error
Position Commanded Position, Limited Position, Actual Load Position, Actual Motor Position, Following
Error, Passive Load Position
Acceleration Profile Acceleration
Voltage Analog Command, Bus Voltage, Analog sin Input, Analog cos Input, Terminal Voltage Stepper,

Terminal Voltage Servo
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Miscellaneous

Motor Phase Angle, Amplifier Temperature, Hall States

Digital Inputs

Digital input line states

Digital Outputs

Digital output line states

Event Status
Faults

Short Circuit, Amp Over Temperature, Over Voltage, Under Voltage, Motor Over Temperature,
Feedback Error, Motor Phasing Error, Following Error, Command Input Fault, Amplifier Fault (a
latched fault is active).

Event Status
Warnings

Current Limited, Voltage Limited, Positive Limit Switch, Negative Limit Switch, Following Warning,
Velocity Limited, Acceleration Limited, Positive Software Limit, Negative Software Limit, Pos
Outside of Tracking Window, Vel Outside of Tracking Window.

Event Status
Misc.

Amp Disabled by Hardware, Amp Disabled by Software, Attempting to Stop Motor, Motor Brake
Active, PWM Outputs Disabled, Position Has Wrapped, Home Switch Active, In Motion, Phase Not
Initialized.

Raw Encoder
Signals

Primary Encoder A, Primary Encoder B, Primary Encoder X, Primary Encoder S, Secondary
Encoder A, Secondary Encoder B, Secondary Encoder X, Secondary Encoder S

Harmonic Drive LLC
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14.6: Trigger Setup

Oscilloscope

Click the Trigger Setup button to open the Trigger Settings screen.

Trigger Settings @
Trigger Type: :Above Level v:
Trigger On: :Channel 1 v:
Position: :Lef't -
Level: 00| rpm
Event Status Bit: Sele
[ 0K ] [ Cancel
Setting Description
Trigger Type Type Condition
Immediate Trigger Trigger as soon as a trace is started (when the Record button is
pressed).
Rising Edge Trigger when the selected channel's input changes from below to
above the trigger level.
Falling Edge Trigger when the selected channel's input changes from above to
below the trigger level
Above Level Trigger as soon as the selected channel's input is greater than or
equal to the trigger level.
Below Level Trigger as soon as the selected channel's input is less than or equal
to the trigger level.
Function Generator Trigger on the start of the next function generator cycle.
Input Level High/Lo Trigger when specified input is high or low
Output Active/lnactive | Trigger when specified output is active/inactive
Event Status Rising Trigger on the rising or falling edge of an event status bit.
Edge/Falling Edge
Raw Encoder Signal Triggers when the raw encoder signal is Hi/Lo
Level H/Lo
Trigger On Selects which channel will be used as the trigger source.
Position Selects placement of the trigger event on the screen. (Value is not configurable for Immediate
or Function Generator trigger types.).
o Left for optimal viewing of events following the trigger.
« Middle for optimal viewing of events preceding and following the trigger.
¢ Right for optimal viewing of events preceding the trigger.
Level Sets the trigger level, in units appropriate to the channel selected.
Event Status Bit With an event status trigger type selected, choose the status bit that will trigger the trace. For
descriptions of the event status word.
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14.7: Measurement Tab

The Measurement tab allows you to measure and analyze data from up to three parameters during
an interval defined by adjustable cursors. The Cursor Data area displays a parameter’s values at
the left and right cursor locations, and the difference between the two values. The Analysis area
displays the minimum, maximum, average, and root mean square of the parameters during the
cursor period.

Cursors

* Osdilloscape (=3

| v Trace Status: Ready v

Function Generator | Profile | settings | Gains | Trajectory Limits | Position Params | Velocity Params | Measurement
Cursor raw data P CursorData Analysis < Cursor data analysis

— - Left Right Delta Min Max Avg rms  Units

AeplyTo: | fositen | o# oses oams :

Function: | Square Wave - | I | N T EEE oo

Amplitude: | 8132 counts len2 «| ZE counts

e 2 e o o ol osof ol oo as icp

= Show Cursors

[R.ecovd][SbopTrace][Clear][Close]
| | l

When Show Cursors is not set, the Cursor Data fields are inactive and the Analysis fields show
calculations based on data from the entire trace cycle.

1 Show Cursors
Cursors.

To display cursors and activate the Cursor Data fields, set Show

2 To move a cursor, click on the cursor and hold the left button while dragging the cursor
to the desired location. Release the left button to place the cursor in the new location.

3 To select a parameter to measure and analyze within the cursors, choose a channel in
one of the three channel lists on the Measurement tab:
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14.8: Control Loop Parameters

The Oscilloscope provides convenient access to all of the control loop parameters that might be
used in tuning and diagnosing an amplifier. The user can adjust these parameters and see the
results immediately on the scope. Control loop parameters are accessed through a set of tabs,
shown below.

| Settings | Gains |Trajvau::|:-::nr3-I Limits | Position Params I Velocity Params | Measurementl

Position Velodty Current
Pp: w000 Vp: 403 Cp: w8 °
AfF: o| * Wi 43 ° i 223 *
ViR | 16334

Note that the parameters represented on these tabs can also be accessed through the screens
used to configure the control loops and the digital position input. Changing a value in the Scope
tool automatically updates the value on the other screens where it appears, and vice versa.

Control loop parameter tab descriptions follow.

Gains Tab
Modes Gains Description For More Information
Pp Position loop proportional gain.
Position mode only Aff Acceleration feed forward. Position Loop Gains
Vif Velocity feed forward.
Position or velocity Vp Velocity loop proportional gain. . .
- - - - Velocity Loop Gains
mode only Vi Velocity loop integral gain.
Cp Current loop proportional gain. )
- - - Current Loop Gains
All modes Ci Current loop integral gain.
ECp Encoder Correction Gain (Stepper only) Encoder Correction
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Trajectory Limits Tab

Available in position mode.

Settings | Gains | Trajectory Limits | Position F‘aramsl Velocity Paramsl Measurement

Maximum Velocity: 750
Maximum Acceleration: 250 |
Maximum Deceleration: 250
Maximum Jerk: . 10000

rpm

rps?

rps?

rps?

For more information see Position Loop Setup and Tuning

Position Loop Parameters

Available in position mode.

| Settings | Gains ITrajECtOﬂ-' Limits | Position Params | Velodty Params | Measurement

120000 counts

Set Zero Position

[ Disable Following Error Fault

Position Tracki
G b Actual Position:
Window: 4096 | counts
Time: 10 ms

Fallowing Errar; 16384 | counts

HDM User Guide

Set Zero Position sets the amplifier’s actual position count to zero. For more information, see

Position Loop Setup and Tuning
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Velocity Loop Parameters

Available in position and velocity modes.

| Settings | Gains I Trajectory Limits | Position Paramsl Velodty Params | Measurement

Oscilloscope

Velocity Tracking
Window: 146 | rpm Accel Limit: 500 rps?
Time: 100 | me Decel Limit: 500 | rps?

For information see Velocity Loop Setup and Tuning
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Scope Trace Files

The Oscilloscope can save trace data to disk that can be opened later with the Trace Viewer.
When the save trace data to disk operation is performed, HDM saves the data in three different
files:
e .sco: This is a HDM format which contains scope settings and trace data.
e .csv: This is a standard comma-separated value file format that can be imported into
spreadsheet software like Microsoft Excel.
e _txt: This is a tab-separated value file similar to the .csv file. This is intended to be imported

by software that can only read tab-separated values.

The format of the .csv and the .txt files are identical except for the separator:
e Column 1: time
e Column 2: Trace Channel 1 data
e Column 3: Trace Channel 2 data (if used)
e Column n: Trace Channel n data (if used)

The trace data is in amplifier units, not user units (see Parameter Dictionary for units).
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14.10: Trace Viewer

The Trace Viewer screen displays the contents of .sco files. All of the trace display features
(zooming, line style, etc.) as well as the measurement functions are available in this screen.

1 On the Main screen, choose Tools—>View Scope Files to open the window.

2 Click Open File. When prompted, select the name of the file you wish to open.
Then, click Open to display the file in the Trace Viewer window.

=

Settings | Measurement
Function Generator Scope Trigger

ch 1: B Type:  Function Generator
oy Bl sl Current

Apply To:  Current

Excitation: Square Wave ch 3 I Apply To: MN/A

N - ch 4 S
Ch 5: Vo] '

Period: 100 Hz che: I Level:  NJA

Trace Time: 25 ms
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15.1: Setting Parameters

To change or view filter configurations follow these steps:

Filters

]
TEFETTE | Choose the Configure Filters button from the main screen to open the

Filter Configuration screen.

2 To view present filter settings choose the Filter Settings tab. Choose other tabs to

configure Analog, V Loop, | Loop or Input Shaping settings.

#  Filter Configuration

| | Filter Settings | Analog I WV Loop I I Loop I Input Shaping|

15.2: Filter Configuration Windows

Along with the location of a cut-off frequency on the filter curve, there are several filter
configuration parameters available depending on the initial choice of: Standard Filter

Types and Standard Filter Families.

Filter configuration choices may include:
¢ Number of Poles (the location of a cut-off frequency on the filter curve)
e Cut Off Frequency

o Frequency 2 (If two poles are chosen)

e Pass Band Ripple
e Stop Band Ripple

15.3: Filter Settings

The Filter Settings tab opens a window that shows what filters have been selected.

#  Filter Configuration

=B B

Filter Settings | Analog I W Loop I I Loop I Input Shapingl

Analog Reference
W Loop Input

W Loop Qutput 1
W Loop Output 2
W Loop QOutput 3
ILoop Input 1
ILoop Input 2

Input Shaping

Type

Disabled

Disabled

Low Pass

Disabled

Disabled

Disabled

Disabled

Disabled

Family

Butterworth

Poles

Freguency

200

0.1
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15.4: Input Shaping

Input shaping is a method by which unwanted command induced vibrations are kept to a minimum
by damping them with superimposed impulses. This produces a command that will drive the
system with limited residual vibration.

In order to set the input shaping parameters, first measure the mechanical frequency; see
Measuring Mechanical Vibration.

Below is a diagram of the input shaping process.

Step Command Input Output Command
A Shaping A
N |
Time X - T ,  Time
0 0 T

25 — ,
F’JJI
- 20—
2
5
= 15 —
48]
3]
£
E smememe ZND
5 S
oL |
0.6 1.4

Frequency (F/Fm)
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Analog

Filters

The Analog tab opens a window that shows analog filter choices and a representative
curve. Modify the settings as needed and press Apply.

» Filter Configuration L"‘E'JL = é
| Filter Settings | Analog || v Loop I ILoop I Input 5hap<ng|
Analog Reference Input B Analog Reference Selected Loop Input
Filter
Type: Disabled -
Family: Butterworth
Default
1 pole (@ 2 Pole

Velocity Loop

The V Loop tab opens a window that shows Velocity Loop filter choices and a
representative curve. Modify the settings as needed and press Apply. Selecting Default

will supply a 200 Hz Low Pass filter to the first velocity loop output filter.
(o) e S

#  Filter Configuration

| Filter Settings I Analog ‘ W Loop | ILoop | Input Shaping|

P
Mﬁm&m. Input M Velocty ’_‘
Limiter Filter Controller

o A
Qutput Qutput Cutput Current
Filter 1 Filter 2 Fitter 3

() Input Filter

Type: Low Pass -
(@ OutputFilter 1 b - = m
_ : Family: | Butterworth -
() Output Filter 2 L Default
) Cutput Filter 3 B}Lpole iR
Cut Off Frequency (Fc) 200 | Hz dB
- -3dB
Freguency 2 (F2) 1| Hz ~40dB
decade
Pass Band Ripple (Rp) 0.1/ db
Stop Band Ripple (Rs) i|db T
Fc
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Current Loop

The | Loop tab opens a window that shows Current Loop filter choices and a
representative curve. Modify the settings as needed and press Apply.
»  Filter Configuration L&Ju_lg‘: =

| Filter Settings | Analog | v Loop [{1L00p | 1nput shaping|

manded

Comi
Current Command Input Input Current Curment Vol
= Filter 1 Filter 2 Limiter Controller

B Type: Disabled ] Apply
R [ =) | poely |
Family: Butterworth

Default

() Input 2

@ 1pole 2 Pole

Close
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15.5: Standard Filter Types

Low Pass Filter
Frequencies below the selectable cut-off are allowed to pass.

Example:
dB
$ -3dB

-40dB
decadea

Fc

High Pass Filter
Frequencies above the selectable cut-off are allowed to pass.

Example:
di
3dB

40de
decade

Fe
Notch Filter

Notch filters allow a bandstop in a range between two selectable frequencies. It may be
Butterworth (no ripple), Chebyshev (selectable passband ripple), or elliptical (ripple on both
passband and bandstop).

Example:
di Jr

&

_f_

Rp

Fi F2

Band Pass Filter

Band pass filters allow a range of frequencies, between two selectable cut-offs, to pass. It may be
Butterworth, Chebyshev, or Elliptical.

di 1'

Rp

F1 F2
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Custom Biquad Filter
The Bi-Quadratic filter has two quadratic terms: one in the numerator, and one in the denominator.
The numerator affects the filter’'s two zeros and the denominator affects the filter’s two poles. Many
filter classes and types can be expressed in the Bi-Quad form by entering the coefficients. The
coefficients can be calculated using any commercially available math software package and
entered as floating point numbers. However, due to the fixed-point representation, the numbers
may be rounded.
Example:

by thZ bz

H =
4]

-1 -z
1+az+az
1 z
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15.6: Standard Filter Families

Butterworth Filter
A Butterworth filter has two poles for faster roll-off at the cut-off frequency.

Example:

dB

+ -3dB
-40d8
decads

Fc

Chebychev Filter

A Chebyshev filter has a faster roll-off than a Butterworth filter, but, as a result of the fast roll-off,
ripple is introduced into the passband frequency.

Example:
dB 1
—T—
Rp
Fe
Elliptic Filter

Similar to a Chebyshev filter but ripple is introduced into both the passband and the stopband. It
has a faster roll-off than a Chebyshev filter.

Example:
dB 1
T
Rp
Rs
4
y T
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Input Shaping Window
The Input Shaping tab opens a window that shows Input Shaping choices and a representative
Time and Amplitude table. Modify the settings as needed and press Apply.
Type as well as Frequency and Damping Rate may be adjusted. Overcurrent is adjustable when a

Negative Zero Vibration or a Negative Zero Vibration and Derivative filter is chosen. If Custom is
chosen as the Type, Time and Amplitude may be set manually.

* Filter Configuration C=I|ESREERl x|
| Filter Settings I Analog | V Loop | 1 Loop |; Input Shaping’|
——— | Trajectory Generator ———m SL'E‘"Q —®| Posifonloop ———————
: . Time Amplitude
Type: Disabled

¥p | a0 0 a

Freguency: 0.1|Hz z c
Damping Ratio: i}

34 0 0

Ower Currenting Ratio: 1 0 0

0 v]

0 [v]

0 v]

Input Shaping Types

Type

Description

Zero Vibration

Single step inputs are replaced with two step inputs of smaller magnitude. One of
which is delayed by one-half the period of vibration. Sensitive to some modeling
errors.

Zero Vibration and Derivative

A zero derivative (of the vibration) constraint is added to Zero Vibration impulse
shaping, thereby reducing modeling errors.

Negative Zero Vibration

Faster than positive input shaping (Zero Vibration, and Zero Vibration and
Derivative), but may magnify high frequency vibrations.

Negative Zero Vibration and
Derivative

A zero derivative (of the vibration) constraint is added to Negative Zero Vibration
impulse shaping.

Custom

Time and Amplitude can be set manually.

Harmonic Drive LLC

170



HDM User Guide Filters

15.8: Measuring Mechanical Vibration

There are several ways to measure mechanical vibration. Two choices are offered below.

Using an Accelerometer with HDM
Begin with a Harmonic Drive LLC drive operational and controlled by HDM.

1

o b~ W0 DN

Connect the accelerometer analog output to Harmonic Drive LLC drive’s Analog + and -
on the signal input as in the diagram below.

Accelerometer Copley Drive
{Analog Devices ADXL105)

Vdd oV

Com GND
Al AIN +

Com AlN -

¥
K

On HDM, click the Scope Tool [=

Select the Measurement tab, choose a channel, select Voltage, then Analog Command.
Perform a move.

After the move is complete, measure Tm (1/Fm), which is the period of mechanical
oscillation.

Using HDM to Monitor Following Error

Monitor the following error using HDM’s scope option.
Begin with a Harmonic Drive LLC drive operational and controlled by HDM.

1

2
3
4

171

On HDM, click the Scope Tool .

Select the Measurement tab, choose a channel, select Position, then Following Error.
Perform a move.

After the move is complete, measure Tm (1/Fm), which is the period of mechanical
oscillation.
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16.1: Amplifier RAM and Flash Memory

Amplifier RAM

e Volatile. Contents erased when amplifier is reset or powered off.

¢ Initial contents read from flash on power-up. Contents then updated in real time to reflect
certain operational conditions and changes entered with HDM software. At any time, the
user can use HDM to restore data from flash into amplifier RAM.

Flash

¢ Non-volatile. Contents retained when the amplifier is reset or powered off.

¢ Modified only by using a Save to Flash tool or by closing certain screens (Motor/Feedback,
Basic Setup, Homing, or CAN Configuration), whose contents are automatically saved to
flash upon closing of the screen.

Parameters reside in RAM only, Flash only, or both RAM and Flash. The table below illustrates the
typical parameter locations. Refer to the Parameter Dictionary for information about specific

parameters.

Data Resides In Data

Flash only This category includes all Motor/Feedback screen data and Basic Setup screen
(motor/feedback data only), This data is saved to flash when the user confirms the
values and closes the screens without cancelling.

Amplifier RAM only Includes operating status data such as actual position, actual current, and amplifier
temperature. Such data is never stored in flash. It is destroyed from amplifier RAM with
each power-down or amplifier reset.

Flash and amplifier RAM Includes all other data not represented in the two categories above. When changing
these parameters in HDM, the value is saved to amplifier RAM only. To save these
values to flash, the Save To Flash operation must be performed or data will be lost on
power down or reset.
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16.2: Data Management Tools
Amplifier

Operations performed using the amplifier data management tools at the top of the Main screen
(shown below) affect amplifier settings, including motor/feedback data. (CVM Control Program
data is not saved by these operations).

¥ CME 2 Vo1 (XEL-230-36 unnamed)
File Amplifier Tools Help .. ..

Eﬁ ﬁ [Z"i |'ﬂ ﬁ lm ﬁ §<—Data Management Tools

Action Name Description
'ﬁ Save amplifier data Saves both amplifier and motor/feedback data to a disk with a .ccx filename
to disk extension.
Restores amplifier and motor/feedback data from a .ccx file to the amplifier’'s
Restore amplifier RAM, or flash for the flash only variables. See Parameter Dictionary for
ﬁ data from disk parameter descriptions.
A To Flash operation should be performed to insure that all data is saved to flash
Iﬁ Save amplifier data Saves contents of amplifier RAM to amplifier flash memory.
to flash
ﬁ Restore amplifier Restores contents of amplifier flash memory to amplifier RAM.
data from flash

Motor/Feedback Screen

Operations performed using the Motor/Feedback screen data management tools only apply to the
motor/feedback parameters.

Motor/Feedback =
data management tools @ @ ‘ﬂ m Cloble)|  |wike| |wONEl)

Action | Name Description

Saves only motor/feedback data to disk with a .ccm filename extension. Amplifier

Iﬂ Save motor data to data that is not represented on the Motor/Feedback screen is not saved in this

disk fle.
ﬁ Restore motor data Restores only motor data from a disk file with a .ccm filename extension
from disk amplifier flash (the motor/feedback parameters are flash only).
Saves the contents of the Motor/Feedback screen from to amplifier flash
E:H Save motor data to memory. Amplifier data that is not represented on the Motor/Feedback screen is
flash not saved. Can be used to assure that all changes are saved to flash without

closing the Motor/Feedback screen.

Restores only motor data from amplifier flash memory to the PC. Amplifier data
ﬂ Restore motor data that is not represented on the Motor/Feedback screen is not affected. Can be

from flash used before closing the Motor/Data screen to restore settings to the previously
saved values.
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Drive Configuration

The Plus Family of drives (Feature set E), have the capability of saving/restoring the entire drive
configuration to a file. The drive configuration consists of all parameters (RAM/Flash and Flash
Only) and the entire contents of the CVM flash, which includes any CVM programs, cam tables,
and gain scheduling tables. The file is saved with a .ccd file extension.

This feature is useful to clone drives in one step rather than separately loading each file (.ccx, .ccp,

.cct, .ccqg). Additionally, the file is in XML format which can be read by some EtherCAT masters.

Save Drive Configuration

From the menu on the Main screen, select File=>Save Drive Configuration, then choose a
filename. A progress bar will be displayed while the data is being saved to the file.

*  Drive Configuration E =] @

Saving Drive Configuration to file...

Restore Drive Configuration

From the menu on the Main screen, select File=>Restore Drive Configuration, then choose a
filename. A progress bar will be displayed while the data is being saved to the file

* Drive Configuration EI =] @
Restoring Drive Configuration to Flash...

All of the data read from the file is saved to the drive’s Flash. After all of the data is written, the
drive will be reset, so that the Flash data is copied to RAM.
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16.4: Copy Drive Data

In product families prior to the Plus Family, the Drive Configuration feature is not available. In order
to clone one drive to the next, multiple steps are required.

OR

Load the .ccx file:
ﬁ From the Main screen, click Restore> Amplifier Data.

M Starting from the Basic Setup screen, click Load ccx File.

When prompted browse to the folder containing the .ccx file and open it.

E:ﬁ On the Main screen, click Save to Flash to save the new settings to flash memory.

Load a CVM program .ccp file:
From the menu on the Main screen, choose File>Restore>CVM Control Program.
When prompted, navigate to the folder containing the appropriate .ccp file and open it.

This procedure also results in setting the Enable Control Program on Startup option, which
configures the program to auto start when the amplifier is powered up or reset.

Load Cam Table .cct files:
From the menu on the Main screen, choose File2>Restore>Cam Tables.
When prompted, navigate to the folder containing the appropriate .cct file and open it.

Load Gains Scheduling Table .ccg files:
From the menu on the Main screen, choose File>Restore->Gains Scheduling Tables.
When prompted, navigate to the folder containing the appropriate .ccg file and open it.

TIP:  When copying amplifier data to multiple amplifiers in a production environment, consider
locking HDM to prevent accidental changes to settings. See Lock/Unlock HDM .
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16.5: Save MACRO File for Delta Tau Controllers

This feature is available only on Harmonic Drive LLC MACRO drives such as the XML Xenus
MACRO

1 On the HDM Main screen, choose File>Save MACRO File to open the MACRO File
Save window:

MACRO File Save =)
MACRO node: 0|
I OK l | Cancel |

2 Enter the ID of the MACRO node with the settings you want to save and click OK.

3 When prompted, enter a File Name. If needed, navigate from the default AmpData
folder to another folder where you wish to store the file.

4 Click Save to save the .pmc file in the same folder and close the screen.
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16.6: Lock/Unlock HDM

The Lock feature of HDM is used to lock out most screens to prevent data from being changed.

WHEN HDM IS LOCKED:
e User cannot change any amplifier or motor settings.
e User can download amplifier and motor files and Cam Tables, jog the motor, run scope
functions and profiles, and monitor amplifier performance with the scope and control panel.

1 On the Main screen choose Tools>HDM Lock/Unlock.
2  Set anew password in the Password and Verify Password fields.

[ HOM Lock =)

Enter password to lock HDM

Password:

Verify Password:

[ OK H Cancel
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3 Click OK to lock out amplifier setting controls.

% HDM V7.0 Beta 14 (REL-230-26 unnamed) oo ] o S

File Amplifier Tools Help
I
7 e o < il
=~ JJ HD Neighborhood
- BB Virtual Amplifier
----- B comt |
HDVM Control Program |
Frogrammed Current ¥ | Loop [—# MotoriFeedback
Configure Regen Configure Faults
@ Axis A
Axis B Configure Filters
HDM Locked
Axis C
Rotary Motor Amp Software Disabled F 12 To Disable

4 To unlock, choose Tools=>HDM Lock/Unlock.

'HDM Unlock B

Enter password to unlodk HDM

Password:

Unlock for this session only

[ Ok, H Cancel

Enter the password. Click OK
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16.7: Firmware Download

The amplifier’s flash memory holds the amplifier’s firmware. As needed, perform the following
steps to obtain new firmware and download it to amplifier flash memory.

NOTES:
o HDM does not support downloading firmware to a node amplifier via a multi-drop gateway
amplifier; a direct connection (serial, CAN, EtherCAT) must be used.

e To check the firmware version currently loaded, click the Amplifier Properties button or
choose Help>About.

WARNING: Do not power down or disconnect the amplifier during firmware
download.

1 On the Main screen choose Tools->Download Firmware to open the Download
Firmware window. Browse to where the firmware file is located and click Open to start
the download. The progress will be displayed while downloading.

#  Firmware Download El [=] @
Writing new FPGA and firmware image.

When the progress dialog closes, the firmware download is complete.
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16.8: Error Log

Click the Error Log tool on the Main screen

& )

# Error Log E =] @
Active | Histary I Frequency
Type Description
Fault Motor Phasing Error
-FI' Clear Log Refres
Tab Contents
Active Type and description of each active fault and warning. The contents of this tab are

automatically refreshed as new events occur.

History Type, description, and time of occurrence of each fault and most warnings since the log was
last cleared. The contents of this tab are not refreshed automatically as new events occur. The
contents are refreshed only when the tab is displayed or when Refresh is clicked.

Frequency Type, description, and frequency of each fault and warning that has occurred since the log
was last cleared. The contents are refreshed only when the tab is displayed or when Refresh
is clicked.

Network Status | (Under CAN control only.) Status of CANopen network. Lists warnings and errors.

Saves the contents of the History and Frequency tabs to a text file.

Clear Log Clears all History and Frequency entries in the drive.

e

Refresh Updates the contents of the History or Frequency tabs.
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16.9: Communications Log

The communications log displays all communications between HDM and the amplifier.

is only stored in the PC’s RAM by HDM; it is not part of the amplifier's data.

On the Main screen, choose Tools=>Communications Log

=N B =)

[

m

[z}
»

Lmp Desired State in RAM 00 73 01 Oc 00 24
Amp Desired State in RAM 00 45 01 00 00 le
Motor Encoder Status 00 78 01 Oc 01 Z2e
Motor Encoder Status 00 58 02 00 00 00 00 00
Camming Configuration 00 53 01 Oc 01 05
Camming Configuration 00 4a 01 00 11 Q0

Lmp Desired State in BAM 00 73 01 Oc 00 24
Amp Desired State in RAM 00 45 01 00 00 le
Motor Encoder Status 00 78 01 Oc 01 Ze
Motor Encoder Status 00 58 02 00 00 00 00 00
Camming Configuration 00 53 01 Oc 01 Q5
Camming Configuration 00 4a 01 00 11 Q0

Lmp Desired State in BAM 00 73 01 Oc 00 24
Amp Desired State in RAM 00 45 01 00 00 le
Motor Encoder Status 00 78 01 Oc 01 Ze
Motor Encoder Status 00 58 02 00 00 00 00 00
Camming Configuration 00 33 01 Oc 01 Q5
Camming Configuration 00 4a 01 00 11 Q0

Lmp Desired State in BAM 00 73 01 Oc 00 24 -

PO O OO 00600
m m m m m m m M M M M M M
ot ot ot ot ot ot ot ot ot ot ot o ot ot

| T

m m
ot ot

Oy 03 63 6) 01 03 Gy 03
m
ot

m
ot

H Communications Log
09:35:26.897 COM3 Send:
09:35:26.910 COM3 Recv:
09:35:26.926 COM3 Send:
09:35:26.936 COM3 Recv:
09:35:26.942 COM3 Send:
09:35:26.952 COM3 BRecv:
09:35:27.151 COM3 Send:
09:35:27.192 COM3 Recv:
09:35:27.214 COM3 Send:
09:35:27.224 COM3 Recv:
09:35:27.230 COM3 Send:
09:35:27.240 COM3 BRecw:
09:35:27.499 COM3 Send:
09:35:27.512 COM3 Recv:
09:35:27.534 COM3 Send:
09:35:27.544 COM3 Recwv:
09:35:27.550 COM3 Send:
09:35:27.560 COM3 BRecwv:
09:35:27.798 COM3 Send:
[#] Enable Logging
[] Enable Event Status Logging

Option

Description

Enable Logging

When selected, logging is enabled and all communications, with the exception
of status messages, are recorded in the log

Enable Event Status

When selected, status messages are included in the log. Note that Show “ Get

Logging Variable” Cmnds must also be checked to log Event Status commands.
Show “Get Variable” When selected, “Get Variable” commands are added to the log.
Cmds

Saves the contents of the Communications Log to a text file.

Clears the log contents from the PC’s RAM
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17.1: Overview

Virtual amplifiers can be used for creating amplifier and motor data files off line. A new virtual
amplifier can be created based on a virtual amplifier template file (.ccv) or from an existing .ccx file.
HDM includes a set of .ccv files for each model that is supported.

P

* CME2 V6.0 (AEP-090-18
File Amplifier Tools Help

87 e B3 [V E

=) |, Copley Meighborhood

1
Select the Virtual Amplifier node from the Harmonic Drive LLC Neighborhood. This
will display the Open Virtual Amplifier screen:
Open Virtual Amplifier @
Choose the method you want to use to create the
virtual amplifier.
@) Create new amplifier file
Open existing amplifier file
[ oK | [ Cancel | | Help |
2 Create new amplifier file

e Select Create new amplifier and click OK.

e When prompted, select the .ccv that represents the appropriate drive model.
¢ Click Open. The Basic Setup screen will be displayed.

¢ Motor and amplifier values may now be viewed, entered, and adjusted.

Open existing amplifier file

Select Open existing amplifier file and click OK.

When prompted, select the appropriate .ccx file.

Click Open.

Motor and amplifier values may now be viewed, entered, and adjusted.
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18.1: Overview

The Gain Scheduling feature allows you to schedule gain adjustments based on changes to a key
parameter. For instance, Pp, Vp, Vi, and Current Offset (A) could be adjusted based on changes to
commanded velocity.

Gain adjustments are specified in a Gain Scheduling Table. Each table row contains a key
parameter value and the corresponding gain settings. The amplifier uses linear interpolation to
make smooth gain adjustments between the programmed settings.

Gain scheduling involves the basic steps outlined below. Details follow in the chapter.

Storage Limits

The maximum number of lines that can be stored in the Gain Scheduling Table is 1000. A typical
Gain Schedule Table will contain far fewer lines. The number of Gain Scheduling Table lines is
also limited by the amount of CVM memory space available in the amplifier. A Gain Scheduling
Table shares that space with CVM programs and Camming Tables. Therefore, the maximum
number of Gain Schedule Table lines will decrease if CVM programs or Camming Tables are
stored in the amplifier.

The Gain Scheduling screen Tables tab displays the percentage of amplifier memory used:

[5}

CVYM memory usage: 1%
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Gains Scheduling

18.2: Configure Gain Scheduling

1 From the menu on Main screen, choose Amplifier=>Gain Scheduling.

¥ Gain Scheduling
File Edit

[o]l & ]

Select Gains

["] Position Loop Pp

[ velodity Loop Vp

[ velocity Loop Vi

[7] Current Loop Offset

Key Parameter: | Disable Gain Scheduling -

[7] Use Absolute Value of Key Parameter
|| Disable Gain Scheduling Until Axis is Referenced

1= [ [ [—

2 Choose the Key Parameter:

Key Parameter

Description

Disable Gain Scheduling.

Disable gain scheduling.

Use Written Parameter.

An external controller can write to this parameter using any of several
protocols and corresponding parameter IDs: Harmonic Drive LLC ASCII
Interface or the Harmonic Drive LLC Indexer 2 Program (ID 0x128),
CANopen and EtherCAT(Index 0x2371), and MACRO I-variable (0x528).
See the Harmonic Drive LLC ASCII Interface Programmer’s Guide, the
Harmonic Drive LLC Indexer 2 Program User Guide, or the Harmonic Drive
LLC CANopen Programmer’s Guide.

Use Commanded Velocity.

Schedule gain adjustments based on changes to commanded velocity.

Use Actual Velocity.

Schedule gain adjustments based on changes to actual velocity.

Use Commanded Position.

Schedule gain adjustments based on changes to commanded position.

Use Actual Position.

Schedule gain adjustments based on changes to actual position.

3 Optionally set controls:

Control Description
Use Absolute Value of Key If a velocity or position value is chosen for the Key Parameter and this option
Parameter is set, the Key Parameter is interpreted as an absolute value.

Disable Gain Scheduling
Until Axis is Referenced

When this option is set, the scheduled gain adjustments do not take place
until the axis is referenced (homed).

4 Select the gains that you wish to adjust by schedule. The choices are Pp, Vp, Vi and
Current Offset (A). For each gain you select, a column will be enabled in the Gain

Scheduling Table.

5 Continue with Set Up Gain Scheduling Tables
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18.3: Set Up Gain Scheduling Tables

On the Gain Scheduling screen, open the Table tab:

* Gain Scheduling o] @ [
File Edit
Key Value P Loop Pp V Loop Vp ¥V Loop Vi Current Offset (A)
a 10 20 20 0.5
1 500000 20 20 20 1.0

CVM memory usage: 1%

=FEIE]

Description
Creates a new table

Deletes the table from amplifier flash and PC RAM

Saves configuration and table to disk

Restores configuration and table to PC only

Saves configuration and table to amplifier flash

A EEE

Restores configuration and table from amplifier flash to PC. This operation
overwrites all data on the Gains Scheduling screen.
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1 On the Gain Scheduling screen, open the Table tab:

* Gain Scheduling o] @ [
File Edit
Config | Table
Key Value F Loop Pp V Loop Vp V Loop Vi Current Offset (A)

CVM memory usage: 1%
3

CIEEIE]

2 Click the Create New Table button and enter the number of lines for the table.
*  Mew Table =)
Enter Mumber of Lines: 2
[ (9] ] [ Cancel ]

3 Enter the Key Parameter and gain adjustment values.
NOTE:
¢ All values must be whole numbers (no fractional values).

e All Key Values must be increasing.

4 After all values have been entered, click the Save Table button. This action saves
both configuration and table data.

189 Harmonic Drive LLC



Regen Resistor Configuration HDM User Guide

CHAPTER

19: REGEN RESISTOR
CONFIGURATION

Harmonic Drive LLC 190



Incorrect values may damage amplifier or external regen
resistor.

For the regen I°T algorithms to work correctly, the values

WARNING entered in the following steps must be correct. Damage to the
external regen resistor may result from incorrect values entered.
Damage to the amplifier may result if an incorrect resistance
value is entered.

Failure to heed this warning can cause equipment damage.

Configure a Standard Harmonic Drive LLC Regen Resistor

Configure Regen . . .
1 oo Click Configure Regen to open the Regen Resistor screen
Regen Resistor @
©) hone
T XTL-RA-03
() XTL-RA-D4

) Custom Resistor | Configure

2 Select the model number XTL-RA-03 or XTL-RA-04 and click OK to save the
configuration and close the screen.

s )

Regen Resistor @

71 XTLRA-04

) Customn Resistor | Configure

View Settings I | OK H Cancel
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Configure a Custom Regen Resistor

1 Confi
gure Regen . . .
Click Configure Regen to open the Regen Resistor screen.
Regen Resistor
® fiar
() XTL-RA-03
) XTL-RA-04
(7 Custom Resistor Configure
View Settings [ QK ] I Cancel |

2 Select Custom Resistor and click Configure to enter the custom resistor data. Read the

information displayed and click OK

P

'0' Regen resistors are subject to potentially high power dissipation depending on
“&F  the resistor value and the amount of energy being regenerated from the motor and
load. To ensure safety and reliable cperation, it is important to select a regen

resistor that is appropriate for your application.

Custom Regen Resistor

-

3 Follow the instructions on step 1 through 5 of the Custom Regen Wizard, then click

Finish.
Custom Regen Resistor Configuration @
_ Step 5
Resistance: 30| &2
T T R s 25 | w Custom regen resistor configuration is
TR complete.

Peak Pawer: W prass Finish to accept the values entered and
save them to the amplifier's RAM and flash.

Time at Peak Power: 50 | ms
To change any of the values press Prev

-,
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View Regen Settings

193

1

| View Settings

Regen Settings

Resistance:
Continuous Power:
Peak Power:

Time at Peak Power;

30 22

65 W

5000 W

1000 ms

Regen Resistor Configuration

Click Configure Regen Settings to open the Regen Settings screen.

=
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Overview

The I°T current limit algorithm continuously monitors the energy being delivered to the motor using
the 1T Accumulator Variable. The value stored in the I1°T Accumulator Variable is compared with
the I°T setpoint that is calculated from the user-entered Peak Current Limit, 1T Time Limit, and
Continuous Current Limit. Whenever the energy delivered to the motor exceeds the I°T setpoint,
the algorithm protects the motor by limiting the output current or generates a fault.

Formulas and Algorithm Operation

Calculating the I°T Setpoint Value

The I°T setpoint value has units of Amperes®-seconds (A”S) and is calculated from programmed
motor data. The setpoint is calculated from the Peak Current Limit, the 1T Time Limit, and the
Continuous Current Limit as follows:

I°T setpoint =
(Peak Current Limit? — Continuous Current Limit®) * I°T Time Limit

Algorithm Operation

During amplifier operation, the 1°T algorithm periodically updates the I*T Accumulator Variable at a
rate related to the output current Sampling Frequency. The value of the IT Accumulator Variable
is incrementally increased for output currents greater than the Continuous Current Limit and is
incrementally decreased for output currents less than the Continuous Current Limit. The I°T
Accumulator Variable is not allowed to have a value less than zero and is initialized to zero upon
reset or +24 Vdc logic supply power-cycle.

Accumulator Increment Formula

At each update, a new value for the I°T Accumulator Variable is calculated as follows:
I°T Accumulator Variable ., =
1T Accumulator Variable ,
+(Actual Output Current .,> — Continuous Current Limit?) * Update period

After each sample, the updated value of the I°T Accumulator Variable is compared with the I*T
setpoint. If the I°T Accumulator Variable value is greater than the I°T Setpoint value, then the
amplifier limits the output current to the Continuous Current Limit. When current limiting is active,
the output current will be equal to the Continuous Current Limit if the commanded current is
greater than the Continuous Current Limit. If instead the commanded current is less than or equal
to the Continuous Current Limit, the output current will be equal to the commanded current.
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Application Example

Operation of the I°T current limit algorithm is best understood through an example. For this
example, a motor with the following characteristics is used:

e Peak Current Limit—12 A
e I°T Time Limit—1S
e Continuous Current Limit — 6 A

From this information, the I°T setpoint is:
setpoint = (12 A>-6 A%) *1 S = 108 A’S

Plot Diagrams

The plots that follow show the response of an amplifier (configured w/ I°T setpoint = 108 A?S) to a
given current command. For this example, DC output currents are shown in order to simplify the
waveforms. The algorithm essentially calculates the RMS value of the output current, and thus
operates the same way regardless of the output current frequency and wave shape.

I’T current limit
16 ‘ :
17 |_commanded
12 SRR EARERREEE i I_actual
< 10
5 8]
4
2 4
0
0 1 2 3 4 5 6 !
Time (S)
Diagram A

At time 0, plot diagram A shows that the actual output current follows the commanded current.
Note that the current is higher than the continuous current limit setting of 6 A. Under this condition,
the 1T Accumulator Variable begins increasing from its initial value of zero. Initially, the output
current linearly increases from 6 A up to 12 A over the course of 1.2 seconds. During this same
period, the I°T Accumulator Variable increases in a non-linear fashion because of its dependence
on the square of the current.

At about 1.6 seconds, the IT Accumulator Variable reaches a values equal to the I°T setpoint. At
this time, the amplifier limits the output current to the continuous current limit even though the
commanded current remains at 12 A. The I°T Accumulator Variable value remains constant during
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the next 2 seconds since the difference between the actual output current and the continuous
current limit is zero.

At approximately 3.5 seconds, the commanded current falls below the continuous current limit and
once again the output current follows the commanded current. Because the actual current is less
than the continuous current, the 1°T Accumulator Variable value begins to fall incrementally.

The I1°T Accumulator Variable value continues to fall until at approximately 5.0 seconds when the
commanded current goes above the continuous current limit again. The actual output current
follows the current command until the I1°T Accumulator Variable value reaches the I°T setpoint and
current limiting is invoked.

I’T Accumulator
120
@ 200 {7 AN
< 80 1 N /
------- etpoint
S 60 pol
% 40 1 h2T Accumulator
20
0
0 1 2 3 4 5 6 7
Time (S)
Diagram B

I°T Scope Trace Variables
Two Scope Tool trace variables are available for monitoring whether the I°T accumulator is
accumulating or discharging.
e The I°T Amplifier Accumulator variable evaluates the accumulator against the factory set
current limits of the amplifier.
e The I°T Motor Accumulator variable evaluates the accumulator against the user-
programmed current loop values.
The value shown Diagram B has been normalized so that 100% equals the I°T setpoint.
When either trace variable line reaches 100%, current limiting will be invoked.
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APPENDIX B

HOMING METHODS
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Overview
There are several homing methods. Each method establishes the:
o Home reference (limit or home switch transition or encoder index pulse)

o Direction of motion and, where appropriate, the relationship of the index pulse to limit or
home switches.

Homing Diagram Legend

As highlighted in the example below, each homing method diagram shows the starting position on
a mechanical stage. The arrow line indicates direction of motion, and the circled H indicates the
home position. Solid line stems on the index pulse line indicate index pulse locations. Longer
dashed lines overlay these stems as a visual aid. Finally, the relevant limit switch is represented,
showing the active and inactive zones and transition.

Mechanical Stage Limits

< Axis
[ ]
Starting position 9! T
/®<—>e Direction of motion

Home position —_—
@4—‘ <— Starting position
Index pulse location T
Index Pulse | | |

Positive Limit
Switch AT
Switch inactive T Switch active

Switch transition

Note that in the homing method descriptions, negative motion is leftward and positive motion is
rightward.
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Homing Method Descriptions

Set current position as home
The current position is the home position.

Next Index

Direction of Motion: Positive

Home is the first index pulse found in the positive direction. Direction of motion is positive. If a
positive limit switch is activated before the index pulse, an error is generated.

Index Pulse

HDM User Guide
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—®

i

Direction of Motion: Negative

Home is the first index pulse found in negative direction. Direction of motion is negative. If a
negative limit switch is activated before the index pulse, an error is generated.

Index Pulse

Harmonic Drive LLC
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Limit Switch

Direction of Motion: Positive
Home is the transition of the positive limit switch. Initial direction of motion is positive if the positive

limit switch is inactive.
Positive Limit i_
Switch

Direction of Motion: Negative
Home is the transition of negative limit switch. Initial direction of motion is negative if the negative

limit switch is inactive.
H ]

Negative Limit i
Switch |
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Limit Switch Out to Index

Direction of Motion: Positive

Home is the first index pulse to the negative side of the positive limit switch transition. Initial
direction of motion is positive if the positive limit switch is inactive (shown here as low).

B ]

Positive Limit I—:
Switch :

Index Pulse |

Direction of Motion: Negative

Home is the first index pulse to the positive side of the negative limit switch transition. Initial
direction of motion is negative if the negative limit switch is inactive (shown here as low).

e ]

Negative Limit .i @
— :

Switch

Index Pulse |
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Hardstop

Direction of Motion: Positive

Home is the positive hard stop. Direction of motion is positive. In servo modes, the hard stop is
reached when the amplifier outputs the homing Current Limit continuously for the amount of time
specified in the Delay Time. If a positive limit switch is activated before the hard stop, an error is

generated.
I ]

| -®

Direction of Motion: Negative

Home is the negative hard stop. Direction of motion is negative. The hard stop is reached when
the amplifier outputs the homing Current Limit continuously for the amount of time specified in the
Delay Time. If a negative limit switch is activated before the hard stop, an error is generated.

In I

(e |

Hardstop Methods in Stepper Mode

In Stepnet amplifiers operating in stepper mode with an encoder, the hard stop is reached when
the following error is exceeded. When using hardstop methods in stepper mode, do not disable
following error.
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Hardstop Out to Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the positive hard stop. Initial direction of
motion is positive. The hard stop is reached when the amplifier outputs the homing Current Limit
continuously for the amount of time specified in the Delay Time. If a positive limit switch is
activated before the hard stop, an error is generated.

! —

| @|><_)

Index Pulse

Direction of Motion: Negative

Home is the first index pulse on the positive side of the negative hard stop. Initial direction of
motion is negative. The hard stop is reached when the amplifier outputs the homing Current Limit
continuously for the amount of time specified in the Delay Time. If a negative limit switch is
activated before the hard stop, an error is generated.

— ﬂ
II I

Hardstop Out to Index Methods in Stepper Mode

In Stepnet amplifiers operating in stepper mode with an encoder, the hard stop is reached when
the following error is exceeded. When using hardstop methods in stepper mode, do not disable
following error.

Index Pulse
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Home Switch

Direction of Motion: Positive

Home is the home switch transition. Initial direction of motion is positive if the home switch is
inactive. If a limit switch is activated before the home switch transition, an error is generated.

| i |

Home Switch

Direction of Motion: Negative

Home is the home switch transition. Initial direction of motion is negative if the home switch is
inactive. If a limit switch is activated before the home switch transition, an error is generated.

D ﬂ
e

Home Switch |
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Home Switch Out to Index

Direction of Motion: Positive

Home is the first index pulse to the negative side of the home switch transition. Initial direction of
motion is positive if the home switch is inactive. If a limit switch is activated before the home switch
transition, an error is generated.

1 |

Home Switch |

Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse to the positive side of the home switch transition.
Initial direction of motion is negative if the home switch is inactive. If a limit switch is activated
before the home switch transition, an error is generated.

u ———]

Home Switch |

Index Pulse
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Home Switch In to Index

Direction of Motion: Positive

Home is the first index pulse to the positive side of the home switch transition. Initial direction of
motion is positive if the home switch is inactive. If a limit switch is activated before the home switch
transition, an error is generated.

B — 00—

Home Switch |

Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse to the negative side of the home switch transition. Initial direction of
motion is negative if the home switch is inactive. If a limit switch is activated before the home
switch transition, an error is generated.

— ]

Home Switch : l

Index Pulse

207 Harmonic Drive LLC



Homing Methods HDM User Guide

Lower Home

Direction of Motion: Positive

Home is the negative edge of a momentary home switch. Initial direction of motion is positive if the
home switch is inactive. Motion will reverse if a positive limit switch is activated before the home
switch; then, if a negative limit switch is activated before the home switch, an error is generated.

i =

95 p
@<—| E
—

Home Switch
Positive Limit ;
Switch // // |

Direction of Motion: Negative

Home is the negative edge of a momentary home switch. Initial direction of motion is negative. If
the initial motion leads away from the home switch, the axis reverses on encountering the negative
limit switch; then, if a positive limit switch is activated before the home switch, an error is

generated.
B 5 =/ D
C 5

Home Switch l 71

Negative Limit i
Switch _| // //
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Upper Home

Direction of Motion: Positive

Home is the positive edge of a momentary home switch. Initial direction of motion is positive. If the
initial motion leads away from the home switch, the axis reverses on encountering the positive limit
switch; then, if a negative limit switch is activated before the home switch, an error is generated.

] / A =
-® |
— Lo —

T

Positive Limit ;
Switch / / |

Home Switch

Direction of Motion: Negative

Home is the positive edge of momentary home switch. Initial direction of motion is negative if the
home switch is inactive. If the initial motion leads away from the home switch, the axis reverses on
encountering the negative limit switch; then, if a positive limit switch is activated before the home

switch, an error is generated.
I AL 1
[ 7/ |
: A

C Cs
5

Negative Limit '
Switch _| // //
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Lower Home Outside Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the negative edge of a momentary home
switch. Initial direction of motion is positive if the home switch is inactive. If the initial motion leads
away from the home switch, the axis reverses on encountering the positive limit switch; then, if a
negative limit switch is activated before the home switch, an error is generated.

= 3

Home Switch E 7

Positive Limit : / '
Switch ! ]/
Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse on the negative side of the negative edge of a momentary home
switch. Initial direction of motion is negative. If the initial motion leads away from the home switch,
the axis reverses on encountering the negative limit switch; then, if a negative limit switch is
activated before the home switch, an error is generated.

Iy I==V 1
S

'
'
'
'
'
'
'
'
'
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<
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ome Switc ! ! :
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Negative Limit

Index Pulse |
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Lower Home Inside Index

Direction of Motion: Positive

Home is the first index pulse on the positive side of the negative edge of a momentary home
switch. Initial direction of motion is positive if the home switch is inactive. If the initial motion leads
away from the home switch, the axis reverses on encountering the positive limit switch; then, if a
negative limit switch is activated before the home switch, an error is generated.

[ = / i ﬂ

Home Switch 5 / /L|

Positive L.imit Loy
Index Pulse |

Direction of Motion: Negative

Home is the first index pulse on the positive side of the negative edge of a momentary home
switch. Initial direction of motion is negative. If the initial motion leads away from the home switch,
the axis reverses on encountering the negative limit switch; then, if a negative limit switch is
activated before the home switch, an error is generated.

Ly 7 =

Home Switch ; 5 / /L|

Negative Limit .
Switch o : 7/

Index Pulse |
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Upper Home Outside Index

Direction of Motion: Positive

Home is the first index pulse on the positive side of the positive edge of a momentary home switch.
Initial direction of motion is positive. If the initial motion leads away from the home switch, the axis
reverses on encountering the positive limit switch; then, if a negative limit switch is activated before
the home switch, an error is generated.

[ i
| C % D

Home Switch 71 t

Positive L_imit / 5 |
Switch ]/ !
Index Pulse

Direction of Motion: Negative

Home is the first index pulse on the positive side of the positive edge of a momentary home switch.
Initial direction of motion is negative if the home switch is inactive. If the initial position is right of
the home position, the axis reverses on encountering the home switch.

I Cowmiamnl
. C g

Home Switch 71

Negative Limit :
Switch

/]
I/

Index Pulse | I
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Upper Home Inside Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the positive edge of momentary home switch.
Initial direction of motion is positive. If initial motion leads away from the home switch, the axis
reverses on encountering the positive limit switch; then, if a negative limit switch is activated before
the home switch, an error is generated.

&
)
Home Switch |7/ /__| I

Positive Limit / 5 |

Switch ] /[
Index Pulse |

Direction of Motion: Negative

Home is the first index pulse on the negative side of the positive edge of a momentary home
switch. Initial direction of motion is negative if the home switch is inactive. If initial motion leads
away from the home switch, the axis reverses on encountering the negative limit; then, if a
negative limit switch is activated before the home switch, an error is generated.

[ g /A D
G ®—)

oy
Home Switch W/H

Negative Limit

Switch _l //E

[/
Index Pulse | |
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Harmonic Drive LLC ASCII Interface

An amplifier's RS-232 serial bus can be used by an external control application (HMI,
PLC, PC, etc.) for setup and direct serial control of the amplifier. The control application
can issue amplifier commands from the set of ASCII format commands that make up the
Harmonic Drive LLC ASCII Interface.

For more information, see the Harmonic Drive LLC ASCII Interface Programmer’s Guide.

HDM ASCII Command Line Interface Tool

215

As described below, the HDM ASCII Command Line Interface tool provides a simple way
to enter Harmonic Drive LLC ASCIlI commands.

Use the ASCIl Command Line Interface to Enter Commands

1 From the Main screen, choose Tools=>ASCIl Command Line to open the tool.

* ASCI Command Line Y= et

Command:

Response:

4 I

Close

2 Enter an ASCII Command in the Command field.

3 Press the Enter key to send the command to the amplifier. Observe the Response field.

If a value is returned, it is preceded by the letter “v.” In the following example, the get
command was used to retrieve the amplifier RAM value of variable 0x32 (actual
position).

*  ASCH Command Line E' E@

Command: |g rox32

Response: |V 71

3

Close

An error code would be preceded by the letter “e.”
TIP: To view an error definition, hold the mouse pointer over the error number.

For more information, see the Harmonic Drive LLC ASCII Interface Programmer’s Guide
and the Harmonic Drive LLC Amplifier Parameter Dictionary.
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Single-Axis Serial Connection

For RS-232 serial bus control of a single axis, set the CAN node address of that axis to
zero (0). Note that if the CAN node address is switched to zero after power-up, the
amplifier must be reset or power cycled to make the new address setting take effect.

Serial Copley Am plifier
PC, PLC,or HMI | COM port . SER-CK "Serial Cable Kit" pley Amp CAN
9pin D-sub with ASCII
for ASCII Control for RS-232 ADDR
RS-232 0
ADDRESS MUST BE SET
TO ZERO BEFORE

POWER-UP OR RESET.

Multi-Drop Serial Connection

A serially connected amplifier can be used as a multi-drop gateway for access to other
amplifiers linked in a series of CAN bus connections. Set the CAN node address of the
serially connected amplifier (gateway) to zero (0). Assign each additional amplifier in the
chain a uniqgue CAN node address value between 1 and 127. For more information on

CAN node address assignment, see Network Configuration. Use 120 Ohms termination on
the first and last amplifier.

TERMINATION MUST BE 120 Ohm
USED ON FIRST AND LAST Terminator
NODE

Serial : - i
PC, PLC, or HMI . SER-CK "Serial Cable Kit" Copley Amplifier CAN
’ ’ COM port 9pin D-sub . . @ CAN Port
for ASCII Control | ("o P with ASCIIRS-232  ADDR .

CAN Network Cable UTP CAT.5E Gigabit Ethernet

CAN CAN Port CAN CAN Port CAN CAN Port
ADDR ADDR ADDR
1 1

ADDRESSES MUST BE 120 Ohm
SET BEFORE POWER-UP Terminator
OR RESET.
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Recommended Device

Harmonic Drive LLC recommends using the 232USB9M USB to Serial Adapter made by B&B
Electronics (http://www.bb-elec.com/). Harmonic Drive LLC has tested this low cost device
extensively with HDM software.

Factory Settings

The factory settings for this device works well, but Harmonic Drive LLC recommends changing the
Latency time for faster performance with HDM software. This value is changed through the
Windows Device Manager

1 Open the Device Manager dialog from the Windows Control Panel and expand the Ports
(COM &LPT) node:

&b Batteries
£ Bluetooth Radics
& CAN Hardware (Kvaser)
‘B Computer
L¥ ControlVault Device
= Dizk drives
K. Display adapters
b DVD/CD-ROM drives
ﬂﬁ Human Interface Devices
g IDE ATASATAPI contrallers
=5 Imaging devices
= Keyboards
,l-ii, Mice and other pointing devices
K Monitors
&¥ Metwork adapters
¥ Pors (COM & LPT)
'Y Communications Port (COML)
Y5 ECP Printer Port (LPT1)
'3 RS-232 Port (COMZ)
O Processans
= Smart card readers
& Sound, video and game controllers
€5 Storage controllers
I System devices

[

2 Select the COM port that is used by the USB to Serial Adapter (refer to manufacturer’s
documentation for details).

3 Right-click that port and select Properties from the pop-up menu. This will open the device
properties.


http://www.bb-elec.com/
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RS-232 Port (COM2) Properties

General | Port Settings | Driver | Details |

RS-232 Port {COM2)
=

Device type: Ports (COM & LPT)
Manufacturer: B&B Electronics

Location: on Maodel 232U5B3M

Device status

[This device is working propery.

J ’ Cancel

4 Select the Port Settings tab, then click the Advanced button.

R5-232 Port (COM2) Properties

Bits per second: [BBDD

Data bits: [8

Parity: [None

Stop bits: [ 1

Flow contral: [None

[ Advanced... ] [Bestore Defaults ]

[ o

J [ Cancel

B&B USB to Serial Adapter
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Advanced Settings for COM2

COM Port Mumber: comz2

USB Transfer Sizes

Receive (Bytes):

Transmit (Bytes):

EM Options

Latency Timer {msec):

Timeouts
Minimum Read Timeout (msec):

Minimum Write Timeout (msec):

Select lower settings to correct performance problems at low baud rates.

Select higher settings for faster performance.

Select lower settings to correct response problems.

[ =

Ok

Cancel

Defaults

Miscellaneous Options
Serial Enumerator

Serial Printer

Cancel If Power Off

Event On Surprise Removal
Set RTS On Close

Disable Modem Ctrl At Startup

OOoOO0OO0OOE

HDM User Guide

5 The factory default setting for Latency Timer is 16 ms as shown above. Change the
Latency Timer to 1 ms, No other settings should be changed. Click OK to set the new
value and close the dialog.

6 Click OK to close the device properties dialog.

Harmonic Drive LLC

220



HDM User Guide

Revision B
April 2014

© 2014
Harmonic Drive LLC

247 Lynnfield St.
Peabody, MA 01960 USA
All rights reserved




	About This Manual
	Related Documentation
	Links to publications, along with hardware manuals and data sheets, can be found under the downloads heading at: http://www.harmonicdrive.net/
	Harmonic Drive LLC software and related information can be found at:
	Comments
	Harmonic Drive LLC welcomes your comments on this manual. See http://www.harmonicdrive.net for contact information.
	Copyrights
	Document Validity
	Revision History

	1: Introduction
	1.1: Host Computer Requirements
	Computer and Operating System
	Default File Locations
	Serial Communications
	Ethernet Communications
	CAN Communications
	EtherCAT Communications

	1.2: Overview
	Setup and Tuning
	Indexing
	Cam Tables

	1.3: Servo Operating Modes and Control Loops
	Control Loops Model
	Basic Attributes of All Servo Control Loops


	2: Installation, Startup, and Interface Tour
	2.1: Download and Install HDM Software
	2.2: Special Notes for Windows 7 and Windows 8
	Installer
	Set up HDM to run as administrator

	2.3: Start HDM
	2.4: Communications Wizard
	Configure Serial Ports
	Configure Ethernet Network
	Configure CANopen Network
	Configure EtherCAT Network

	2.5: Connect to an Amplifier
	2.6: Rename an Amplifier
	2.7: HDM Interface Tour
	Tool Bar
	Menu Bar
	Functional Diagram
	CAN Information and Status Bar
	CAN Information
	Status Bar



	3: Amplifier Setup
	3.1: Setup Procedure
	Warnings and Notes


	4: Basic Setup
	4.1:  Overview
	4.2: Change Basic Setup Settings
	4.3: ServoTube Setup

	Stepper Drives Only
	Manually tune the Current Loop
	Manually Tune the Velocity Loop

	5: Motor/Feedback
	5.1: Motor/Feedback Screen Overview
	5.2:  Load Motor/Feedback/Brake Settings from a File
	5.3:  Rotary Motor Parameters
	5.4:  Linear Motor Parameters
	5.5:  Feedback Parameters, Rotary
	5.6: Feedback Parameters, Linear
	5.7:  Feedback Notes
	Encoder and Resolver Support
	Dual Feedback

	5.8: Brake/Stop Parameters
	5.9: Calculate

	6: Digital Inputs and Outputs
	6.1:  Digital Inputs
	Digital Input Functions

	6.2: Digital Outputs
	Digital Output Functions

	6.3:  Custom Event Triggered Output
	Latched vs. Non-Latched Custom Event

	6.4: Custom Trajectory Status Triggered Output
	6.5: Custom Position Triggered Output
	6.6: Synchronizing PWM Switching Frequency
	6.7: Analog I/O
	Analog Motor Temperature Sensor
	Analog Output


	7: Command Inputs
	7.1:  Analog Command Settings
	Analog Command Notes
	Scaling
	Dead Band
	Offset
	Monitoring the Analog Command Voltage
	Analog Command in Position Mode


	7.2:  PWM Input Settings
	50% Duty Cycle (One-Wire)
	100% Duty Cycle (Two-Wire)
	Failsafe Protection from 0 or 100% Duty Cycle Commands

	7.3:  Digital Position Input Settings
	Pulse Smoothing
	Pulse and Direction
	Count Up/Count Down
	Quadrature

	7.4: Software Programmed Input Settings
	Programmed Position
	Programmed Velocity
	Programmed Current


	8: Network Configuration
	8.1: CANopen Network
	8.2: MACRO Network
	8.3: EtherCAT Network
	EtherCAT Address (Station Alias)


	9: Faults
	9.1: Overview
	Latched vs Non-latched Faults
	Example

	9.2:  Fault Descriptions

	10: Motor Phasing
	10.1: Auto Phase
	Auto Phase Example: Servo Amplifier

	10.2: Tips for Auto Phase Current and Increment Rate
	10.3: Troubleshooting the Auto Phase Problems
	Motor direction setup
	Motor wiring setup
	Phase count test
	Halls wiring setup

	10.4: Manual Phase
	Phase Initialization for Motor without Halls
	Manual Phase Example: Motor with Resolver

	Troubleshoot Manual Phase w/ Encoder and Halls
	Data accuracy test
	Encoder wiring test
	Hall signals test
	Hall transition test


	11: Control Loops
	11.1: Current Loop Setup and Tuning
	11.2:  Current Loop Auto Tune
	11.3: Notes on the Current Mode and Current Loop
	Current Loop Diagram
	Current Loop Inputs
	Offset
	Limits
	Current Loop Gains
	Current Loop Output

	11.4:  Velocity Loop Setup and Tuning
	11.5: Notes on the Velocity Mode and Velocity Loop
	Velocity Loop Diagram
	Inputs
	Velocity Loop Limits
	Diagram: Effects of Limits on Velocity Command
	Velocity Loop Gains
	Velocity Gains Shift
	Velocity Loop Filters
	Velocity Loop Outputs
	Proper Tracking Over Time
	Velocity Tracking Illustration

	11.6:  Position Loop Setup and Tuning
	11.7: Notes on the Position Mode and Position Loop
	Position Loop Diagram
	Trajectory Limits
	Position Loop Inputs From the Trajectory Generator
	Position Loop Gains
	Position Loop Feedback
	Position Loop Output

	Position Wrap
	Following Error Faults
	Following Error Warnings
	Position and Velocity Tracking Windows
	Following Error Fault Details
	Position Error Reaches Fault Level
	Amplifier Response to Non-Latched Following Error Fault
	Resuming Operations After a Non-Latched Following Error Fault
	Amplifier Response to a Latched Following Error Fault
	Resuming Operations After a Latched Following Error Fault


	11.8:  Auto Tune all Loops for Linear Motors

	Description
	Manually Tune the Position Loop
	Test S-Curve Profile
	Parameter
	Description

	Parameter
	12: Homing
	12.1: Overview
	12.2: Absolute Encoder Calibration
	Mechanical Homing
	Calibration


	13: Control Panel
	13.1: Control Panel Overview
	13.2: Status Indicators and Messages
	13.3:  Control Panel Monitor
	13.4: Control Functions
	13.5: Jog Mode

	Monitor Variables
	14: Oscilloscope
	14.1: Overview
	14.2: Menu, Display and Controls
	File Menu
	Display
	Trace Display Zoom
	Controls

	14.3: Function Generator
	14.4: Profile Generator
	14.5:  Trace Channel Variables
	14.6: Trigger Setup
	14.7: Measurement Tab
	14.8: Control Loop Parameters
	Gains Tab
	Trajectory Limits Tab
	Position Loop Parameters
	Velocity Loop Parameters

	14.9:  Scope Trace Files
	14.10: Trace Viewer

	File Menu
	Action
	Description
	Use the ASCII Command Line Interface to Enter Commands


	15: Filters
	15.1: Setting Parameters
	15.2: Filter Configuration Windows
	15.3: Filter Settings
	15.4: Input Shaping
	Analog
	Velocity Loop
	Current Loop

	15.5: Standard Filter Types
	Low Pass Filter
	High Pass Filter
	Notch Filter
	Band Pass Filter
	Custom Biquad Filter

	15.6:  Standard Filter Families
	Butterworth Filter
	Chebychev Filter
	Elliptic Filter

	15.7:   Input Shaping Window
	Input Shaping Types

	15.8:  Measuring Mechanical Vibration
	Using an Accelerometer with HDM
	Using HDM to Monitor Following Error


	16: Data, Firmware, and Logs
	16.1:  Amplifier RAM and Flash Memory
	Amplifier RAM
	Flash

	16.2: Data Management Tools
	Amplifier
	Motor/Feedback Screen

	16.3: Drive Configuration
	Save Drive Configuration
	Restore Drive Configuration

	16.4: Copy Drive Data
	16.5: Save MACRO File for Delta Tau Controllers
	16.6: Lock/Unlock HDM
	16.7: Firmware Download
	16.8: Error Log
	16.9: Communications Log

	17: Virtual Amplifier
	17.1: Overview

	18: Gains Scheduling
	18.1: Overview
	Storage Limits

	18.2: Configure Gain Scheduling
	18.3: Set Up Gain Scheduling Tables

	19: Regen Resistor Configuration
	Configure a Standard Harmonic Drive LLC Regen Resistor
	Configure a Custom Regen Resistor
	View Regen Settings

	I2T Time Limit Algorithm
	Overview
	Formulas and Algorithm Operation
	Calculating the I2T Setpoint Value
	Algorithm Operation
	Accumulator Increment Formula

	Application Example
	Plot Diagrams
	I2T Scope Trace Variables


	Homing Methods
	Overview
	Homing Diagram Legend
	Homing Method Descriptions
	Set current position as home
	Next Index
	Direction of Motion: Positive
	Direction of Motion: Negative

	Limit Switch
	Direction of Motion: Positive
	Direction of Motion: Negative

	Limit Switch Out to Index
	Direction of Motion: Positive
	Direction of Motion: Negative

	Hardstop
	Direction of Motion: Positive
	Direction of Motion: Negative
	Hardstop Methods in Stepper Mode

	Hardstop Out to Index
	Direction of Motion: Positive
	Direction of Motion: Negative
	Hardstop Out to Index Methods in Stepper Mode

	Home Switch
	Direction of Motion: Positive
	Direction of Motion: Negative

	Home Switch Out to Index
	Direction of Motion: Positive
	Direction of Motion: Negative

	Home Switch In to Index
	Direction of Motion: Positive
	Direction of Motion: Negative

	Lower Home
	Direction of Motion: Positive
	Direction of Motion: Negative

	Upper Home
	Direction of Motion: Positive
	Direction of Motion: Negative

	Lower Home Outside Index
	Direction of Motion: Positive
	Direction of Motion: Negative

	Lower Home Inside Index
	Direction of Motion: Positive
	Direction of Motion: Negative

	Upper Home Outside Index
	Direction of Motion: Positive
	Direction of Motion: Negative

	Upper Home Inside Index
	Direction of Motion: Positive
	Direction of Motion: Negative



	ASCII Commands/Serial Control
	Harmonic Drive LLC ASCII Interface
	HDM ASCII Command Line Interface Tool
	Single-Axis Serial Connection
	Multi-Drop Serial Connection

	B&B USB to Serial Adapter
	Recommended Device
	Factory Settings


